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    Abstract 
      The topic of the thesis was create the audiovisual (small commercials), using image processing 
technology and audio/music composition video and audio. The programs used for the preparation of 
the Adobe Photoshop CS2 of Adobe Systems, used for editing and creating images. Sound Forge 8.0 
of Sonic Foundry, which is the tool for digitizing and editing music. Adobe Premiere Pro CS3 of 
Adobe Systems, for video composition through video files, audio, picture and other graphics. 
      Goal was the creation of three commercials, with the aim of deepening my three earlier 
programmes and especially in Adobe Premiere. The first spot is the title «AFOI  GEROYKAKI» 
where advertised workshop/electric service « Afoi Geroykaki». The second spot has the title «SONY 
VAIO»,  which advertise the famous sony vaio laptop. In the last spots, is an advertisement for a 
children's educational book, and has the title «BABYPEDIA».  In all these commercials, have applied 
different effects and filters, and more generally have been sufficient editing to arrive (as was possible, 
therefore non-professional equipment to record audio and video) to the desired effect. The overall 
duration is 1 minute and 28 seconds and the presentation via a new audiovisual secondary. 
      The written part of the thesis that follows is divided into 5 chapters. The first chapter is the 
introduction which presents the theme of this project and objectives is a reference, the incentive and 
the structure. The second chapter is described in the condition of audiovisual and advertising as well 
as the characteristics of the image the audio and video. In the third chapter is a description of the three 
tools used to understand their use, their basic concepts and get to know the interface (for each 
program). In the fourth chapter deals with the practical part of the thesis, i.e. the production of 
advertisingspots. The last exposes the results and conclusions of this project.  
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Σύνοψη 
       Το θέµα της πτυχιακής εργασίας ήταν η δηµιουργία οπτικοακουστικών µέσων (µικρών 
διαφηµιστικών σποτ), µε χρήση τεχνολογιών επεξεργασίας εικόνας/ήχου και σύνθεση κοµµατιών 
video και audio.Τα προγράµµατα που χρησιµοποιήθηκαν για την εκπόνηση της ήταν το Adobe 
Photoshop CS2 της Adobe Systems, που χρησιµοποιείται για την για την επεξεργασία και δηµιουργία 
εικόνων. Το Sound Forge 8.0 της Sonic  Foundry, το οποίο είναι το εργαλείο για την ψηφιοποίηση 
και την επεξεργασία µουσικών αρχείων. Το Adobe Premiere Pro CS3 της Adobe Systems,  για την 
σύνθεση βίντεο µέσω αρχείων βίντεο, εικόνας, ήχου και άλλων γραφικών. 
      Στόχος ήταν η δηµιουργία τριών διαφηµιστικών σποτ, µε σκοπό την εµβάθυνση µου στα  τρία 
παραπάνω προγράµµατα  και κυρίως στο Adobe Premiere. Το πρώτο σποτ έχει τον τίτλο «ΑΦΟΙ 
ΓΕΡΟΥΚΑΚΗ», όπου διαφηµίζεται το συνεργείο/ηλεκτρολογείο «Αφοί Γερουκάκη». Το δεύτερο 
σποτ έχει τον τίτλο «SONY VAIO», όπου διαφηµίζω τον γνωστό φορητό υπολογιστή sony vaio. Στο 
τελευταίο σποτ, γίνεται µια διαφήµιση ενός παιδικού εκπαιδευτικού βιβλίου, και έχει τον τίτλο 
«BABYPEDIA». Σε όλα τα παραπάνω διαφηµιστικά σποτ, έχουν εφαρµοστεί διάφορα εφέ και φίλτρα 
και γενικότερα έχουν υποστεί αρκετή επεξεργασία, ώστε να φτάσουν (όσο γινόταν εφικτό, λόγο µη 
επαγγελµατικού εξοπλισµού στην εγγραφή του ήχου και του βίντεο)στο επιθυµητό αποτέλεσµα. Η 
συνολική τους διάρκεια είναι 1 λεπτό και 28 δευτερόλεπτα και η παρουσίαση τους γίνεται µέσω µίας 
νέας οπτικοακουστικής παράγωγης. 
      Το γραπτό µέρος της πτυχιακής που ακολουθεί χωρίζεται σε 5 κεφάλαια. Το πρώτο κεφάλαιο 
είναι η εισαγωγή όπου παρουσιάζεται το θέµα της παρούσας πτυχιακής και γίνεται µια αναφορά στους 
στόχους,, το κίνητρο και στην δοµή της. Στο  δεύτερο κεφάλαιο περιγράφεται ο όρος των 
οπτικοακουστικών µέσων και της διαφήµισης όπως επίσης και τα χαρακτηριστικά της εικόνας ,του 
ήχου και του βίντεο.  Στην τρίτο κεφάλαιο, γίνεται µια περιγραφή  των τριών εργαλείων που 
χρησιµοποιήθηκαν, ώστε να καταλάβουµε την χρήση τους, τις βασικές τους έννοιες και γενικότερα να 
γνωρίσουµε το περιβάλλον εργασίας(του κάθε προγράµµατος). Στο τέταρτο κεφάλαιο ασχολείται µε  
το πρακτικό µέρος της πτυχιακής εργασίας, δηλαδή µε την  παραγωγή των διαφηµιστικών spots. Το 
τελευταίο εκθέτει τα  αποτελέσµατα και τα συµπεράσµατα της παρούσας πτυχιακής.   
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1       ΕΙΣΑΓΩΓΗ 
 

1.1 Περίληψη 
      Το θέµα της παρούσας πτυχιακής εργασίας ήταν η δηµιουργία οπτικοακουστικών µέσων 
(µικρών διαφηµιστικών σποτ), µε χρήση τεχνολογιών επεξεργασίας εικόνας/ήχου και σύνθεση 
κοµµατιών video και audio.Τα προγράµµατα που χρησιµοποιήθηκαν για την εκπόνηση της ήταν τα 
παρακάτω: 

 Το Adobe Photoshop CS2, της Adobe System είναι ένα πρόγραµµα µε το οποίο 
µπορούµε να εισάγουµε έτοιµες εικόνες ή να τις  δηµιουργήσουµε εξολοκλήρου και 
να τις επεξεργαστούµε χρησιµοποιώντας διάφορα εφέ, φίλτρα,  layers κ.α. Έπειτα 
µπορούµε να τις εξάγουµε σε διάφορες µορφές εικόνας (όπως .bmp, .tiff, .jif, .jpg, 
κ.α.). 

 Το Sound Forge 8.0, της Sonic  Foundry είναι το εργαλείο για την ψηφιοποίηση και 
την επεξεργασία µουσικών αρχείων, µε την χρήση ποικίλων εφέ κ.α. Υπάρχουν 
αρκετοί και διαφορετικοί τύποι αρχείων και µορφών ήχου, για την εξαγωγή τους ( 
όπως .wav, .midi, .mp3, .ra, .qt, κ.α.). 

 Το Adobe Premiere Pro CS3, της Adobe System  χρησιµοποιείται για µπορούµε να 
εισάγουµε αρχεία βίντεο, εικόνας και ήχου, να τα µοντάρουµε και να τα 
επεξεργαστούµε µε κατάλληλα εφέ και φίλτρα. Αφού φτάσουµε στο επιθυµητό 
αποτέλεσµα έχουµε τη δυνατότητα να εξάγουµε το τελικό Project σε µια από τις 
πολλές διαθέσιµες µορφές βίντεο (avi, .mpeg1, .mpeg2, .wmv, .mov κ.α.).  

 
1.2  Κίνητρο ∆ιεξαγωγής της Εργασίας 
      Αυτό που µε ώθησε στην επιλογή του θέµατος της πτυχιακής εργασίας, ήταν, το ιδιαίτερο 
ενδιαφέρον µου για τα πολυµέσα και για την επεξεργασία τους.. Επίσης, άλλος ένας παράγοντας που 
µε οδήγησε στην επιλογή αυτή, ήταν η ραγδαία αναπτύξει που υπάρχει στον κλάδο της διαφήµισης , 
καθώς πολλές επιχειρήσεις στρέφονται στην λήψη ειδικευµένων υπηρεσιών από επαγγελµατικές 
διαφηµιστικές εταιρίες οι οποίες αναλαµβάνουν την επιλογή και την εκτέλεση του µηνύµατος της 
διαφήµισης. Αυτό που µε επηρέασε, για την δηµιουργία των συγκεκριµένων διαφηµιστικών σποτ, 
ήταν το περιβάλλον µου και συγκεκριµένα  ο σύζυγος µου, τα παιδιά µου και τέλος ο επαγγελµατικός 
µου κλάδος.  

 
1.3  Σκοπός και Στόχοι Εργασίας 
      Στόχος της εργασίας αυτής, ήταν η δηµιουργία τριών µικρής διάρκειας διαφηµιστικών σποτ, 
δηλαδή µια παραγωγή οπτικοακουστικών µέσων, µε σκοπό την εµβάθυνση µου στα προγράµµατα: 
Adobe Photoshop, Sound Forge και κυρίως στο Adobe Premiere.  Το πρώτο σποτ έχει τον τίτλο 
«ΑΦΟΙ ΓΕΡΟΥΚΑΚΗ», όπου διαφηµίζεται το συνεργείο/ηλεκτρολογείο «Αφοί Γερουκάκη». Το 
δεύτερο σποτ έχει τον τίτλο «SONY VAIO», όπου διαφηµίζω τον γνωστό φορητό υπολογιστή sony 
vaio. Στο τελευταίο σποτ, γίνεται µια διαφήµιση ενός παιδικού εκπαιδευτικού βιβλίου, και έχει τον 
τίτλο «BABYPEDIA». Σε όλα τα παραπάνω διαφηµιστικά σποτ, έχουν εφαρµοστεί διάφορα εφέ και 
φίλτρα και γενικότερα έχουν υποστεί αρκετή επεξεργασία και από τα τρία παραπάνω εργαλεία, ώστε 
να φτάσουν (όσο γινόταν εφικτό, λόγο µη επαγγελµατικού εξοπλισµού στη λήψη του ήχου και του 
βίντεο)στο επιθυµητό αποτέλεσµα. Η συνολική τους διάρκεια είναι 1 λεπτό και 28 δευτερόλεπτα και η 
παρουσίαση τους γίνεται µέσω µίας νέας οπτικοακουστικής παράγωγης. 
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1.4  ∆οµή Εργασίας 
       Το γραπτό µέρος της πτυχιακής που ακολουθεί αποτελείται από 5 κεφάλαια και αναφέρονται 
παρακάτω: 
      

� Πρώτο κεφάλαιο: Είναι το παρών κεφάλαιο· η εισαγωγή. 
 
� ∆εύτερο κεφάλαιο: Περιγράφεται ο όρος των οπτικοακουστικών µέσων και της διαφήµισης 

όπως επίσης και τα χαρακτηριστικά της εικόνας ,του ήχου και του βίντεο. 
 
� Τρίτο κεφάλαιο: Γίνεται µια περιγραφή  των τριών εργαλείων που χρησιµοποιήθηκαν, ώστε 

να καταλάβουµε την χρήση τους, τις βασικές τους έννοιες και γενικότερα να γνωρίσουµε το 
περιβάλλον εργασίας(του κάθε προγράµµατος). 

 
� Τέταρτο κεφάλαιο: Παρουσιάζει µε  το πρακτικό κοµµάτι της παρούσας πτυχιακής εργασίας 

, δηλαδή την παραγωγή των διαφηµιστικών spots. 
 

� Πέµπτο κεφάλαιο: Εκθέτει τα  αποτελέσµατα και τα συµπεράσµατα της παρούσας 
πτυχιακής. 
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2 ΒΑΣΙΚΕΣ ΕΝΝΟΙΕΣ & ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ 
 
      Το κεφάλαιο αυτό ασχολείται µε τους όρους: οπτικοακουστικά µέσα και διαφήµιση, όπως και µε 
τα χαρακτηριστικά της εικόνας, του βίντεο και του ήχου. Σκοπός είναι να κατανοήσουµε τις βασικές 
έννοιες, και τα «συστατικά» εκείνα  τα οποία θα αποτελέσουν την βάση για την υλοποίηση της 
πτυχιακής εργασίας. 

 
2.1 Τα Πολυµέσα      
      Με τον όρο πολυµέσα εννοούµε τα µέσα που περιέχουν και χρησιµοποιούν ένα συνδυασµό 
διαφόρων µορφών περιεχοµένου. Λέγοντας πολυµέσα αναφερόµαστε στον συνδυασµό εικόνας, ήχου, 
και βίντεο. Τα πολυµέσα ως όρος έχει προέρθει από τον αγγλικό όρο Multimedia. Ετυµολογικά ο όρος 
αυτός είναι σύνθετη λέξη και αποτελείται από το πρόθεµα ‘multi’ ( προέρχεται από το λατινικό 
multus) που σηµαίνει ‘πολλαπλός’ και την ρίζα ‘media’ (πληθυντικός του λατινικού medium) που 
σηµαίνει ‘µέσα’. Γενικότερα τα πολυµέσα σήµερα αποτελούν σηµείο συνάντησης για την 
πληροφορική, τις τηλεπικοινωνίες, τις ηλεκτρονικές εκδόσεις, την βιοµηχανία της µουσικής καθώς 
και την τηλεόραση και τον κινηµατογράφο. Έτσι τα πολυµέσα πλέον έχουν γίνει κοµµάτι της 
σύγχρονης καθηµερινότητας. 

 
2.2  Τα Οπτικοακουστικά Μέσα 
      Ο όρος οπτικοακουστικά µέσα αναφέρεται στα µέσα που παράγουν ταυτόχρονα εικόνα και ήχο. 
Ως όρος χρησιµοποιείται για την παραγωγή, τη χρήση, ή τον εξοπλισµό εργασιών που συνδυάζουν 
τον ήχο µε την εικόνα. Συνέδρια, συνελεύσεις, παρουσιάσεις, διαφηµίσεις ή ακόµα και φωνητικές 
εργασίες υποστηρίζονται πληρέστερα µε την χρήστη των οπτικοακουστικών µέσων, καθώς οι 
συντελεστές έχουν την δυνατότητα να συνδυάσουν τον προφορικό λόγο µε την εικόνα και να 
δηµιουργήσουν έτσι τις καταλληλότερες συνθήκες για κατανόηση και προβολή της πληροφορίας. 

 
2.3   Η ∆ιαφήµιση 
      Ο όρος διαφήµιση αναφέρεται στην παραγωγή οπτικοακουστικού ή γραπτού µηνύµατος, το 
οποίο αφορά σε συγκεκριµένο προϊόν, µε σκοπό την αγορά του ή την αποδοχή από τον δέκτη. Η 
διαφήµιση είναι πράξη επικοινωνίας και στοχεύει: 
� Να ενηµερώσει το καταναλωτικό κοινό για προϊόντα που κυκλοφορούν στην αγορά. 
� Να πείσει τους καταναλωτές πως το συγκεκριµένο προϊόν υπερτερεί έναντι των                                                                                              

άλλων. 
� Να αυξήσει τις πωλήσεις, το τζίρο και τα κέρδη. 
 

2.4   Χαρακτηριστικά Εικόνας 
      Η εικόνα αποτελεί το σηµαντικότερο κοµµάτι στον κόσµο των υπολογιστών και ειδικότερα στα 
πολυµέσα και στις οπτικοακουστικές παραγωγές. Εικόνες µπορούµε να εισάγουµε σε µια πολυµεσική 
εφαρµογή µε τη βοήθεια του σαρωτή (scanner), όπου η όλη διαδικασία λέγεται ψηφιοποίηση της 
εικόνας, να τις πάρουµε (κατεβάσουµε) από το Internet, από CD ή να τις δηµιουργήσουµε µε κάποιο 
από τα πληθώρα εργαλεία επεξεργασίας εικόνας που υπάρχουν . 
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2.4.1  Οι ∆ιανυσµατικές Εικόνες  
 

 
         Εικόνα 1: ∆ιανυσµατική Εικόνα 
 
      Οι διανυσµατικές εικόνες (vector graphics) αποτελούνται από αντικείµενα σχεδίασης (γραµµές, 
ορθογώνια, ελλείψεις ή τόξα) τα οποία βασίζονται σε ειδικά µαθηµατικά µοντέλα. Για παράδειγµα, 
όταν δηµιουργούµε έναν κύκλο σαν διανυσµατική εικόνα, το πρόγραµµα χρειάζεται µόνο τις 
συντεταγµένες του κέντρου του (x, y) και την ακτίνα του και δεν τον βλέπει ζωγραφισµένο σαν µια 
αλληλουχία από εικονοστοιχεία.  
      Το µεγάλο πλεονέκτηµα που έχουν οι διανυσµατικές εικόνες είναι ότι µπορούµε να περιστρέφουµε 
να µεγεθύνουµε ή να σµικρύνουµε τα σχήµατα χωρίς να προκαλούνται αλλοιώσεις ή µεταβολή στο 
µέγεθος του αρχείου. Απλώς κάθε φορά αλλάζει η ακτίνα του κύκλου. Το µέγεθος ενός αρχείου 
διανυσµατικής εικόνας είναι ανάλογο της πολυπλοκότητας και του πλήθους των αντικειµένων 
σχεδίασης Τα άλλα πλεονεκτήµατα που έχουν είναι ότι λόγο της αποθήκευσης µόνο των πληροφορίες 
που είναι απαραίτητες για τον σχεδιασµό των αντικειµένων σχεδίασης, είναι αρκετά µικρότερο από 
ένα χαρτογραφικό ίδιων διαστάσεων, και είναι συµβατά µ’ όλα σχεδόν τα προγράµµατα 
παρουσιάσεων.  
Οι διανυσµατικές εικόνες δηµιουργούνται από:  

• Την ψηφιοποίηση εικόνων µέσω σαρωτή. 
• Τo Microsoft Office σαν αντικείµενα σχεδίασης και γραφικές παραστάσεις. 
• Τα προγράµµατα δηµιουργίας και επεξεργασίας διανυσµατικής εικόνας όπως το Corel Draw, το 

Adobe Illustrator κ.α.  

 
2.4.1.1 Βασικές Μορφοποιήσεις(formats) ∆ιανυσµατικών                   

Εικόνων 
 
FORMAT  ΠΕΡΙΓΡΑΦΗ 
WMF 
Windows Meta 
File 

Έγινε γνωστό κυρίως λόγω των windows. Επειδή δεν υπάρχουν πολλά vector 
format γενικής χρήσης, είναι αρκετά χρησιµοποιούµενο. Βάθος χρώµατος 24 bit, 
RGB. 

CDR 
CorelDraw 

Corel Draw format. Καταχωρεί όλα τα επίπεδα (layers). Βάθος χρώµατος 24 bit, 
RGB. 

EPS 
Encapsulated 
PostScript 

Παραλλαγή του TIF και του PS. Έχει τη δυνατότητα να καταχωρεί και raster και 
vector εικόνες ταυτόχρονα. Χρησιµοποιείται κυρίως στην τυπογραφία. Βάθος 
χρώµατος 24 bit ή 32 bit για RGB ή CMYK αντίστοιχα. ∆υνατότητα clipping paths. 
Χρησιµοποιείται για να διευκολύνει τη χρήση φωτογραφιών σε αρχεία .ps 

 Πίνακας 1: Format ∆ιανυσµατικών εικόνων- Περιγραφή                        
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2.4.2 Οι Ψηφιογραφικές Εικόνες 
 

 
         Εικόνα 2: Ψηφιογραφική Εικόνα 
 
      Οι ψηφιογραφικές ή Χαρτογραφικές εικόνες (bitmaps ή raster) είναι η µία από τις δύο µεγάλες 
κατηγορίες στις οποίες χωρίζονται οι εικόνες. Το όνοµά τους το οφείλουν στο ότι αποτελούνται από 
πολλά χαρτογραφηµένα bits (τετραγωνάκια), που µοιάζουν µε ψηφίδες ή κουκκίδες ή εικονοστοιχεία 
(pixels). Το εικονοστοιχείο είναι το ελάχιστο στοιχείο ανάλυσης στην οθόνη και περιγράφεται από το 
χρώµα και τη θέση του.  Το καθένα απ’ αυτά τα pixels µπορεί να είναι άσπρο ή µαύρο ή να έχει ένα 
συγκεκριµένο χρώµα και ο συνδυασµός όλων των pixels µιας εικόνας δίνει το τελικό αποτέλεσµα.  
Οι χαρτογραφικές εικόνες δηµιουργούνται από:  

� την ψηφιοποίηση εικόνων µέσω σαρωτή,  
� τις ψηφιακές φωτογραφικές και εικονοληπτικές µηχανές,  
� τη σύλληψη εικόνων από την οθόνη του υπολογιστή,  
� την ψηφιοποίηση εικόνων βίντεο ή τηλεόρασης µέσω ειδικής κάρτας σύλληψης βίντεο  
� τα προγράµµατα δηµιουργίας και επεξεργασίας χαρτογραφικής εικόνας, όπως το 

Paint, το Photo Paint, το Paint Shop Pro, το Photoshop, τα ελεύθερα διατιθέµενα 
Picasa και GIMP κ.α.. 

      Οι ψηφιογραφικές εικόνες είναι κατάλληλες για φωτορεαλιστικές και για τρισδιάστατες 
απεικονίσεις, γιατί προσφέρουν µεγάλο φάσµα χρωµάτων, µεγάλο επίπεδο λεπτοµέρειας και 
σκιάσεων. Τα µειονεκτήµατά τους είναι ότι δηµιουργούν µεγάλα αρχεία στον δίσκο και αν τις 
µεγεθύνουµε χαλάνε οι λεπτοµέρειές τους.  

 
2.4.2.1 Βασικές Μορφοποιήσεις(formats) Χαρτογραφικών                   

Εικόνων 
 

FORMAT  ΠΕΡΙΓΡΑΦΗ 
JPG 
Join Photo Group 

Σχεδόν αποκλειστικά για φωτογραφίες. Ένα από τα δύο format που 
χρησιµοποιείται στο internet γιατί επιτυγχάνει πολύ µεγάλο βαθµό 

συµπίεσης. Ο βαθµός συµπίεσης µπορεί να επιλεγεί από το χρήστη σε 
ένα µεγάλο εύρος. Βάθος χρώµατος 24 bit ή 32 bit για RGB ή CMYK 

µοντέλο αντίστοιχα, και 8 bit ασπρόµαυρο µοντέλο. 
TIFF, TIF 
Tag Image File Format 

To format που χρησιµοποιείται κυρίως στην τυπογραφία λόγω των 
χαρακτηριστικών που διαθέτει. Τα µεγάλου µεγέθους αρχεία 

συµπιέζονται ικανοποιητικά χωρίς απώλεια ποιότητας (looseless). 
Βάθος χρώµατος 24 bit ή 32 bit για RGB ή CMYK αντίστοιχα. 

GIF 
Graphics Interchange Format 

Αποτελεί το δεύτερο format που χρησιµοποιείται στο internet. 
Κατάλληλο για γραφικά, όχι για φωτογραφίες. Ειδικά όταν δεν 

περιέχει πολλά χρώµατα παράγει εξαιρετικά µικρού µεγέθους αρχεία. 
Βάθος χρώµατος ως 1-8 bit έγχρωµα ή ασπρόµαυρα. RGB. 

BMP 
Bitmap 

Ένα από τα format που καθιερώθηκε από τα windows. Βάθος 
χρώµατος 24, 8, 4 και 1 bit. RGB. ∆εν ενδείκνυται η χρήση του εκτός 

αν δεν υπάρχει δυνατότητα να χρησιµοποιήσετε κάτι άλλο. 
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PCX 
Paintbrush 

Βάθος χρώµατος 8 bit, RGB. 

PCD 
Photo CD 

Το format που χρησιµοποιεί η Kodak για το Photo CD. Μόνο για 
φωτογραφίες, βάθος χρώµατος περίπου 24 bit. 

Πίνακας 2: Format Ψηφιογραφικών Εικόνων- Περιγραφή 

 
2.4.2.2 Παράµετροι Χαρτογραφικών Εικόνων  

• Ανάλυση (resolusion). Εκφράζει την πυκνότητα των εικονοστοιχείων της εικόνας και 
µετριέται µε το πλήθος των εικονοστοιχείων στο µήκος της µιας ίντσας (pixels per inch, ppi). 
Αν ο προορισµός της εικόνας είναι η εκτύπωση µέσω ενός εκτυπωτή µε µεγάλη δυνατότητα 
λεπτοµέρειας (διακριτικότητα ή ανάλυση), όπως των ατελιέ και των τυπογραφείων, τότε θα 
προσπαθήσουµε να τη δηµιουργήσουµε µε µεγάλη ανάλυση (250 έως 400 ppi), ενώ µέσω 
ενός κοινού εκτυπωτή αρκεί µια µέση ανάλυση (100 έως 250 ppi). Τέλος, αν ο προορισµός 
της εικόνας είναι η εµφάνιση µέσω της οθόνης του υπολογιστή (παρουσίαση - διαδίκτυο) τότε 
θα τη δηµιουργήσουµε µε χαµηλή ανάλυση (72 έως 100 ppi).  

  
 

Εικόνα 3: Ανάλυση Εικόνας 
 

• Χρωµατικό βάθος. Εκφράζει το πλήθος των διαφορετικών χρωµάτων που µπορεί να πάρει 
ένα pixel και καθορίζεται από τον αριθµό των bit. Έτσι µια εικόνα µε χρωµατικό βάθος 8 bits 
αποδίδει 28=256 χρώµατα ενώ µε 16bit αποδίδει 216=65536 χρώµατα. Για τέλεια χρωµατική 
απόδοση (true color) απαιτείται χρωµατικό βάθος 24 bit δηλαδή περίπου 16,8 εκατοµµύρια 
χρώµατα (224).  

 

Χρωµατικό Βάθος Αριθµός Χρωµάτων 

1  21 = 2 

2 22 = 4 

4 24 = 16 

8 28 = 256 

16 216 = 65.636 

24 (true color) 224 = 16.777.216 

Πίνακας 3: Χρωµατικό Πλήθος Εικόνας 
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• ∆ιάσταση. Η εικόνα ανεξάρτητα από το σχήµα της, καταλαµβάνει τον χώρο ενός ορθογωνίου 
παραλληλογράµµου που την περιβάλει. 

      Το µέγεθος ενός αρχείου χαρτογραφικής εικόνας είναι το γινόµενο του πλήθους των pixel επί 
χρωµατικό βάθος της εικόνας. Έτσι µια εικόνα µε ανάλυση 100ppi, χρωµατικού βάθους 24 bit και 
δια-στάσεων (6,4 Χ 4,8) ίντσες θα έχει µέγεθος 900KBytes. (Στο πλάτος υπάρχουν 640 pixels και στο 
ύψος 480 pixels, έτσι το πλήθος των pixels της εικόνας είναι 307.200 pixels. [307.200pixels X 
24bit/pixel=7.372.800 bit =921.600 Bytes=900KBytes]). Το πλήθος των pixels σε µια εικόνα είναι το 
γινόµενο της ανάλυσης επί την διάσταση. ∆ιατηρώντας το πλήθος των pixels σταθερό µπορούµε, µε 
οποιοδήποτε πρόγραµµα επεξεργασίας εικόνας, να αυξήσουµε την ανάλυση της εικόνας εις βάρος της 
διάστασης ή το αντίθετο χωρίς να αλλοιωθεί η ποιότητα της εικόνας. Όταν διπλασιάζουµε την 
ανάλυση µιας εικόνας οι διαστάσεις της υποδιπλασιάζονται. 

Μια ασυµπίεστη φωτογραφία από µια ψηφιακή φωτογραφική µηχανή των 5 Mpixel και 24 bit που 
έχει µέγεθος 14,1 Mbytes όταν τυπωθεί σε ένα εκτυπωτή χαµηλής διακριτικότητας και ρυθµίσουµε 
την ανάλυση σε 100ppi θα τυπωθεί µε διαστάσεις 65X48 cm, όταν τυπωθεί σε ένα κοινό εκτυπωτή 
και ρυθµίσουµε την ανάλυση σε 200ppi θα τυπωθεί µε διαστάσεις 32,5Χ24 cm και όταν τυπωθεί σε 
ένα εκτυπωτή υψηλής διακριτικότητας (φωτογραφείο–ατελιέ–τυπογραφείο) και ρυθµίσουµε την 
ανάλυση σε 400ppi θα τυπωθεί µε διαστάσεις 16,2Χ12 cm, µε την προϋπόθεση βέβαια ότι διατηρούµε 
σταθερό. 

 
2.4.2.3  Συµπίεση Αρχείου Ψηφιογραφικής Εικόνας  
      Το µεγάλο µέγεθος των ψηφιογραφικών εικόνων και ο µικρός αποθηκευτικός χώρος των µέσων 
στις δεκαετίες του ’80 και ’90 ανάγκασε τους επιστήµονες να επινοήσουν τρόπους συµπίεσης µε 
µεγάλο λόγο συµπίεσης χωρίς να γίνονται ιδιαίτερα αντιληπτές οι απώλειες που µπορεί να υπάρχουν 
στην εικόνα από το ανθρώπινο µάτι. Έτσι επινοήθηκαν δυο τρόποι συµπίεσης της εικόνας:  

• Συµπίεση χωρίς απωλεστικούς αλγορίθµους (LZW)  
• Συµπίεση µε απωλεστικούς αλγορίθµους (JPEG)  

      Στη πρώτη περίπτωση η λειτουργία του αλγορίθµου βασίζεται στην αποφυγή αποθήκευσης 
επαναλαµβανόµενων πληροφοριών σε µια οµάδα από pixels. Το µέγεθος της συµπίεσης εξαρτάται 
λοιπόν από το εάν έχει η εικόνα πολλά pixels που είναι όµοια µεταξύ τους. Τον αλγόριθµο αυτό 
χρησιµοποιούν οι εικόνες TIFF (*.TIF), και οι εικόνες PHOTOSHOP (*.PSD).  
Στη δεύτερη περίπτωση η λειτουργία του αλγορίθµου βασίζεται σε κάποιες ιδιαιτερότητες της 
ανθρώπινης όρασης και ειδικότερα στο εξής: Το ανθρώπινο µάτι αντιλαµβάνεται λιγότερο τις µικρό 
εναλλαγές στο χρώµα και την απόχρωση από τις αντίστοιχες στη φωτεινότητα και την αντίθεση. Έτσι 
ο αλγόριθµος εκµεταλλευόµενος αυτή την ιδιαιτερότητα για να συµπιέσει µια εικόνα ελαττώνει την 
πληροφορία του χρώµατος µε τον ακόλουθο τρόπο: διαιρεί την εικόνα σε τετράγωνα των 64 pixels 
(8Χ8) και ενοποιεί χρωµατικά τα pixels που έχουν παραπλήσια απόχρωση και ανάλογα µε τον βαθµό 
συµπίεσης που θα επιλέξουµε στη κλίµακα1 µπορούµε να επιτύχουµε µεγάλη συµπίεση (πολλές 
απώλειες) ή µικρή συµπίεση (λίγες απώλειες).  

Α                                                                                      Γ 

                      Β                          
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Εικόνα 4: Απωλεστικός αλγόριθµος 
 

      Βλέπουµε πως λειτουργεί ο απωλεστικός αλγόριθµος JPEG (Εικόνα 4) σε µια µεγεθυσµένη 
οµάδα των 64 pixels. Αν δυσκολευόµαστε να βρούµε τις διαφορές και η ανάλυση είναι πχ. 240 ppi, 
τότε φανταστείτε πόσο πιο δύσκολο θα είναι αφού η κάθε πλευρά της οµάδας θα έχει µήκος, 8/240 = 
1/30 της ίντσας, δηλαδή λίγο µικρότερο από ένα χιλιοστό. 

 

2.4.3  Ιδανική Επιλογή Βαθµού Συµπίεσης Αλγορίθµου                  
JPEG 

      Το ποσοστό συµπίεσης µιας εικόνας έχει άµεση σχέση µε τη µελλοντική της χρήση αλλά και µε 
το περιεχόµενό της. Αν οι αρχικές εικόνες συµπιεστούν στην τιµή 6/12 ή 50/100 τότε στην εικόνα η 
συµπίεση µπορεί να φθάσει µέχρι και το 1/40 του αρχικού µεγέθους χωρίς ιδιαίτερες ορατές απώλειες. 
Αν πρόκειται να τυπωθούν σε ατελιέ, καλό είναι να µη δίνουµε τιµές ποιότητας κάτω από 9/12 ή 
80/100 και για εκτυπώσεις σε κοινούς εκτυπωτές ψεκασµού όχι κάτω από 8/12 ή 70/100. Σε µια 
συµπιεσµένη εικόνα οι πληροφορίες που χάνονται, χάνονται για πάντα και δεν υπάρχει τρόπος για να 
τις ανακτήσουµε (εκτός αν έχουµε κρατήσει αντίγραφο σε TIFF ή άλλη ασυµπίεστη µορφή). Εάν 
αποθηκεύσουµε εκ νέου ως TIFF µια εικόνα που έχει ήδη συµπιεστεί ως JPG, δεν κερδίζουµε τίποτα 
σε ποιότητα. απλά αποθηκεύουµε τις απώλειες σε άλλο format. Για µια εικόνα tif που στην 
προηγούµενη “ζωή” της ήταν jpg, δεν υπάρχει γυρισµός, ακόµα και αν αλλάζει το “επίθετό” της σε 
"*.tif". 
      Οι εικόνες JPG δεν επηρεάζονται αν ανοιχτούν από κάποιο πρόγραµµα και ξανά αποθηκευτούν. 
Αν όµως τις επεξεργαστούµε και τις αποθηκεύσουµε πολλές φορές στα σηµεία ειδικά που έχει γίνει 
επανειληµµένη επεξεργασία η ποιότητα σταδιακά υποβαθµίζεται. Τα περισσότερα φωτογραφεία που 
εκτυπώνουν ψηφιακές φωτογραφίες δέχονται φωτογραφία JPG στα 300dpi µε τιµή ποιότητας – 
συµπίεσης έως 9/12 ή 80/100 και έχουν άψογα αποτελέσµατα.  

 
2.4.4   ∆ιαδικασίες Ψηφιοποίησης Εικόνας µέσω Σαρωτή      
   Η σάρωση πραγµατοποιείται µε τη βοήθεια του προγράµµατος σάρωσης. Μολονότι κάθε σαρωτής 
διαθέτει το δικό του πρόγραµµα, το οποίο διαφέρει ανάλογα µε το µοντέλο και την εταιρεία 
κατασκευής, υπάρχουν κάποιες επιλογές που είναι κοινές για όλα τα προγράµµατα. Αυτά συνήθως 
προσφέρουν δύο διαφορετικές επιφάνειες εργασίας, µία µε τις βασικές λειτουργίες και κάποιες 
προκαθορισµένες ρυθµίσεις σάρωσης και µία µε περισσότερες επιλογές και δυνατότητα βασικής 
επεξεργασίας της εικόνας. 
      Η διαδικασία της σάρωσης δεν είναι δύσκολη. Η επιτυχηµένη όµως σάρωση προϋποθέτει να 
ξέρουµε τι σαρώνουµε και για ποιο λόγο. ∆ιαφορετικά θα δηµιουργούµε αρχεία ακατάλληλα, είτε 
γιατί είναι χαµηλής ποιότητας είτε γιατί είναι υπερβολικά µεγάλα σε µέγεθος χωρίς να υπάρχει λόγος. 
Ουσιαστικά, οι αποφάσεις που καλούµαστε να πάρουµε πριν από κάθε σάρωση αφορούν στην 
ανάλυση και στο βάθος χρώµατος της εικόνας που θα δηµιουργήσουµε. Κατόπιν, χρειάζεται να 
επιλέξουµε τον κατάλληλο τύπο αρχείου που θα την αποθηκεύσουµε, έτσι ώστε, αν θελήσουµε να την 
τροποποιήσουµε µελλοντικά, να µην έχουν αλλοιωθεί οι πληροφορίες της. 
Ας δούµε πιο αναλυτικά τα βήµατα της σάρωσης: 
� Τοποθέτηση δοκιµίου  
Αν ο σαρωτής µας έχει τη δυνατότητα να σαρώσει έντυπα και διαφάνειες, επιλέγουµε το είδος του 
δοκιµίου που θα χρησιµοποιήσουµε, έτσι ώστε το λογισµικό να ξέρει πώς θα κάνει τη σάρωση. Αυτό 
το κάνουµε διότι, η σάρωση ενός εντύπου πραγµατοποιείται από το φως που ανακλάται πάνω του, 
ενώ η σάρωση µιας διαφάνειας από το φως που περνά µέσα από αυτή. Αν θέλουµε να σαρώσουµε 
διαφάνειες ή φιλµ, εγκαθιστούµε στο σαρωτή τα ειδικά πλαίσια προσαρµογής διαφανειών.  
Στη συνέχεια τοποθετούµε το δοκίµιο (έγγραφο, φωτογραφία κ.λπ.) στη γυάλινη πλάκα του σαρωτή, 
έτσι ώστε η επιφάνεια που επιθυµούµε να σαρώσουµε να ακουµπά πάνω της. Προσέχουµε τον σωστό 
προσανατολισµό (παράλληλη ή κάθετη µε τη φορά ανάγνωσης για να γλιτώσουµε µετά τη διαδικασία 
στρέψης) και κλείνουµε το σκέπασµα του σαρωτή. Αν θέλουµε να σαρώσουµε φιλµ ή διαφάνειες, τα 
τοποθετούµε στην περιοχή της γυάλινης πλάκας που οριοθετεί το ειδικό πλαίσιο. Προσέχουµε να 
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είναι καθαρή πάντα η γυάλινη επιφάνεια, οι φωτογραφίες, και προπαντός τα αρνητικά και τα θετικά 
φιλµ.  
� Προεπισκόπηση και επιλογή περιοχής σάρωσης  
      Επειδή τις περισσότερες φορές το δοκίµιο µας δεν καλύπτει όλη την επιφάνεια σάρωσης, ενώ 

κάποιες άλλες φορές θέλουµε να σαρώσουµε µόνο ένα τµήµα του, θα πρέπει πριν από τη σάρωση 
να κάνουµε µία προεπισκόπηση της περιοχής σάρωσης και στη συνέχεια να καθορίσουµε το 
τµήµα που µας ενδιαφέρει. Για την προεπισκόπηση του δοκιµίου επιλέγουµε «Preview» ή 
«Overview» στο πρόγραµµα σάρωσης, ώστε ο σαρωτής να κάνει µια γρήγορη σάρωση και να 
εµφανίσει την περιοχή του δοκιµίου που µπορεί να σαρώσει. Αν έχουµε τοποθετήσει το δοκίµιο 
ανάποδα ή λοξά, κάνουµε τις απαραίτητες διορθώσεις. Στη συνέχεια επιλέγουµε την περιοχή που 
θέλουµε να σαρώσουµε. Αυτή καθορίζεται από ένα διακεκοµµένο παραλληλόγραµµο (ή 
τετράγωνο), το οποίο µετά την προεπισκόπηση καταλαµβάνει συνήθως όλο το δοκίµιο. Η επιλογή 
µόνο της περιοχής του δοκιµίου που µας ενδιαφέρει, µειώνει σηµαντικά το χρόνο σάρωσης και 
δεν δηµιουργεί αρχεία µεγάλου µεγέθους.  

� Επιλογή βάθους χρώµατος  
      Κατόπιν θα πρέπει να καθορίσουµε το βάθος χρώµατος που θέλουµε να έχει η εικόνα που θα 

δηµιουργήσουµε. Γενικά, η εικόνα µας µπορεί να είναι έγχρωµη ή να έχει µόνο διαβαθµίσεις του 
γκρι χρώµατος ή να είναι ασπρόµαυρη.  

� Αν το δοκίµιο µας είναι έγχρωµο, µπορούµε να επιλέξουµε βάθος χρώµατος 24bit 
(ονοµάζεται και True Color ή RGB), οπότε η εικόνα που θα δηµιουργήσουµε θα έχει 
περίπου 16,8 εκατοµµύρια χρώµατα, ή να επιλέξουµε µε βάθος χρώµατος 8bit οπότε η 
εικόνα µας θα έχει 256 χρώµατα.  

� Εάν το δοκίµιο µας είναι ασπρόµαυρη φωτογραφία, και περιέχει διαβαθµίσεις του γκρι 
χρώµατος ή δεν χρειαζόµαστε χρώµα στη εικόνα µας, τότε ως βάθος χρώµατος επιλέγουµε 
Grayscale 8bit.  
� Τέλος, αν το δοκίµιο είναι ασπρόµαυρο (βιβλίο, περιοδικό, µονόχρωµα σκίτσα κ.λπ.) ή 
το αρχείο που θα δηµιουργήσουµε θέλουµε να το χρησιµοποιήσουµε για την οπτική 
αναγνώριση χαρακτήρων µε ένα πρόγραµµα OCR, επιλέγουµε ως βάθος χρώµατος Lineart 
(ονοµάζεται και Black and White ή lbit). Εάν όµως το δοκίµιο είναι έγχρωµο και µας 
ενδιαφέρει το έγγραφο που θα δηµιουργηθεί από το OCR πρόγραµµα να είναι πάλι 
έγχρωµο, τότε πρέπει να κάνουµε ρυθµίσεις σύµφωνα µε την πρώτη περίπτωση.  

      Επειδή το βάθος χρώµατος επηρεάζει τόσο το χρόνο της σάρωσης όσο και το µέγεθος του 
τελικού αρχείου, χρειάζεται να είµαστε προσεκτικοί στην επιλογή του. Σε γενικές γραµµές, στις 
περισσότερες έγχρωµες σαρώσεις θα πρέπει να επιλέγουµε βάθος χρώµατος 24bit. Να 
σηµειώσουµε ότι εικόνες µε βάθος χρώµατος µεγαλύτερο των 24bit για τις έγχρωµες σαρώσεις 
και άνω των 8bit για τις διαβαθµίσεις του γκρι (π.χ., 48bit RGB Color και 16bit Grayscale), δεν 
υποστηρίζονται από ορισµένα προγράµµατα επεξεργασίας εικόνας. Τις περισσότερες φορές 
ακόµα και τα προγράµµατα που το υποστηρίζουν δεν εφαρµόζουν όλα τα φίλτρα και τα εφέ, 
οπότε ενδέχεται να χρειαστεί η υποβάθµιση του βάθους χρώµατος για να επεξεργαστούµε την 
εικόνα.  

� Επιλογή ανάλυσης  
Το επόµενο βήµα είναι να επιλέξουµε την ανάλυση µε την οποία επιθυµούµε να γίνει η σάρωση 
του δοκιµίου. Όπως έχουµε αναφέρει, αυτή θα είναι και η ανάλυση της εικόνας που θα 
δηµιουργήσουµε. Η ανάλυση της σάρωσης καθορίζει τη λεπτοµέρεια που θα έχει η τελική εικόνα 
και το τελικό µέγεθος του αρχείου. Γενικά, ο διπλασιασµός της ανάλυσης (και στους δύο άξονες) 
τετραπλασιάζει το πλήθος των εικονοστοιχείων, άρα και το µέγεθος του αρχείου. Ενδεικτικά να 
αναφέρουµε ότι κατά τη σάρωση µιας σελίδας A4 µε πραγµατικό χρώµα (24bit) στα 100, 200 και 
300ppi,το µέγεθος του αρχείου που δηµιουργείται καταλαµβάνει στη µνήµη του υπολογιστή 2,78, 
11,13 και 25,04ΜΒ αντίστοιχα.  
      Η επιλογή της ανάλυσης, λοιπόν, θα πρέπει να γίνει µε προσοχή αναλόγως µε το σκοπό για 
τον οποίο θα χρησιµοποιήσουµε την εικόνα. Συνήθως η ανάλυση µιας εικόνας µε 200 έως 300ppi 
είναι υπεραρκετή για την εκτύπωση των φωτογραφιών, ενώ µια ανάλυση των 100ppi είναι καλή 
για την απεικόνιση στην οθόνη του υπολογιστή. Αν πάλι θέλουµε να κάνουµε οπτική αναγνώριση 
χαρακτήρων σε ένα δοκίµιο πρέπει να σαρώσουµε µε ανάλυση από 300ppi έως 400ppi εκτός εάν 
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οι χαρακτήρες του δοκιµίου είναι µικροί οπότε τότε πρέπει να αυξήσουµε την ανάλυση σάρωσης 
στα 500ppi έως 600ppi. 
 Στη σάρωση των φωτογραφιών καλό θα είναι να µην υπερβαίνουµε ποτέ την οπτική ανάλυση του 
σαρωτή µας (ουσιαστικά τις δυνατότητές του), γιατί τότε το λογισµικό του σαρωτή παρεµβάλει 
στην δηµιουργηµένη εικόνα µη πραγµατικά εικονο-στοιχεία, τα οποία θολώνουν την εικόνα 
(σάρωση µε παρεµβολή). Έτσι, αν ο σαρωτής έχει µέγιστη οπτική ανάλυση 600x600dpi ή 
600x1200dpi, δεν θα πρέπει να σαρώνουµε πάνω από τα 600ppi. Αν θέλουµε να αυξήσουµε την 
ανάλυση µιας εικόνας, παραπάνω από την οπτική ανάλυση του σαρωτή, είναι προτιµότερο να 
κάνουµε παρεµβολή χρησιµοποιώντας ένα πρόγραµµα επεξεργασίας εικόνας (π.χ. το photoshop) 
παρά το λογισµικό του σαρωτή. 
 Στους σαρωτές που υποστηρίζουν µεγάλες αναλύσεις σάρωσης χρησιµοποιούµε µεγάλη ανάλυση 
σάρωσης, µόνο στη σάρωση διαφανειών µε ασπρόµαυρα σκίτσα ή στη σάρωση µικρών εικόνων 
και αρνητικών που σκοπεύουµε στο µέλλον να εκτυπώσουµε ή να προβάλουµε σε µεγαλύτερες 
διαστάσεις. (Κρατώντας σταθερό το πλήθος των Pixels µπορούµε να αυξήσουµε την διάσταση της 
εικόνας µε αποτέλεσµα να µειωθεί αυτόµατα η ανάλυσή της σε ικανοποιητικές τιµές εκτύπωσης, 
χωρίς να µειωθεί η ποιότητά της.)  

� Ρυθµίσεις βελτίωσης  
Αν η προεπισκόπηση του δοκιµίου εµφανίζει προβλήµατα φωτεινότητας ή λάθος χρωµατικούς 
τόνους, µπορούµε να ρυθµίσουµε τη φωτεινότητα, την αντίθεση ή όσες χρωµατικές ρυθµίσεις 
προσφέρει το πρόγραµµα σάρωσης, έτσι ώστε το αποτέλεσµα να είναι όσο το δυνατόν καλύτερο. 
Επίσης επειδή οι σαρωτές και κυρίως στις υψηλές αναλύσεις θολώνουν την εικόνα καλό είναι να 
ενεργοποιείται το φίλτρο “unsarp mask”. Τέλος στις εικόνες που έχουν εκτυπωθεί από 
τυπογραφεία (βιβλία - περιοδικά) πρέπει να ενεργοποιείται και το φίλτρο “descreening”.  

� Αποθήκευση  
Αφού τελειώσει η σάρωση του δοκιµίου το ελέγχουµε και το αποθηκεύουµε µε τη χρήση ενός 
αλγορίθµου χωρίς απώλειες (TIF ή PSD). Μετά µπορούµε να επεξεργασθούµε το αρχείο και να το 
αποθηκεύσουµε µε έναν απωλεστικό αλγόριθµο (JPG), κρατώντας πάντα ακέραιο το αρχικό µας 
αντίγραφο. 

 
2.4.5    Τα Βασικά Στοιχεία Χρώµατος 
      Ένα µοντέλο χρωµάτων (color model) είναι µία µέθοδος για την εµφάνιση και µέτρηση του 
χρώµατος. Το ανθρώπινο µάτι αντιλαµβάνεται το χρώµα ανάλογα µε το µήκος κύµατος του φωτός 
που λαµβάνει. Το φως που περιέχει ολόκληρο το φάσµα χρωµάτων γίνεται αντιληπτό σαν λευκό. 
Όταν δεν υπάρχει φως, το µάτι αντιλαµβάνεται το µαύρο. 

 
2.4.5.1 Το Μοντέλο Χρωµάτων RGB  

 
Εικόνα 5: Μοντέλο Χρωµάτων RGB 

 
      Ένα µεγάλο ποσοστό του ορατού φάσµατος χρωµάτων µπορεί να αποδοθεί µε την ανάµειξη των 
τριών βασικών συστατικών του έγχρωµου φωτός, σε διάφορες αναλογίες. Τα συστατικά αυτά είναι 
γνωστά σαν πρωτεύοντα χρώµατα: Red (κόκκινο), Green (πράσινο) και Blue (µπλε). Επειδή 
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προστίθενται διάφορα ποσοστά από κάθε ένα από τα πρωτεύοντα χρώµατα για την δηµιουργία νέων 
χρωµάτων, το µοντέλο χρωµάτων RGB αναφέρεται επίσης σαν προσθετικό µοντέλο χρωµάτων 
(additive color). Ίσα ποσά κόκκινου, πράσινου και µπλε παράγουν το λευκό.  
      Όλες οι συσκευές οθόνης εµφανίζουν το χρώµα χρησιµοποιώντας µία ανάµειξη των τριών 
πρωτευόντων προσθετικών χρωµάτων, κόκκινο, πράσινο και µπλε. Γενικά, θα πρέπει να τροποποιείτε 
τις έγχρωµες εικόνες σας χρησιµοποιώντας το µοντέλο χρωµάτων RGB για τους ακόλουθους λόγους:  
Τα αρχεία των έγχρωµων RGB εικόνων είναι µικρότερα σε σύγκριση µε τα αρχεία που 
δηµιουργούνται µε τα άλλα µοντέλα χρωµάτων. Οι οθόνες εµφανίζουν καλύτερα τα χρώµατα του 
µοντέλου RGB. Το µοντέλο χρωµάτων RGB παρέχει µεγαλύτερο φάσµα χρωµάτων στην οθόνη απ’ 
ότι τα άλλα µοντέλα χρωµάτων, όπως το CMYK.  

 
2.4.5.2 Το Μοντέλο Χρωµάτων CMYK  

 
Εικόνα 6: Μοντέλο Χρωµάτων CMYK 

 
      Το µοντέλο χρωµάτων CMYK (Cyan-κυανό, Μagenta-µατζέντα, Υellοw-κίτρινο και Black-
µαύρο) αντιπροσωπεύει τα τέσσερα µελά-νια της τετραχρωµίας που χρησιµοποιούνται για την 
εκτύπωση εικόνων σε τυπογραφικά πιεστήρια. Για την εκτύπωση έγχρωµων εικόνων σ’ ένα πιεστήριο 
χρησιµοποιούνται τέσσερις τσίγκοι ένας για κάθε ένα από τα τέσσερα βασικά χρώµατα της 
τετραχρωµίας. Η διαδικασία παραγωγής των φιλµ για κάθε χρώµα αποκαλείται διαχωρισµοί 
χρωµάτων. Οι διαχωρισµοί χρωµάτων, σε συνδυασµό, σχηµατίζουν µία σύνθετη έγχρωµη εικόνα. Το 
µοντέλο χρωµάτων CMYK ονοµάζεται και αφαιρετικό (subtractive) µοντέλο χρωµάτων, επειδή ο 
συνδυασµός όλων των χρωµάτων αφαιρεί χρώµα και παράγει το µαύρο. 
 

2.4.5.3 Γκάµα χρώµατος  

 
Εικόνα 7: Γκάµα Χρώµατος 

      Η γκάµα (gamut) ενός µοντέλου χρωµάτων είναι η περιοχή των χρωµάτων που µπορούν να 
εµφανίζονται ή να εκτυπώνονται όταν χρησιµοποιείται το µοντέλο αυτό. Η µεγαλύτερη γκάµα 
χρωµάτων που µπορεί να δει κανείς είναι στην ίδια την φύση. Η γκάµα χρωµάτων του µοντέλου RGB 
είναι µικρότερη από την γκάµα χρωµάτων της Φύσης, ενώ η γκάµα χρωµάτων του µοντέλου CMYK 
είναι µικρότερη από την γκάµα του µοντέλου RGB. 
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Όλα τα χρώµατα µπορούν να περιγραφούν και µε τον συνδυασµό των εξής τριών βασικών                  
χαρακτηριστικών (Εικόνα 8): 

• Hue, απόχρωση, που είναι το κύριο χαρακτηριστικό του χρώµατος που το κατατάσσει 
στο φάσµα,  

• Saturation, πυκνότητα ή διάχυση, δηλ. ο βαθµός απόχρωσης του χρώµατος,  
• Brightness, φωτεινότητα, δηλ. πόσο φωτεινό ή σκοτεινό µπορεί να είναι ένα χρώµα. 

 

          
Εικόνα 8: Χαρακτηριστικά Χρωµάτων 

 

2.5      Χαρακτηριστικά Βίντεο 
      Το βίντεο εµπλουτίζει, βελτιώνει και προσδίδει έµφαση σε µια εφαρµογή πολυµέσων. Προσθέτει 
ρεαλισµό, θετική διάθεση και συντελεί στην ενθάρρυνση του χρήστη ή του ακροατηρίου. Με την 
ενσωµάτωση ενός κατάλληλα επιλεγµένου και διαµορφωµένου αποσπάσµατος βίντεο ο ακροατής 
κατανοεί καλύτερα την πληροφορία παρακολουθώντας το ίδιο το γεγονός και όχι µια περιγραφή µέσω 
του κειµένου. 
Υπάρχουν δύο τρόποι µε τους οποίους µπορεί να χρησιµοποιηθεί το βίντεο σε µια πολυµεσική 
εφαρµογή:  

• Σαν video περιεχοµένου για: να δώσουµε έµφαση σε συγκεκριµένα στοιχεία σχετικά µε το θέµα, 
την αναλυτική παρουσίαση πολύπλοκων διαδικασιών, την παρουσίαση ιστορικών ντοκουµέντων 
και µαρτυριών, την επεξήγηση δυσνόητων εννοιών, την δηµιουργία κατάλληλης διάθεσης του 
ακροατηρίου και  

• Σαν video βοήθειας για οδηγίες πλοήγησης και χρήσης της εφαρµογής.  
 

2.5.1   Αναλογικό Βίντεο  
      Αναλογικό βίντεο είναι η ηλεκτρονική τεχνολογία κωδικοποίησης, µετάδοσης και αναπαραγωγής 
οπτικοακουστικής πληροφορίας, όπου η µορφή των χρησιµοποιούµενων σηµάτων είναι αναλογικού 
τύπου. Το αναλογικό βίντεο βασίζεται σε µια διαδικασία όµοια µε αυτήν των κινηµατογραφικών 
ταινιών. Η ταινία βίντεο σχηµατίζεται από µια αλληλουχία διαφορετικών εικόνων που προβάλλονται 
στην οθόνη και λέγονται πλαίσια ή καρέ (frames). Η δηµιουργία της ψευδαίσθησης της κινούµενης 
εικόνας οφείλεται στη φυσιολογία του µατιού, η οποία επιτρέπει µια κίνηση να φαίνεται οµαλή και 
συνεχής όταν η ταχύτητα ανανέωσης των πλαισίων είναι πάνω από 15 καρέ το δευτερόλεπτο (fps).  

 
2.5.1.1 Βασικά Μεγέθη στη Τεχνολογία Αναλογικού Βίντεο  

• Κάθετη ανάλυση (vertical resolution) είναι ο αριθµός των διακριτών οριζόντιων γραµµών 
στις ο-ποίες αναλύεται ένα πλαίσιο. Χαρακτηριστικές τιµές ανάλυσης έχουµε, 625 γραµµές 
στο ευρωπαϊκό τηλεοπτικό σύστηµα (PAL) και 525 γραµµές στο αµερικάνικο (NTSC).  

• Λόγος εικόνας (aspect ratio) είναι ο λόγος του πλάτους της εικόνας προς το ύψος της. Η 
συµβατική τηλεοπτική εικόνα έχει λόγο 4:3 ενώ στη τηλεόραση υψηλής ευκρίνειας έχει λόγο 
16:9.  

• Ρυθµός ή συχνότητα ανανέωσης πλαισίου (frame rate) είναι το µέγεθος που εκφράζει το 
πόσο συχνά ανανεώνεται κάθε πλαίσιο της εικόνας στην οθόνη.  

• ∆ιαπλεκόµενη και συνεχής σάρωση (interlaced and non interlaced scan)  
 Η εικόνα δηµιουργείται καθώς µια δέσµη ηλεκτρονίων που σαρώνει διαδοχικές γραµµές στην 
 οθόνη και καθορίζει τον βαθµό φωτεινότητας και χρωµατικότητας των διαφόρων περιοχών. Η 
 σάρωση αυτή µπορεί να γίνει µε δύο τρόπους:  

• ∆ιαπλεκόµενη (interlaced) όταν σαρώνονται πρώτα οι µισές γραµµές περνώντας από κάθε 
δεύτερη γραµµή (1η , 3η ,5η, κλπ) και µετά τις άλλες µισές άρτιες γραµµές (2η, 4η, 6η, κλπ). 
Ουσιαστικά κάθε πλαίσιο χωρίζεται σε δύο µέρη που ονοµάζονται πεδία, στο πάνω πεδίο 
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(upper field) που περιλαµβάνει τις γραµµές περιττής τάξης και το κάτω πεδίο (lower field) 
που περιλαµβάνει τις γραµµές άρτιας τάξης. Κατά το πρώτο σάρωµα το πάνω πεδίο γράφεται 
στην οθόνη(Εικόνα 9 πάνω φωτογραφία). Όταν γραφούν όλες οι περιττές γραµµές, η δέσµη 
ξαναγυρίζει στην πάνω αριστερή γωνία της οθόνης και ξεκινάει να γράφει τις άρτιες γραµµές. 
Έτσι το ανθρώπινο µάτι δεν αντιλαµβάνεται την γρήγορη αλλαγή και αντί να βλέπει δυο 
πεδία, βλέπει τη σύζευξη των δύο πεδίων, δηλαδή όλη την εικόνα.(Εικόνα 9 κάτω 
φωτογραφία). 

 

 
Εικόνα 9: ∆ιαπλεκόµενη Σάρωση 

 
• Συνεχής (non interlaced ή progressive) όταν όλες οι γραµµές σαρώνονται συνεχόµενα χωρίς 

να δηµιουργούνται πεδία. Στη τηλεόραση και το βίντεο εφαρµόζεται διαπλεκόµενη σάρωση 
ενώ στους υπολογιστές συνεχής. (Στη νέα µορφή βίντεο - τηλεόρασης υψηλής ευκρίνειας, που 
λέγεται και HDTV, εφαρµόζεται συνεχής σάρωση).  

• Οverscan και ζώνες ασφάλειας Το µέγεθος καρέ µπορεί να είναι παραπλανητικό στοιχείο 
εάν το βίντεο προετοιµάζεται για τηλεοπτική προβολή. Οι περισσότερες ευρείας 
κατανάλωσης συσκευές τηλεόρασης µεγεθύνουν την εικόνα. Το χαρακτηριστικό αυτό 
"σπρώχνει" τα περιφερειακά µέρη της εικόνας έξω από την οθόνη µε αποτέλεσµα αυτά να µην 
εµφανίζονται. Η διαδικασία αυτή αποκαλείται overscan. Επειδή το ποσό του overscan δεν 
είναι όµοιο για όλες τις συσκευές τηλεόρασης, θα πρέπει η δράση και οι τίτλοι να κρατούνται 
µέσα σε δύο περιοχές ασφάλειας - τη περιοχή ασφάλειας δράσης (action-safe) και ασφάλειας 
τίτλων (title-safe) (Εικόνα 10). 

                                                                                                                        
                                                                                                                                                                            
 
Ζώνη ασφαλείας δράσης                            
 
 
Ζώνη ασφαλείας τίτλων                                                                                                                           
 
 
 
 

Εικόνα 10: Περιοχές Ασφάλειας 
 

2.5.1.2  Συστήµατα Αναλογικού Βίντεο  
Τα βασικότερα συστήµατα αναπαραγωγής και µετάδοσης αναλογικού βίντεο που υπάρχουν σήµερα 
είναι δύο:  

• Το PAL (Phase Alternating Line) χρησιµοποιείται στην Ευρώπη και την Ασία, που εκπέµπει 
διαπλεκόµενη σάρωση 625 γραµµών, µε ρυθµό ανανέωσης 25 fps και ο λόγος εικόνας είναι 
4:3.  
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• Το NTSC (National Television Systems Committee) χρησιµοποιείται στη Βόρεια Αµερική 
και την Ιαπωνία που εκπέµπει διαπλεκόµενη σάρωση 525 γραµµών, µε ρυθµό ανανέωσης 
περίπου 30 fps και ο λόγος εικόνας είναι 4:3.  

      Ένα ακόµη σύστηµα αναλογικού video σε χρήση είναι το SECAM (Sequentiel Couleur avec 
Memoire) που χρησιµοποιείται σε Γαλλία, Ανατολική Ευρώπη & περιοχές της Αφρικής. Έχει ίδιο 
αριθµό γραµµών και ρυθµό ανανέωσης µε το PAL αλλά διαφοροποιείται στον τρόπο κωδικοποίησης 
της πληροφορίας χρώµατος. Υπάρχει τέλος και το νέο σύστηµα (High-Definition TeleVision ή 
HDTV) µε αριθµό γραµµών 1125 και ρυθµό ανανέωσης 60 fps που χρησιµοποιείται στη τηλεόραση 
υψηλής ευκρίνειας 
 

Συστήµατα  Κάθετη Ανάλυση  Ταχύτητα 
εναλλαγής 
πλαισίων  

Λόγος εικόνας 

PAL (Phase Alternating Line)  625  25  4:3  
NTSC (National Television Systems 
Committee)  

525  29,97  4:3  

Πίνακας 4: Συστήµατα PAL-NTSC 
 

2.5.1.3 Μορφοποίηση – Κωδικοποίηση Αναλογικού Βίντεο  
      Η ανάγκη για εγγραφή – αναπαραγωγή και εκποµπή ποιοτικής έγχρωµης εικόνας καθώς και η 
συµβατότητα µε άλλα παλαιότερα µέσα έφερε σαν αποτέλεσµα την κωδικοποίηση του έγχρωµου 
σήµατος βίντεο. Έτσι δηµιουργήθηκαν τρία βασικά σχήµατα κωδικοποίησης τα οποία αναφέρονται µε 
φθίνουσα σειρά ποιότητας:  

o Component: Το σήµα µεταφέρεται µέσω τριών διαφορετικών συνιστωσών οι οποίες είναι οι 
πληροφορίες για τα τρία πρωτεύοντα χρώµατα του µοντέλου RGB. Λόγοι συµβατότητας, 
αποδοτικότερης µετάδοσης και συµπίεσης γέννησαν την ανάγκη του µετασχηµατισµού του σε 
YUV όπου Y= φωτεινότητα ή luminance, U = πληροφορία χρώµατος (Cb) και V = 
πληροφορία χρώµατος (Cr). Το σήµα Component είναι το καλύτερο ποιοτικά σήµα. Οι 
µηχανές Betacam φέρουν σήµα Component YUV, ενώ οι υπολογιστές χρησιµοποιούν σήµα 
Component RGB.  

o Y/C: Το σήµα αυτό µεταφέρεται από δύο συνιστώσες, µια της φωτεινότητας Υ και µια της 
χρωµατικότητας C, η τελευταία η οποία δηµιουργήθηκε από την σύνθεση των U και V. Το 
σήµα Y/C είναι συµπιεσµένο ως προς τη χρωµατικότητα και η ποιότητά του είναι χαµηλότερη 
από το Component. Οι µηχανές S-Video (S-VHS και Hi8) φέρουν σήµα Y/C.  

o Composite: Το σήµα αυτό δηµιουργείται συνθέτοντας τα δύο σήµατα Y και C, σε ένα 
σύνθετο σήµα το οποίο µεταφέρει την πληροφορία της φωτεινότητας και του χρώµατος. Είναι 
το πλέον συµπιεσµένο σήµα και το χαµηλότερο ποιοτικά. Το Composite (σύνθετο σήµα) είναι 
το πιο συνηθισµένο σήµα (το PAL και το NTSC µεταδίδουν σήµα Composite, οι απλές 
µηχανές Video δηλαδή οι VHS και οι Video8 φέρουν σήµα Composite). 

 

2.5.2   Ψηφιακό Βίντεο 
      Την δεκαετία του 1990 µε τον όρο ψηφιακό βίντεο εννοούσαµε τα ψηφιακά αρχεία βίντεο που 
προ-έκυπταν από την ψηφιοποίηση του αναλογικού βίντεο. Σήµερα ο όρος ψηφιακό βίντεο ή 
τεχνολογία DV (Digital Video), αναφέρεται γενικά σε όλο το σύνολο των ψηφιακών τεχνολογιών µε 
τις οποίες γίνεται η παραγωγή, η επεξεργασία, η αποθήκευση, η διανοµή και η αναπαραγωγή – 
εκποµπή του οπτικοακουστικού υλικού σε ψηφιακή µορφή. 
 

2.5.2.1 ∆ηµιουργία ψηφιακού βίντεο 
� Ψηφιοποίηση αναλογικού βίντεο µέσω της κάρτας σύλληψης (analog video capturing) 

Η µετατροπή του αναλογικού σήµατος βίντεο σε ψηφιακό γίνεται µε την χρήση ειδικής 
κάρτας σύλληψης που πρέπει να υπάρχει στον υπολογιστή, η οποία συνδέεται µε την 
αναλογική πηγή σήµατος (τηλεόραση, συσκευές βίντεο Betacam – SVHS – VHS, αναλογικές 
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βιντεοκάµερες), δέχεται το αναλογικό σήµα και το µετατρέπει, µε τη χρήση ολοκληρωµένων 
κυκλωµάτων, σε ψηφιακό αρχείο βίντεο. Η σύνδεση της κάρτας µε τη συσκευή 
αναπαραγωγής γίνεται µε ειδικά καλώδια που µεταφέρουν την εικόνα και τον ήχο.   

 

 
Εικόνα 11: Κάρτα Σύλληψης Βίντεο 

 
 

           
Εικόνα 12: Καλώδια Μεταφοράς Αναλογικού Βίντεο-Ήχου 

 
      Μια σύγχρονη κάρτα σύλληψης χαρακτηρίζεται από:  

• Τον δίαυλο σύνδεσης: PCI (ή και USB)  
• Τα παραγόµενα αρχεία: AVI ή MPEG-1, MPEG-2  
• Την είσοδο σήµατος: Y/C, Composite, ψηφιακό)  
• Την έξοδο σήµατος: (Y/C, Composite, ψηφιακό)  
• Την είσοδο στερεοφωνικού ήχου: (RCA ή miniJack)  
• Την έξοδο στερεοφωνικού ήχου: (RCA ή miniJack)  
• Την δυνατότητα τηλεοπτικού δέκτη  
• Την µέγιστη ανάλυση: (720x576 στο PAL)  
• Το λογισµικό: συνήθως η κάρτα συνοδεύεται από κάποιο λογισµικό επεξεργασίας video  
• Τον µέγιστο ρυθµό διαµεταγωγής  
• Τη συµβατότητα µε τα τηλεοπτικά συστήµατα NTSC – PAL - SECAM  

 
� Με χρήση εξ αρχής ψηφιακής τεχνολογίας βίντεο (DV)  

Στη περίπτωση αυτή η σύνδεση είναι πιο απλή. Με το καλώδιο FireWire συνδέουµε την 
ψηφιακή βιντεοκάµερα µε τη κάρτα σύλληψης ψηφιακού βίντεο. Κατόπιν µε τη χρήση 
ειδικού λογισµικού που παρέχει η κάρτα, µεταφέρουµε τα ψηφιακά αρχεία βίντεο (κινούµενη 
εικόνα και ήχος) από την ψηφιακή βιντεοκάµερα στον υπολογιστή για επεξεργασία. (Το 
πρωτόκολλο IEEE 1394 ή FireWire έχει δυνατότητα διαµεταγωγής ψηφιακών δεδοµένων 
µέχρι 50Mbytes/sec).  
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Εικόνα 13: Καλώδια Μεταφοράς Ψηφιακού Βίντεο-Ήχου 
 

2.5.2.2 Παράµετροι Ψηφιοποίησης του Σήµατος Βίντεο 
� Συχνότητα δειγµατοληψίας (sampling rate). Η συχνότητα δειγµατοληψίας πρέπει να 

ικανοποιεί τις απαιτήσεις για µια καλή ποιότητα σήµατος.  
� Ταχύτητα εναλλαγής των πλαισίων (frame rate). Το τηλεοπτικό πρότυπο για την ταχύτητα 

ανανέωσης των πλαισίων είναι 25fps για το Pal και 29,97 fps για το έγχρωµο NTSC. Εάν η 
τελική αναπαραγωγή του βίντεο γίνει στον υπολογιστή σαν αρχείο βίντεο και όχι σαν 
τυποποιηµένη ταινία στη τηλεόραση (DVD, VCD, SVCD, VHS κλπ.), µπορούµε να έχουµε 
ένα ανεκτό αποτέλεσµα και µε 15fps.  

� Μέγεθος των πλαισίων (frame size). Και πάλι εδώ υπάρχουν κάποια στάνταρ για το µέγεθος 
ανάλογα µε το τηλεοπτικό σύστηµα και µε τον τύπο της ταινίας, πχ. για το PAL σύστηµα, στο 
πρότυπο του DVD, η ανάλυση του πλαισίου είναι 720X576 pixels. Εάν πάλι η τελική 
αναπαραγωγή του βίντεο γίνει στον υπολογιστή µπορούµε να ορίσουµε το µέγεθος που µας 
ικανοποιεί σε οποιαδήποτε αναλογία.  

� Χρωµατικό βάθος (color depth) το οποίο καθορίζει το πλήθος των διαφορετικών χρωµάτων 
που µπορεί να πάρει κάθε εικονοστοιχείο των πλαισίων του βίντεο. Με τιµή χρωµατικού 
βάθους 24 bit έχουµε ένα βίντεο µε πραγµατικό χρώµα. Στην περίπτωση ψηφιοποίησης 
σήµατος PAL η µέγιστη δυνατή ανάλυση εικόνας είναι 720x576. Με 25 πλαίσια ανά 
δευτερόλεπτο και µε 24bit βάθος χρώµατος ο όγκος δεδοµένων είναι:  
720 Χ 576 Χ 24bit Χ 25fps = 31104000 Bytes = 30375 KB = 29,7MB για κάθε δευτερόλεπτο, 
και εποµένως για βίντεο διάρκειας µιας ώρας χρειάζεται αποθηκευτικός χώρος: 29,7X3600 = 
106.920MB=104,41GB.  

      Τα µεγέθη αυτά είναι απαγορευτικά για διαχείριση, επεξεργασία, αποθήκευση και πρέπει µε 
κάποιο τρόπο να µειωθούν. Για την µείωση του µεγέθους των αρχείων βίντεο εφαρµόζονται 
αλγόριθµοι που συνδυάζουν απωλεστικές και µη απωλεστικές τεχνικές συµπίεσης. Αρκετοί από 
αυτούς είναι ίδιοι µε τους αλγόριθµους που χρησιµοποιούνται στη συµπίεση της ψηφιογραφικής 
εικόνας και του PCM ψηφιακού ήχου. 
 

2.5.2.3 Συµπίεση Ψηφιακού Βίντεο.  
Οι τεχνικές συµπίεσης video (compressor/decompressor ή codec) που χρησιµοποιούνται είναι οι:  

• Χωρική συµπίεση (Ενδοπλαισιακή) είναι οι τεχνικές συµπίεσης που εφαρµόζονται στη 
πληροφορία κάθε ενός πλαισίου χωριστά.  

• Χρονική συµπίεση (∆ιαπλαισιακή) είναι οι τεχνικές συµπίεσης που εκµεταλλεύονται τον 
τρόπο µε τον οποίο µεταβάλλεται η πληροφορία µεταξύ διαδοχικών πλαισίων. 

      Έτσι σε ορισµένες περιοχές βίντεο που δεν υπάρχουν πολλές αλλαγές από πλαίσιο σε πλαίσιο, 
όπως π.χ. τα πλάνα ενός τηλεπαρουσιαστή που λέει το πρόγραµµα της ηµέρας, η χρονική συµπίεση 
παρατηρεί ότι τα µόνα pixels που αλλάζουν από πλαίσιο σε πλαίσιο είναι αυτά που απαρτίζουν το 
πρόσωπο του παρουσιαστή. Όλα τα άλλα pixels δεν αλλάζουν (όταν βέβαια η κάµερα είναι ακίνητη). 
Έτσι αντί να περιγράφεται το κάθε pixel από κάθε πλαίσιο, ο συµπιεστής δηµιουργεί οµάδες καρέ (2 
έως 25 περί-που, ανάλογα µε τις διαφορές που υπάρχουν µεταξύ τους), και περιγράφει όλα τα pixels 
του πρώτου καρέ της οµάδας και κατόπιν, για κάθε επόµενο καρέ της οµάδας, περιγράφει µόνο τα 
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pixels που διαφέρουν από το προηγούµενο καρέ. Κάτι αντίστοιχο γίνεται όταν υπάρχει κίνηση σε µια 
περιοχή βίντεο και µπορεί να προβλεφθεί η διαφορά θέσης του αντικειµένου ή του ηθοποιού ανάµεσα 
σε µια οµάδα πλαισίων. Οι δύο χαρακτηριστικές τεχνικές αυτής της µεθόδου συµπίεσης λέγονται 
“διαφορά καρέ” και “εκτίµηση κίνησης”.  
      Η διαπλαισιακή τεχνική συµπίεσης είναι η πιο πολύπλοκη τεχνική αλλά επιτυγχάνει τα 
µεγαλύτερα ποσοστά συµπίεσης µε πολύ καλή ποιότητα. Λόγω του ότι τα πλαίσια είναι 
οµαδοποιηµένα και τα πλαίσια µιας οµάδας έχουν άµεση σχέση µεταξύ τους, και κυρίως µε το πρώτο 
πλαίσιο που ονοµάζεται πλαίσιο κλειδί (key frame), δεν ενδείκνυται η επεξεργασία του αρχείου που 
έχει δηµιουργηθεί µε αυτόν τον συµπιεστή γιατί, µια αλλαγή ή διαγραφή που θα γίνει π.χ. στο πλαίσιο 
κλειδί, θα επηρεάσει και τα υπόλοιπα πλαίσια της οµάδας του, πράγµα που δεν το επιθυµούµε.  

• Συµπίεση µε ή χωρίς απώλειες. Υπάρχουν ορισµένες τεχνικές συµπίεσης που χρησιµοποιούν 
µη απωλεστικούς αλγόριθµους (lossless compression) χωρίς δηλαδή να µειώνεται η ποιότητα 
τους πρωτογενούς υλικού αλλά έχουν το µειονέκτηµα ότι µειώνεται ελάχιστα το µέγεθος του 
αρχείου (περίπου 2:1) µε αποτέλεσµα να µη µπορεί να διαχειρισθεί εύκολα. Αντίθετα, οι 
τεχνικές συµπίεσης που χρησιµοποιούν απωλεστικούς αλγόριθµους πετυχαίνουν µεγάλη µείωση 
του µεγέθους του αρχείου µε απώλειες τόσες ώστε να µην είναι εύκολα ορατές από το 
ανθρώπινο µάτι.  

• Ασύµµετρη και συµµετρική συµπίεση. Συµµετρικός λέγεται ο αλγόριθµος που χρειάζεται τον 
ίδιο χρόνο για την κωδικοποίηση και την αποκωδικοποίηση, ενώ ασύµµετρος ο αλγόριθµος που 
χρειάζεται διαφορετικούς χρόνους στην κωδικοποίηση από την αποκωδικοποίηση.  

      Οι περισσότεροι Codecs χρησιµοποιούν πολλούς αλγόριθµους µαζί οι οποίοι χρησιµοποιούν 
διαφορετικές τεχνικές συµπίεσης και µπορούν να επιτύχουν υψηλά ποσοστά συµπίεσης (έως 50:1), 
χωρίς να υπάρχει µεγάλη διαφορά στη ποιότητα από το πρωτογενές υλικό. Ένας τέτοιος codec είναι ο 
MPEG ο οποίος είναι ασύµµετρος, απωλεστικός, ενδοπλαισιακός και κυρίως διαπλαισιακός. Τα 
αρχικά MPEG προέρχονται από τις λέξεις Moving Picture Experts Group. Πρόκειται για µια επιτροπή 
ειδικών που δραστηριοποιείται στην ανάπτυξη απωλεστικών συµπιεστών για συµπίεση πληροφορίας 
εικόνας, ήχου και video. Μέχρι σήµερα η επιτροπή MPEG έχει διατυπώσει τη µορφή αρκετών 
συµπιεστών που φέρουν όλοι την ονοµασία MPEG και µοιράζονται µεν τα ίδια βασικά 
χαρακτηριστικά, διαφέρουν όµως σε αρκετά σηµεία και συνοδεύονται από έναν χαρακτηριστικό 
αριθµό. 
 Οι σπουδαιότεροι από αυτούς είναι οι MPEG-1, MPEG-2 και MPEG-4.  

� Το MPEG-1 εκδόθηκε το 1992 και σχεδιάστηκε για να υποστηρίξει την αποθήκευση 
πληροφορίας video σε πλατφόρµα CD-ROM. Ο ρυθµός µετάδοσης ψηφιακών δεδοµένων 
(bit rate) είναι σταθερός για τη συµπίεση βίντεο 1,5 Mbps (όσο και του µουσικού CD) κάτι 
που όµως είναι σχετικά µε-γάλο για τη µεταφορά του µέσω του διαδικτύου. Η ανάλυση 
πλαισίου στο πρότυπο αυτό καθορίζεται στα 352x288 pixels µε ρυθµό ανανέωσης πλαισίων 
από 24 έως 30 ανά δευτερόλεπτο. Ο ευρύτατα διαδεδοµένος συµπιεστής µουσικών αρχείων 
MP3 είναι το 3° επίπεδο (Layer III) προδιαγραφών του MPEG-1.  

� To MPEG-2 εµφανίστηκε το 1994 και απετέλεσε σηµαντική βελτίωση του MPEG-1. Ο 
ρυθµός µετάδοσης δεδοµένων µπορεί να είναι σταθερός ή µεταβλητός και ποικίλει από 700 
έως 9.200Κbps, η µέγιστη ανάλυση φθάνει 1280x720 pixels µε ρυθµό ανανέωσης πλαισίων 
µέχρι 60 fps και ήχο ποιότητας CD. To πεδίο εφαρµογής του είναι κύρια η πλατφόρµα DVD. 
Έτσι µια ταινία διάρκειας 2 ωρών µπορεί να “ χωρέσει” άνετα σε δίσκο DVD µιας στρώσης 
(χωρητικότητας 4,7GB) µε ικανοποιητική ποιότητα.  

� Το πρότυπο MPEG-3 που προορίζονταν αρχικά για την τηλεόραση υψηλής ευκρίνειας, 
τελικά δεν χρησιµοποιήθηκε ποτέ αφού ενσωµατώθηκε στο MPEG-2 και καλύφθηκε και 
αυτή η ανάγκη.  

� Τo MPEG-4 παρουσιάστηκε το 1998 και σχεδιάστηκε έτσι ώστε να αποτελέσει ένα 
αποδοτικό σχήµα συµπίεσης για εφαρµογές διαδικτύου. Αρχικά σχεδιάστηκε για πολύ 
χαµηλά bit rates (ανάλυση πλαισίου 176x144 στα 10fps) ώστε να υποστηρίξει τη µετάδοση 
της ψηφιακής ροής δεδοµένων µέσω απλών τηλεφωνικών γραµµών. Σήµερα έχει διαδοθεί 
πάρα πολύ γιατί επιτυγχάνει υψηλή συµπίεση µε πολύ καλή ποιότητα σε µεγάλες αναλύσεις, 
αλλά και γιατί υποστηρίζεται από πολλές οικιακές συσκευές αναπαραγωγής DVD Video. 
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                                   Video CD                                                          Ποιότητα VHS 
 
  MPEG-1 
 
                              
 
                                                Super Video CD (2 γλώσσες – 4 υπότιτλοι) Ποιότητα SVHS 
          
                             
 
      
MPEG-2                                                        
                                    DVD (8 γλώσσες –9 κάµερες –32 υπότιτλοι) Ποιότητα BETA 
                                           
 
 
                     
 
 
 
MPEG-4 
 
 

Πίνακας 5: Συµπιεστές MPEG 
 

2.5.2.4    ∆ιαδεδοµένες Μορφοποιήσεις Αρχείων Βίντεο  
      Στους προσωπικούς υπολογιστές µε λειτουργικό σύστηµα MS Windows η συνηθέστερη 
µορφοποίηση αρχείων video φέρει την επέκταση αρχείου avi. Τα αρχικά AVI προέρχονται από τις 
λέξεις Audio Video Interleave και η µορφοποίηση avi προωθήθηκε και καθιερώθηκε από τη 
Microsoft. Τα αρχεία avi µπορούν να είναι συµπιεσµένα µε οποιονδήποτε από τους συµπιεστές 
(codecs) που υποστηρίζει η πλατφόρµα «Video for Windows», δηλ. η πλατφόρµα λογισµικού για την 
αναπαραγωγή αρχείων video στα MS Windows.  
      Οι συµπιεστές αν χρησιµοποιούν αλγόριθµους µε διαπλαισιακές τεχνικές συµπίεσης τότε στα 
αρχεία βίντεο που δηµιουργούν καλό είναι να αποφεύγουµε την µετέπειτα πολύπλοκη επεξεργασία 
για τους λόγους που αναφέραµε πιο πάνω. Έτσι, στη σύλληψη βίντεο πρέπει να αποφεύγουµε να 
χρησιµοποιούµε διαπλαισιακούς συµπιεστές αν σκοπεύουµε να το επεξεργαστούµε ποικιλοτρόπως.       
Η σειρά των διεργασιών είναι:  

1) σύλληψη βίντεο µε ένα µη διαπλαισιακό συµπιεστή  
2) επεξεργασία µε ένα λογισµικό και  
3) εξαγωγή – συµπίεση µε τη χρήση ενός διαπλαισιακού συµπιεστή για να πετύχουµε την µέγιστη 

συµπίεση µε την καλύτερη δυνατή ποιότητα.  
      Βέβαια αν δεν έχουµε σκοπό να επεξεργασθούµε το βίντεο που θα δηµιουργηθεί από τη σύλληψη, 
τότε χωρίς συζήτηση θα χρησιµοποιήσουµε ένα διαπλαισιακό συµπιεστή για να αποφύγουµε την 
µεγάλη διαµεταγωγή και τα περιττά GBytes στο σκληρό µας δίσκο.  
 Οι γνωστότεροι συµπιεστές που χρησιµοποιούνται είναι:  
� Χωρικής (ενδοπλαισιακής) συµπίεσης – αρχείο πλήρως επεξεργάσιµο  

• M-JPEG ή Motion JPEG (*.avi) Ο συµπιεστής Μ-JPEG εφαρµόζει συµπίεση κατά JPEG 
σε κάθε πλαίσιο του αρχείου avi. Στην καλύτερη ποιότητα η συµπίεση φθάνει µέχρι 4:1.  

• DV (*.avi) Ο Συµπιεστής που χρησιµοποιούν σχεδόν όλες οι ψηφιακές βιντεοκάµερες. Η 
ποιότητα είναι πάρα πολύ καλή και ο λόγος συµπίεσης είναι σταθερός περίπου 8:1.  

• HUFFYUV (*.avi). Μη απωλεστικός συµπιεστής µε άριστη ποιότητα αλλά µε πολύ 
χαµηλό λόγο συµπίεσης 2:1  

MPEG-1, PAL, 352x288, 25 fps, CBR (Constant bitrate) 1.150 kbits/sec 
MPEG-1 Audio Layer II, 44100Hz, Stereo, 224kbits/sec 

MPEG-2, PAL, 480x576, 25 fps CBR ή VBR 1.600 έως 2520  kbits/sec 
MPEG-1 Audio Layer II, 44100Hz, Stereo, 224kbits/sec 

MPEG-2, PAL, 720x576, 25 fps CBR ή VBR 700 έως 9200     kbits/sec 
MPEG-1 Audio Layer II, 48000Hz, Stereo, 64-384kbits/sec ή 
ή Dolby Digital (AC-3), 48000Hz, 6 ch, 128-448kbits/sec ή 
ή Linear PCM, 48000Hz, Stereo, 1536kbits/sec 

Αποδοτικότερη συµπίεση µε πολύ καλή ποιότητα                       
Codecs DivX - XviD - Microsoft MPEG-4- MPEG-4/Η.264                               
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• Cinepak της Radius (*.avi) Ο συµπιεστής «Cinepak» είναι αρκετά διαδεδοµένος στη 
πλατφόρµα Video for Windows (υπάρχει εγκατεστηµένος).  

• ∆ιάφοροι συµπιεστές καρτών σύλληψης (*.avi)  
� Χρονικής (διαπλαισιακής) συµπίεσης - αρχείο µερικώς επεξεργάσιµο  

• MPEG -1 (*.mpg) Ο συµπιεστής στον οποίο βασίζεται το πρότυπο VideoCD (VCD)  
• MPEG -2 (*.mpg) Ο συµπιεστής στον οποίο βασίζονται τα πρότυπα: Super VideoCD, 

Digital Video Disk, High Definition Video, Blu-Ray Disc, και η τηλεόραση υψηλής 
ευκρίνειας (SVCD, DVD, HDV, BRD HDTV,)  

• MPEG -4 (*.avi) Ο συµπιεστής που ακόµα εξελίσσεται. Αποδίδει ίδια ή και καλύτερη 
ποιότητα εικόνας από το MPEG -2 µε µεγαλύτερη συµπίεση. Υποστηρίζεται από πολλά 
επιτραπέζια DVD players. Ιδανικός για παρουσιάσεις στα Windows ιδιαίτερα όταν έχει 
εφαρµοστεί ο Microsoft MPEG-4. Έχει πολλές εφαρµογές όπως για Video Streaming σε 
ασύρµατες συσκευές, στη αλληλεπιδραστική τηλεόραση (εκποµπές ευρείας ζώνης), στο 
πρότυπο HD-DVD κ.α..  

• Quick Time (*.mov) To QuickTime είναι λογισµικό και για την αναπαραγωγή αρχείων 
οπτικοακουστικής πληροφορίας. Αναπτύχθηκε αρχικά για υπολογιστές Apple αλλά 
γρήγορα επεκτάθηκε και στα MS Windows. Το QuickTime µπορεί να αναπαράγει αρχεία 
video, χαρτογραφικά και διανυσµατικά γραφικά, ψηφιοποιηµένο ήχο και ήχο midi, 
σχεδιοκίνηση 2D και 3D και αρχεία εικονικής πραγµατικότητας.  

• Real Media (*.rm) Αυτό το πρότυπο προορίζεται βασικά για την άµεση αναπαραγωγή 
βίντεο στο διαδίκτυο, χωρίς δηλαδή να προηγείται το κατέβασµα του βίντεο στο σκληρό 
δίσκο του υπολογιστή. Το πρότυπο RΜ υποστηρίζει µεγάλη συµπίεση και κατά κανόνα 
µέτρια έως χαµηλή ποιότητα.  

• Windows Media Video (*.wmv). Αναπτύχθηκε από την Microsoft µε στόχο την 
αναπαραγωγή βίντεο στο διαδίκτυο. Η συµπίεση είναι µεταβλητή και η ποιότητα ίδια 
περίπου µε του Real Media. Ιδανικό για παρουσιάσεις µέσω εφαρµογών των Windows.  

• Η.261 Πρόκειται για συµπιεστή που χρησιµοποιείται σε εφαρµογές εικονοδιάσκεψης και 
εικονοτηλεφωνίας, πάνω από γραµµές ISDN.  

• Η.263 Σχεδιασµένος για χαµηλότερο εύρος ζώνης και χρησιµοποιείται για µετάδοση 
βίντεο στο διαδίκτυο µε χρήση πρωτοκόλλου IP. Προσφέρει την ίδια ποιότητα µε τον 
προηγούµενο αλλά µε στο µισό περίπου µέγεθος.  

 

2.5.2.5 Απαιτήσεις Σύλληψης Video σε  
Hardware/Software  

� Κάρτα σύλληψης video – ήχου (Χαρακτηριστικά έχουν αναφερθεί παραπάνω)  
Η κάρτα ψηφιοποίησης βίντεο πρέπει να είναι αρκετά γρήγορη για να µπορεί να µεταφέρει 
την εικόνα βίντεο στο επίπεδο της ποιότητας που απαιτεί το τελικό µέσο. Για NTSC βίντεο 
πλήρους οθόνης µε πλήρη κίνηση, η κάρτα πρέπει να µπορεί να ψηφιοποιεί 30 πλαίσια ανά 
δευτερόλεπτο σε µέγεθος 640 Χ 480 pixels και για τα PAL - SECAM, η κάρτα πρέπει να 
µπορεί να ψηφιοποιεί 25 καρέ ανά δευτερόλεπτο σε διαστάσεις 720 Χ 576 pixels χωρίς 
απόρριψη πλαισίων (drop frames).  

� Κεντρική Μονάδα Επεξεργασίας (CPU)  
Ο επεξεργαστής του υπολογιστή πρέπει να είναι αρκετά γρήγορος ώστε να µπορεί να 
συµπιέζει τα καρέ που ψηφιοποιούνται στο επιθυµητό frame rate. Σαφώς, θα πρέπει να 
χρησιµοποιείτε την ταχύτερη δυνατή CPU, ή πολλαπλές CPU στον ίδιο υπολογιστή 
(πολυεπεξεργασία). Οι επεξεργαστές που κυκλοφορούν σήµερα (3GHz έως 3,8GHz), είναι 
πάρα πολύ γρήγοροι και ικανοί για σύλληψη και επεξεργασία βίντεο.  

� Σκληρός δίσκος  
Ο σκληρός δίσκος πρέπει να είναι αρκετά γρήγορος και ευρύχωρος για να µπορεί να 
αποθηκεύει τα καρέ τόσο γρήγορα, όσο φτάνουν από την κάρτα ψηφιοποίησης βίντεο, 
αλλιώς, ορισµένα από τα καρέ θα απορρίπτονται καθώς ο δίσκος δε θα προλαβαίνει να 
αποθηκεύει µε µεγάλη ταχύτητα. Γενικά όλοι οι σηµερινοί δίσκοι έχουν τεράστιες 
χωρητικότητες και πολύ µεγάλες ταχύτητες διαµεταγωγής. Οι δίσκοι IDE & SATA (Idegrated 
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Drive Electronics & SerialATA) που κυκλοφορούν σήµερα έχουν χωρητικότητα από 80 GB 
έως 500GB και η µέση διαµεταγωγή τους κυµαίνεται από 50MB/sec έως 65 MB/sec, ενώ οι 
σηµερινοί δίσκοι που υποστηρίζουν το πρωτόκολλο SCSI (Small Computers System 
Interface) έχουν µικρότερη µεν χωρητικότητα (100 GB έως 350 GB) αλλά µεγαλύτερη µέση 
διαµεταγωγή (60MB/sec έως 75 MB/sec) και πολύ υψηλότερο κόστος. Για βέλτιστα 
αποτελέσµατα πρέπει οι ψηφιοποιήσεις να γίνονται σ' έναν ξεχωριστό, υψηλής απόδοσης 
σκληρό δίσκο, ο οποίος θα χρησιµοποιείται µόνο για σκοπούς ψηφιοποίησης και µοντάζ.  

� ∆ίαυλος δεδοµένων (Data bus)  
Κάθε υπολογιστής έχει έναν δίαυλο δεδοµένων ο οποίος συνδέει τα συστατικά του 
συστήµατος και χειρίζεται τη µεταφορά δεδοµένων µεταξύ τους. Η ταχύτητά του καθορίζει 
πόσο γρήγορα µπορεί ο υπολογιστής σας να µεταφέρει τα πλαίσια του βίντεο από τη κάρτας 
ψηφιοποίησης, στον επεξεργαστή και στον σκληρό δίσκο. Τα σηµερινά πρωτόκολλα 
µεταφοράς δεδοµένων (Ultra ATA, SATA, SCSI) επιτυγχάνουν µεγάλο ρυθµό διαµεταγωγής.  

� Λογισµικό σύλληψης  
Ένα καλό λογισµικό σύλληψης βοηθάει στο να εκµεταλλευθεί στο µέγιστο τις δυνατότητες 
του co-dec σύλληψης και τις δυνατότητες του υπολογιστή. Επίσης, το εύχρηστο και απλό 
λογισµικό βοηθάει τον χρήστη να χρησιµοποιήσει έτοιµους συνδυασµούς επιλογών και 
ρυθµίσεων για βέλτιστα αποτελέσµατα σύλληψης.  

� Codec σύλληψης  
Οι περισσότερες κάρτες ψηφιοποίησης βίντεο διαθέτουν ένα ολοκληρωµένο κύκλωµα 
συµπίεσης (compression chip), το οποίο κρατά την ταχύτητα µεταφοράς δεδοµένων µέσα στα 
επίπεδα που µπορεί να χειριστεί ο υπολογιστής. Εάν η κάρτα ψηφιοποίησης βίντεο δε διαθέτει 
ειδικό ολοκληρωµένο για συµπίεση και ο υπολογιστής ακολουθεί τις τελευταίες 
προδιαγραφές, θα πρέπει να γίνει η ψηφιοποίηση χρησιµοποιώντας ένα γρήγορο σχήµα codec 
υψηλής ποιότητας, όπως το Motion JPEG ή το DV. Εάν ο υπολογιστής είναι παλαιών 
προδιαγραφών, η ψηφιοποίηση πρέπει να γίνει µε ένα σχήµα codec που να υποστηρίζει 
συµπίεση µε απώλειες και να µην επιβαρύνει πολύ τη CPU, αλλιώς ορισµένα από τα πλαίσια 
θα απορριφθούν (drop frames), χάνοντας την ποιότητα του βίντεο και τον συγχρονισµό 
µεταξύ εικόνας και ήχου.  

� Κατάλληλο λειτουργικό  
Το λειτουργικό σύστηµα πρέπει να είναι συµβατό µε το υλικό και το λογισµικό που θα 
χρησιµοποιηθεί.  

� Λειτουργία άλλων εφαρµογών  
Ευνόητο είναι ότι όταν κάνουµε σύλληψη βίντεο δεν θα πρέπει να “τρέχει” καµία άλλη 
εφαρµογή που θα απασχολεί την CPU ή θα χρησιµοποιεί τον δίαυλο δεδοµένων.  
 

2.5.2.6   Απαιτήσεις Επεξεργασίας Video σε 
Hardware/Software 

� Οθόνη  
Πρέπει να είναι έγχρωµη, εύχρηστη, µε πολλά ρυθµιστικά, µεγάλου µεγέθους (17 έως 21 
ίντσες), CRT ή TFT, να υποστηρίζει µεγάλες αναλύσεις χωρίς µειονεκτήµατα στη 
καθαρότητα και τη γεωµετρία απεικόνισης.  

� Κάρτα γραφικών  
Η κάρτα γραφικών να µπορεί να οδηγήσει την παραπάνω οθόνη µε τις καλύτερες δυνατές 
ρυθµίσεις της χωρίς προβλήµατα.  

� Codec αποθήκευσης  
Αν δεν υποστηρίζει η κάρτα σύλληψης µε το λογισµικό που τη συνοδεύει, Codecs για τελική 
αποθήκευση και διανοµή, θα πρέπει να προµηθευτούµε από τις αντίστοιχες εταιρείες τους 
ιδανικότερους.  

� Λογισµικό επεξεργασίας  
Πρέπει να είναι εύχρηστο, απλό, λειτουργικό, συµβατό µε προηγούµενες εκδόσεις του και µε 
το υλικό-λογισµικό σύλληψης καθώς επίσης να έχει πολλές δυνατότητες επεξεργασίας και να 
δέχεται προσθετικά επεκτατικά πακέτα (αναβαθµίσεις - Plugins)  

� Μνήµη RAM  
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Τα λογισµικά επεξεργασίας βίντεο έχουν µεγάλες απαιτήσεις σε µνήµη RAM. Όσο µεγάλη 
και γρήγορη µνήµη τοποθετήσουµε το λογισµικό θα την αξιοποιήσει στο έπακρο. Γενικά µια 
γρήγορη και ποιοτική µνήµη από 1GB έως 2GB είναι υπεραρκετή.  

� Κάρτα ήχου - Ηχεία – Μικρόφωνο - Ακουστικά  
Αυτές οι συσκευές χρειάζονται για τη σύλληψη και αναπαραγωγή του ήχου. Ο ήχος ενός 
βίντεο µπορεί να επεξεργαστεί από το πρόγραµµα επεξεργασίας βίντεο. Αν τα προϊόντα 
βίντεο θέλουµε να έχουν πολυκάναλο ήχο (AC3 Dolby Digital), πρέπει η κάρτα ήχου και τα 
ηχεία να τον υποστηρίζουν. 

� Τεχνολογία ψηφιακού βίντεο (DV - Digital Video)  
Ψηφιακό video είναι η εντελώς ψηφιακή παραγωγή, επεξεργασία και αποθήκευση της 
οπτικοακουστικής πληροφορίας (ψηφιακές εικονοληπτικές µηχανές, ψηφιακές τεχνικές 
συµπίεσης, λογισµικό επεξεργασίας και δίσκοι DVD).  

      To DV ξεκίνησε το 1994 όταν περισσότερες από 50 εταιρείες συµφώνησαν σε µια κοινά αποδεκτή 
µορφοποίηση κασέτας DV. Οι πρώτες ψηφιακές βιντεοκάµερες εµφανίστηκαν στην αγορά το 1995 µε 
πολύ ψηλές τιµές. Από τότε οι τιµές τους πέφτουν συνεχώς ενώ ανεβαίνει η ποιότητα, το πλήθος των 
βελτιωµένων χαρακτηριστικών και ο βαθµός διείσδυσης τους στην αγορά συσκευών video ευρείας 
κατανάλωσης.  
 

2.5.2.7  Πλεονεκτήµατα της Ψηφιακής Πλατφόρµας  
      Το ψηφιακό video προσφέρει καλύτερη (έως και άριστη) ποιότητα εικόνας σε σχέση µε τις 
διάφορες πλατφόρµες του αναλογικού. Η καλύτερη εικόνα κρίνεται από τους τρεις παρακάτω 
βασικούς παράγοντες:  
1) Ανάλυση εικόνας. Η κάθετη ανάλυση της ψηφιακής εικόνας είναι τουλάχιστον δύο φορές 

µεγαλύτερη από εκείνη που µπορεί να προσφέρει η αναλογική τεχνολογία VHS και αρκετά 
µεγαλύτερη από τη S-VHS & Hi-8. Συγκρινόµενο ακόµα και µε τη πλατφόρµα Betacam που είναι 
η καλύτερη διαθέσιµη µορφοποίηση αναλογικού βίντεο, το DV προσφέρει καλύτερη ή 
τουλάχιστον ίση ποιοτικά εικόνα.  

2) Απόδοση Χρώµατος. Η τεχνολογία DV χρησιµοποιεί κωδικοποίηση χρώµατος component που 
αποδίδει καλύτερα τη χρωµατική πληροφορία σε σχέση µε το Y/C (χρησιµοποιείται στο S-VHS & 
Hi-8) ή το composite (στο VHS & 8mm).  

3) Λόγος σήµατος προς θόρυβο. Ο λόγος σήµατος προς θόρυβο (signal to noise ratio ή S/N) είναι το 
κλάσµα µε αριθµητή το πλάτος (ή ισχύ) του σήµατος που µεταφέρει την πληροφορία και 
παρονοµαστή το επίπεδο θορύβου που παράγει η συγκεκριµένη τεχνολογία. Μετριέται σε decibel 
(db) και όσο µεγαλύτερος είναι τόσο καλύτερη η ποιότητα µετάδοσης και αναπαραγωγής της 
πληροφορίας από τη συγκεκριµένη τεχνολογία. Στην περίπτωση εγγραφής και αναπαραγωγής της 
εικόνας υψηλή τιµή του S/N σηµαίνει καθαρότερη εικόνα µε λιγότερα παράσιτα, λόγω π.χ. 
στατικού ηλεκτρισµού ή άλλων τεχνολογικών προβληµάτων.  

      Στον παρακάτω πίνακα συνοψίζονται οι τιµές των χαρακτηριστικών στοιχείων για τις πλατφόρµες 
ψηφιακού (DV) και αναλογικού (S-VHS, Hi8, VHS, 8 mm) video. Η υπεροχή του DV είναι 
προφανής. 
 
 

Κάθετη ανάλυση (γραµµές) 500 400-420 240-250 
Κωδικοποίηση χρώµατος Component Y/C Composite 
Λόγος σήµατος προς θόρυβο (S/N σε db) 60 45 - 46 43 - 45 

Πίνακας 6: Πλατφόρµες Αναλογικού- Ψηφιακού Βίντεο 
 

 Εκτός όµως από τα παραπάνω πλεονεκτήµατα που έχει η τεχνολογία DV, υπάρχουν και άλλα  
σηµαντικά πλεονεκτήµατα όπως:  

� Το DV παράγει εξ’ αρχής την πληροφορία σε ψηφιακή µορφή, οπότε µε ένα δίαυλο υψηλών 
ταχυτήτων, όπως είναι το καλώδιο και η κάρτα IEEE-1394 (ή FireWire ή iLink), µεταφέρεται 
και αποθηκεύεται πάρα πολύ εύκολα, χωρίς καµία απώλεια, για επεξεργασία τυχαίας 
προσπέλασης στον υπολογιστή.  

� Το µέγεθος της βιντεοκάµερας είναι πολύ µικρότερο από τις αντίστοιχες αναλογικές.  

DV S-VHS/Hi8 VHS/8mm 
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� Ο ήχος έχει καλύτερη ποιότητα από την ποιότητα CD.  
� Η τεχνολογία DV έχει ενσωµατώσει στις κασέτες εγγραφής µνήµη RAM για αποθήκευση 

πληροφοριών. Οι πληροφορίες αυτές είναι η ηµεροµηνία και οι ρυθµίσεις της κάµερας κατά την 
εγγραφή, τα περιεχόµενα κ.α., που πιθανόν να χρησιµοποιηθούν αυτές οι πληροφορίες στην 
µετέπειτα επεξεργασία.  

 
2.5.2.8   Ψηφιακό Βίντεο Υψηλής Ευκρίνειας (High 

Definition Video - HDV)  
      Το High Definition είναι ένας γενικός όρος που αφορά µόνο την ανάλυση των σηµάτων βίντεο. 
Υψηλή ανάλυση θεωρείται, οποιαδήποτε ανάλυση ξεπερνά την τυποποιηµένη 720x576, των 
κλασσικών ψηφιακών συστηµάτων. Το HDV υποστηρίζει δύο διαφορετικές αναλύσεις µε 
διαφορετικό τύπο σάρωσης. Έτσι, αντί για το Standard Definition (SD) PAL σήµα των 576i 
(720X576, inter-laced), το HDV αντιπροτείνει δύο διαφορετικά σήµατα, το 720p (progressive) και το 
1080i (inter-laced). Οι αναλύσεις αυτές είναι της τάξης των 1280x720pixel (720p) και 1920xl080pixel 
(1080i). Επίσης, για το HDV, έχουν προταθεί και άλλα format, αλλά προς το παρόν έχουν τυποποιηθεί 
µόνο τα 720p και 1080i, µε τα χαρακτηριστικά που ήδη αναφέραµε. Για παράδειγµα, για το 1080i έχει 
προταθεί και η ανάλυση των 1440x1080pixels, η οποία παρότι είναι σαφώς καλύτερη από το SD, δεν 
ξεπερνά την τυποποιηµένη ανάλυση των 1920x1080.  
      Το HDV υποστηρίζει το bitrate των 25Mbps, που συναντάµε στα λιγότερο συµπιεσµένα SD, µε 
την διαφορά ότι χρησιµοποιεί συµπίεση MPEG-2 (και όχι DCT όπως το DV), ώστε να επιτύχει 
υψηλότερες αναλύσεις στο ίδιο bitrate µε το DV. Εάν συγκρίνουµε το HDV και το SDV, όσον αφορά 
τον λόγο πλευρών (aspect ratio) της εικόνας, τότε βλέπουµε ότι το σήµα HDV περιλαµβάνει 
ενδογενώς το κάδρο µε λόγο 16:9, ενώ το σήµα SDV που έχει λόγο 4:3, για να πετύχει τον λόγο 
πλευρών 16:9 κρατάει την ανάλυση σταθερή και απλά διευρύνει τα pixel, µε µια τεχνική που 
ονοµάζεται wide pixel. 
       Όσον αφορά τα µέσα, χρησιµοποιείται ακριβώς η ίδια κασέτα miniDV, µε µόνη ενδεχόµενη 
διαφοροποίηση στην επίστρωση που αναµένεται να βελτιωθεί (όπως ισχύει µε το Digital 8 που γράφει 
σε Ηί8 κασέτες υψηλής ποιότητας). Μάλιστα µια 62 λεπτών miniDV κασέτα, µπορεί να χωρέσει 
βίντεο υψηλής ευκρίνειας 62 λεπτών που είναι απόλυτα λογικό αφού DV και HDV έχουν το ίδιο 
bitrate. Από το καλοκαίρι του 2006 οι εταιρείες Sony και Panasonic παρουσίασαν βιντεοκάµερες high 
definition που χρησιµοποιούν συµπίεση MPEG-4/H.264, το λεγόµενο format AVCHD (Advance 
Video Codec High Definition). Ως µέσο χρησιµοποιούν ή κάρτα µνήµης ή σκληρό δίσκο ή DVD 
δίσκο των 8 cm, το δε bitrate είναι µεταβλητό από 9Mbps έως 24Mbps το οποίο το επιλέγει ο χρήστης 
ανάλογα µε το µέσο που χρησιµοποιεί η κάµερα και την ποιότητα που επιθυµεί. Η ποιότητα του 
βίντεο µε format AVCHD σε σχέση µε το HDV είναι καλύτερη αν υποστηρίζεται και χρησιµοποιείται 
bitrate µεγαλύτερο των 15Mbps.  
      Κάνοντας µια σύγκριση του HD(HDV ή AVCHD) και του SD µε απλά λόγια, θα συνοψίζαµε ότι 
το HD σε σχέση µε το SD, προσφέρει µεγαλύτερη απεικόνιση της λεπτοµέρειας, καλύτερη οξύτητα, 
πλουσιότερα και άρα φυσικότερα χρώµατα. Λογικά φαίνεται ότι το HDV/AVCHD θα αποτελέσει την 
εξέλιξη του DV αν και υπάρχουν σηµαντικές διαφορές µεταξύ των δύο προτύπων, όσον αφορά την 
συµπίεση, την ανάλυση, ακόµα και τον τρόπο λήψης.  
 

2.5.2.9 Στρατηγική Συλλογής & ∆ηµιουργίας Ψηφιακού 
Βίντεο  
Πριν ξεκινήσουµε να κάνουµε οτιδήποτε σχετικά µε το βίντεο, πρέπει προηγουµένως να κάνουµε 
απαραίτητα τα παρακάτω βήµατα:  

1) Αξιολόγηση ποιότητας του πηγαίου υλικού µας,  
2) Αξιολόγηση δυνατοτήτων υλικού και λογισµικού µας,  
3) Καθορισµός του µέσου αναπαραγωγής του τελικού video και, τέλος,  
4) Καθορισµός της τελικής µορφής του video.  

 
� Συλλογή ψηφιακών Video clip  
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Γενικά η συλλογή ψηφιακών αποσπασµάτων βίντεο (Video clip) µπορεί να επιτευχθεί µε τους 
παρακάτω τρόπους:  
• Μέσω κάρτας σύλληψης από αναλογικό Video  
• Μέσω κάρτας σύλληψης µε τηλεοπτικό δέκτη, από τηλεοπτικό σήµα  
• Αντιγραφή-µεταφορά video clip από κάµερα DV  
• Αντιγραφή αρχείων video από διάφορα αποθηκευτικά µέσα  
• Κατέβασµα αρχείων video από το διαδίκτυο  
• Απόσπαση video τίτλων (extraction) από DVD, SVCD, VCD  
• Σύλληψη της απεικόνισης της οθόνης του υπολογιστή µε χρήση κατάλληλου λογισµικού.  

� Οδηγίες ψηφιοποίησης αναλογικού βίντεο  
Αρχικά συνδέουµε την πηγή µας µε την κάρτα βίντεο, όπως έχουµε αναφέρει σε προηγούµενο 
κεφάλαιο, και ελέγχουµε εάν το σήµα βίντεο περνά στην κάρτα µας. Το λογισµικό που 
συνοδεύει τις κάρτες βίντεο µας παρέχει αυτή τη δυνατότητα ελέγχου (σήµα composite ή σήµα 
S-Video). Εκτός βέβαια από το σήµα βίντεο ελέγχουµε και τον ήχο, ο οποίος περνά στον 
υπολογιστή ή µέσω της κάρτας βίντεο ή, αν δεν υποστηρίζει, µέσω της κάρτας ήχου του 
υπολογιστή.  

      Αφού βεβαιωθούµε ότι η εικόνα και ο ήχος περνούν στον υπολογιστή, πραγµατοποιούµε µερικές 
δοκιµαστικές συλλήψεις βίντεο περιορισµένης χρονικής διάρκειας, ξεκινώντας από µικρές αναλύσεις 
και ρυθµούς ανανέωσης των καρέ, που σταδιακά αυξάνουµε, µέχρις ότου η κάρτα σύλληψης αρχίσει 
να χάνει καρέ πράγµα που σηµαίνει ότι έχει φτάσει στα όριά της σε σχέση µε το σύστηµα που 
διαθέτουµε. Σηµαντικό ρόλο παίζει και η επιλογή του codec, καθώς και οι ρυθµίσεις του. 
Περισσότερες απαιτήσεις έχει από τον επεξεργαστή µια σύλληψη κατευθείαν σε MPEG-2 από ότι σε 
DV ή M-JPEG, µόνο που στους τελευταίους απαιτείται µεγαλύτερος και πιο γρήγορος σκληρός 
δίσκος. Αφού γίνουν οι τελικές ρυθµίσεις (πχ. είσοδος composite, σε PAL, µε τον DV codec) ξεκινάµε 
τη σύλληψη. 
 

 
Εικόνα 14: Ρυθµίσεις Σύλληψης (1) 
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Εικόνα 15: Ρυθµίσεις Σύλληψης (2) 

 
      Στις παραπάνω εικόνες (Εικόνα 14, 15)φαίνονται οι επιλογές και οι ρυθµίσεις σύλληψης για το 
σήµα βίντεο, για τα χρώµατα, για τον ήχο και για τους codecs του βίντεο και του ήχου.  
Καλό είναι, αν είναι δυνατόν, να βελτιώσουµε το αναλογικό σήµα πριν την εγγραφή (καθαρισµός 
κεφαλής VHS, χρησιµοποίηση ποιοτικών καλωδίων ενδοσύνδεσης κλπ.), για να επιτύχουµε την 
µέγιστη ποιότητα του αρχείου βίντεο.  
� Εισαγωγή ψηφιακού βίντεο από DVD - SVCD – VCD (video extraction)  

Αν το πηγαίο υλικό είναι ήδη ψηφιοποιηµένο σε ψηφιακό δίσκο και θέλουµε να 
εκµεταλλευθούµε κάποια αποσπάσµατα βίντεο, τότε µεταφέρουµε τα δεδοµένα βίντεο από το 
cd ή το dvd στο σκληρό µας δίσκο µε τη βοήθεια κάποιου ειδικού προγράµµατος. Μερικά από 
τα προγράµµατα αυτά είναι τα: DVD Shrink (www.dvdshring.org), CloneDVD2 
(www.elby.ch), Nero Recoder 2 (www.nero.com), DVD Rebuilder, DVD Decrypter πολλά από 
τα οποία διατίθενται ελεύθερα. 

 

2.6       Χαρακτηριστικά Ήχου  
      Η ενσωµάτωση του ήχου στις εφαρµογές πολυµέσων βελτιώνει ουσιαστικά την παρουσίαση του 
πληροφοριακού υλικού. Ο ήχος λειτουργεί συµπληρωµατικά ως προς τα κείµενα και τις φωτογραφίες 
και κυρίως ως προς το βίντεο και τη σχεδιοκίνηση. Η δυναµική και ο ρεαλισµός της εφαρµογής 
αυξάνει σηµαντικά µε τη χρήση των κατάλληλων ηχητικών δεδοµένων. Στο χώρο της εκπαίδευσης, η 
ενσωµάτωση κατάλληλου ήχου και µουσικής στις παρουσιάσεις µε χρήση οπτικοακουστικών µέσων, 
έχει ως στόχο τη βελτίωση του µηνύµατος και την ενίσχυση της διαδικασίας της µάθησης.  
      Μπορούµε να χρησιµοποιήσουµε τον ήχο σε µια πολυµεσική εφαρµογή σαν ήχο περιεχοµένου 
(αφηγήσεις για γεγονότα ή περιστατικά που σχετίζονται µε το θέµα, µαρτυρίες, εκφωνήσεις 
περιεχοµένων εφαρµογής, οδηγίες πλοήγησης, επεξηγήσεις κλπ.), ή σαν ήχο περιβάλλοντος (ενίσχυση 
του µηνύµατος π.χ. ήχος αέρα – ζώων, µουσική επένδυση, ηχητικά εφέ κλπ.). 
 

2.6.1     Φυσική Θεωρία του Ήχου 
      Ο ήχος είναι από τα πιο εντυπωσιακά στοιχεία των πολυµεσικών εφαρµογών και 
οπτικοακουστικών παραγωγών, καθώς µπορεί να προσφέρει ακουστική απόλαυση, να εντυπωσιάσει 
µε διάφορα ηχητικά εφέ και να ξεκουράσει σαν ηχητική υπόκρουση. Ο ήχος παράγεται από µια πηγή 
και συλλαµβάνεται από το αυτί µας. Συγκεκριµένα, ο ήχος, είναι η αίσθηση που αντιλαµβανόµαστε 
όταν τα ακουστικά νεύρα ενεργοποιούνται από µόρια που δονούνται στον αέρα, π.χ. όταν κτυπάει ένα 
κουδούνι αυτό δονείται. Η κίνηση αυτή διοχετεύεται στα περιβάλλοντα µόρια του αέρα, όπου και 
δονούν τα γειτονικά τους µόρια προκαλώντας µε αυτή την κίνηση δόνηση στο τύµπανο. Εντούτοις, ο 
ήχος παρουσιάζεται και ως κυµατοµορφή, το µέγεθος της οποίας αντιπροσωπεύει την ευρύτητα του 
και επίσης, το ύψος αναδεικνύει την σχετική ισχύει ή δύναµη του ήχου. (Εικόνα 16). 
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      Μέσο διάδοσης του ήχου µπορεί να είναι ο αέρας, το νερό ή και κάποιο στερεό σώµα. Το µέσο 
διάδοσης καθορίζει και τις ιδιότητες του ήχου, δηλ. αλλιώς ακούγονται οι ήχοι στο νερό, αλλιώς 
φιλτράρονται και µε άλλες ταχύτητες µεταδίδονται. Ο ήχος που ακούµε δεν είναι τίποτα άλλο παρά 
κυµάνσεις του αέρα, το πλάτος και η συχνότητα των οποίων διαµορφώνουν το ποιόν του ήχου που 
ακούµε. 

o Ο απλούστερος τύπος κύµανσης είναι το ηµιτονικό σήµα, το οποίο αντιστοιχεί σε µία µόνο 
συχνότητα και είναι ένα περιοδικό σήµα. Αυτό σηµαίνει πως ο πρώτος παλµός ακολουθείται 
από πολλούς ίδιους παλµούς. Τα περιοδικά κύµατα δηµιουργούν ήχους που λέγονται τόνοι, 
όπως είναι οι τόνοι που παράγει µια κιθάρα, ένα πιάνο ή ένα διαπασών. 

o Το βασικό στοιχείο µιας ηχητικής κύµανσης είναι η έντασή της, δηλ. το πλάτος της. Όσο 
µεγαλύτερο είναι το πλάτος, τόσο ισχυρότερα ακούγεται ο ήχος. Φυσική µονάδα µέτρησης της 
έντασης του ήχου είναι το decibel (dB), που είναι µια λογαριθµική κλίµακα. Όταν 
διπλασιάζεται η ένταση ενός ήχου, αυξάνει κατά 3 dB στη λογαριθµική κλίµακα. 

o Ένα άλλο στοιχείο µιας ηχητική κύµανσης είναι η συχνότητά της, που µας επιτρέπει να 
κατατάξουµε τους ήχους σε µπάσους ή οξείς. Η συχνότητα ενός ηχητικού σήµατος ορίζεται 
σαν ο αριθµός των παλµικών δονήσεων ανά δευτερόλεπτο και µετριέται σε Hertz (Hz) (Εικόνα 
17). 

 

 
         Εικόνα 16: Ύψος Κυµατοµορφής 

 
Εικόνα 17: Συχνότητα κυµατοµορφής 
 

2.6.2     ∆ιαδικασία Ψηφιοποίηση Ήχου 
      Ο ήχος είναι µια διακύµανση πιέσεων και το µικρόφωνο αποτελεί το όργανο εκείνο που 
µετατρέπει ένα ηχητικό σήµα σε διακύµανση ηλεκτρονικής τάσης , αυτή η ηλεκτρονική τάση είναι το 
αναλογικό ηλεκτρονικό σήµα. Για να γίνει δυνατή η επεξεργασία του από τον Η/Υ απαραίτητη 
προϋπόθεση η ψηφιοποίηση του, µετατρέποντας το αναλογικό (analogy) σε ψηφιακό (digital) µε την 
χρήση των µετατροπέων,  ADC (Analog-to-Digital-Converters)  και DAC (Digital-to-Analog- 
Converters DACs) και αντίστροφα. Έτσι, η διαδικασία αυτή συµπεριλαµβάνει τρείς βασικές 
λειτουργίες: την «δειγµατοληψία» του αρχικού σήµατος, τον «κβαντισµό» των τιµών του σήµατος 
διακριτών χρόνου που προκύπτει από την δειγµατοληψία και τέλος η «κωδικοποίηση».  
      Πιο συγκεκριµένα, κατά την δειγµατοληψία παίρνονται δείγµατα του πλάτους του αναλογικού 
σήµατος σε τακτά χρονικά διαστήµατα µε συνεπακόλουθο να δηµιουργείται ένα στιγµιότυπο του 
σήµατος της συγκεκριµένης τιµής, σύνολο το οποίου τα δείγµατα διαµορφώνουν το ψηφιοποιηµένο 
σήµα.  Αντίθετα, στον κβαντισµό οι διαδοχικές τιµές της στάθµης (πλάτους) του σήµατος διακριτού 
χρόνου sd(nTs) µετατρέπεται σε διακριτές (ψηφιακές) τιµές, πραγµατοποιείται δηλαδή µια απεικόνιση 
της µορφής  s(nTs) =Q{sd(nTs)} όπου Q{sd(nTs)} είναι η κβαντισµένη τιµή. Κατά την παραπάνω 
µετατροπή το τελικό σήµα είναι διακριτό τόσο ως προς το χρόνο όσο και ως προς το πλάτος που 
καλείται ψηφιακό. 
      Όπως έχει ήδη τυπωθεί, το αναλογικό σήµα ακουστικής πίεσης µετατρέπεται σε ψηφιακό µε την 
χρήση υποσυστηµάτων εφαρµογής Α/Ψ (Analog-to-Digital-Converters) και το αντίστροφο, 
υλοποιείται µε την χρήση Ψ/Α µετατροπών (Digital-to-Analog- Converters DACs) όπου οι 
κβαντισµένες τιµές µετατρέπονται σε αναλογικές. Σε τέτοια υποσυστήµατα οι διαδικασίες κβαντισµού 
και δειγµατοληψίας πραγµατοποιούνται ταυτόχρονα, ενώ η υλοποίηση των µετατροπέων και στις δύο 
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φάσεις, παρουσιάζουν τόσο θεωρητικά  όσο και πρακτικά προβλήµατα, ενώ για την σταθερή 
µετατροπή καλό θα είναι να ικανοποιούνται συγκεκριµένες συνθήκες δειγµατοληψίας  και 
κβαντισµού.  

 
Εικόνα 18: ∆ιαδικασία Ψηφιακού Σήµατος 

 

2.6.3     Μορφές Ψηφιακού Ήχου  
� Ήχος MIDI (Musical Instrument Digital Interface)  

Το πρότυπο MIDI καθορίζει τον ενδιάµεσο εξοπλισµό και το πρωτόκολλο επικοινωνίας 
για την ανταλλαγή ηχητικών δεδοµένων µεταξύ µουσικών οργάνων και υπολογιστών. 
Σύµφωνα µε αυτό, δεν αποθηκεύεται το ψηφιοποιηµένο σήµα του µουσικού οργάνου 
αλλά µια σειρά ειδικών πληροφοριών που απαιτούνται για την αναπαραγωγή του 
ηχητικού σήµατος. Στο πρότυπο MIDI η πληροφορία καταγράφεται µε τέσσερις αριθµούς 
που περιγράφουν ένα µουσικό γεγονός. Ο πρώτος περιγράφει τη νότα, ο δεύτερος το 
όργανο που την παρήγαγε, ο τρίτος την ένταση µε την οποία πατήθηκε η νότα και ο 
τέταρτος το χρόνο που έµεινε πατηµένο το πλήκτρο.  
Τα όργανα που µπορούν να χρησιµοποιηθούν για σύνθεση µουσικής περιέχονται στον 
πίνακα του συστήµατος MIDI, ο οποίος περιλαµβάνει 128 διαφορετικά όργανα. Επειδή τα 
αρχεία MIDI περιέ-χουν κώδικα και όχι ψηφιακές πληροφορίες κυµατοµορφών έχουν 
σηµαντικά µικρότερο µέγεθος σε σχέση µε τα αρχεία ψηφιοποιηµένου ήχου. Για 
παράδειγµα, ένα λεπτό µουσικής αποθηκευµένο σε αρχείο WAV απαιτεί περίπου 10 MB, 
ενώ σε αρχείο MIDI απαιτεί περίπου 6 ΚΒ. Ένα πολύ σηµαντικό χαρακτηριστικό των 
αρχείων MIDI είναι ότι ο ήχος µπορεί να χωριστεί σε 16 διαφορετικά κανάλια. Σε κάθε 
κανάλι αντιστοιχεί ένα όργανο και µε κατάλληλο συνδυασµό όλων των καναλιών 
µπορούµε να δηµιουργήσουµε µια ολοκληρωµένη σύνθεση. Οι ηχητικές πληροφορίες που 
αποθηκεύονται στα αρχεία MIDI, αφού επεξεργαστούν κατάλληλα, µπορούν να 
δηµιουργήσουν ηχητικά αποτελέσµατα που θα έδινε µια ολόκληρη ορχήστρα µε διάφορα 
όργανα. 

� Ψηφιακός ήχος µε παλµοκωδική κωδικοποίηση (PCM- Pulse Code Modulation)  
Είναι η πιο απλή και ευρέως χρησιµοποιούµενη τεχνική κωδικοποίηση ήχου. Ο PCM 
ήχος δηµιουργείται µέσω της σύνδεσης των εισόδων της κάρτας ήχου του υπολογιστή µε:  

� το µικρόφωνο,  
� την αναλογική έξοδο (line out) διαφόρων ηχητικών συσκευών (µαγνητόφωνα, 

ενισχυτές, ηλεκτρικά µουσικά όργανα κλπ).  
                   Ο ψηφιακός ήχος µε παλµοκωδική κωδικοποίηση χαρακτηρίζεται από:  

� Τη συχνότητα δειγµατοληψίας (sampling rate) που καθορίζει τον αριθµό 
των δειγµάτων πλάτους του αναλογικού σήµατος στη µονάδα του 
χρόνου(Εικόνα 16). Όσο µεγαλύτερη είναι αυτή η συχνότητα τόσο 
πιστότερη είναι η µετατροπή του ήχου. Η συχνότητα της δειγµατοληψίας 
είναι το πόσες φορές το δευτερόλεπτο λαµβάνει τιµές ο µετατροπέας ADC 

�� 
 Πηγή 

� 
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σήµα 

Ηλεκτρικό 
σήµα 

∆ειγµατοληψία 

Κβάντωση Κβαντοµένο 
σήµα 
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από το αναλογικό σήµα (Εικόνα 19).Οι σύγχρονες κάρτες ήχου προσφέρουν 
συχνότητες δειγµατοληψίας στα 11 KHz, 22,050 KHz και 44,100 KHz. 

�   Το µέγεθος δείγµατος (sampling size) που είναι ο αριθµός των bits που 
χρησιµοποιούνται για την αποθήκευση κάθε δείγµατος του αναλογικού 
σήµατος  

 

 
Εικόνα 18: Συχνότητα ∆ειγµατοληψίας 

 
Εικόνα 19: Κωδικοποίηση PCM 

 

 
Εικόνα 20: Χρήση PCM Κωδικοποίηση 

 

Αναλογικό σήµα 

Ψηφιακό σήµα µε χαµηλή 
συχνότητα δειγµατοληψίας 

Ψηφιακό σήµα µε υψηλή 
συχνότητα δειγµατοληψίας 
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Εικόνα 21: Παράδειγµα PCM Κωδικοποίηση 

 
      Αν η συσκευή έχει χωρητικότητα ή µέγεθος δείγµατος 8 bits, αυτό σηµαίνει ότι µπορεί να 
αποθηκεύσει τις τιµές που λαµβάνει από τη δειγµατοληψία σε πίνακες των 8 bits, δηλ. σε 256 (28) 
διαφορετικές τιµές. Αν, όµως, έχουµε κάρτα ήχου των 16 bits, τότε από τη δειγµατοληψία µπορούµε 
να έχουµε 65.536 (216) διαφορετικές τιµές και άρα πολύ καλύτερη ευκρίνεια και απόδοση του αρχικού 
αναλογικού ήχου. 
      Όσο πιο µεγάλος είναι ο ρυθµός δειγµατοληψίας τόσο µεγαλύτερο είναι το εύρος συχνοτήτων που 
µπορούµε να ηχογραφήσουµε και γενικά, όσο καλύτερες είναι οι επιλογές που κάνουµε για την 
πιστότητα του ήχου, τόσο µεγαλύτερος είναι και ο απαιτούµενος χώρος για την αποθήκευση ήχου της 
ίδιας διάρκειας. Με τη δειγµατοληψία µαζεύεται ένας τεράστιος αριθµός από δείγµατα και αυτό 
απαιτεί µεγάλες και γρήγορες µονάδες αποθήκευσης. 
      Για να καθορίσουµε τη συχνότητα δειγµατοληψίας χρησιµοποιούµε το θεώρηµα του Nyquist, 
σύµφωνα µε το οποίο : “ Η µεγαλύτερη συχνότητα ενός αναλογικού σήµατος που µπορεί να 
αποδοθεί χωρίς αλλοίωση πρέπει να είναι ίση µε το µισό της συχνότητας δειγµατοληψίας” . Έτσι, η 
συχνότητα δειγµατοληψίας των 44.100 Hz µε δείγµατα των 16 bits είναι αρκετή για να έχουµε 
ψηφιοποίηση στερεοφωνικής ποιότητας υψηλής πιστότητας. Μ’ αυτή την τυποποίηση είναι 
ψηφιοποιηµένοι και οι ήχοι των µουσικών CD στο εµπόριο. Με την κωδικοποίηση αυτή για να 
αποθηκεύσουµε 1 λεπτό στερεοφωνικού ήχου, θα χρειαζόµασταν περίπου 10 ΜΒ, δηλ. αρκετά 
µεγάλο µέγεθος αρχείου. 2 Χ 44100 Χ 16/8 Χ 60 = 10,1 ΜΒ. 
 

2.6.4   Συµπίεση Αρχείου Ψηφιακού Ήχου.  
      Κατά την ψηφιοποίηση ηχητικών δεδοµένων βλέπουµε ότι δηµιουργούνται αρχεία µεγάλων 
µεγεθών που είναι δύσκολο να µεταφερθούν, απαιτούν µεγάλους αποθηκευτικούς χώρους, πολύ 
µνήµη και µεγάλη υπολογιστική ισχύ. Για αυτούς τους λόγους είναι απαραίτητη η συµπίεση των 
αρχείων ήχου ώστε να µπορούν εύκολα να διαχειρισθούν. Στην συµπίεση των ηχητικών δεδοµένων 
εφαρµόζονται πολύπλοκοι αλγόριθµοι που συνδυάζουν απωλεστικές και µη απωλεστικές τεχνικές 
συµπίεσης οι οποίες βασίζονται σε ψυχοακουστικά µοντέλα βάσει των οποίων απορρίπτονται οι ήχοι 
που δεν γίνονται αντιληπτοί από το ανθρώπινο αυτί(Εικόνα 22).  
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Εικόνα 22: Ψυχοακουστικό Μοντέλο Ακοής 

 
      Έχει αποδειχθεί ότι η ευαισθησία του ανθρώπινου αυτιού περιορίζεται σε κάποιο συγκεκριµένο 
φάσµα ηχητικών συχνοτήτων. Έτσι, κάτω από τις συχνότητες των 20Hz δεν αντιλαµβανόµαστε 
τίποτα, ενώ το ίδιο συµβαίνει και πάνω από τις συχνότητες των 20KHz περίπου. Μπορούµε, λοιπόν, 
να απορρίψουµε τις πληροφορίες που αφορούν σε συχνότητες εκτός των συγκεκριµένων ορίων. 
Επιπλέον, όταν υπάρχει ένας κυρίαρχος ήχος συγκεκριµένης συχνότητας και έντασης είναι δυνατόν 
άλλοι ήχοι σε κοντινές συχνότητες και µικρότερης έντασης να µη γίνονται αντιληπτοί από το 
ανθρώπινο αυτί (φαινόµενο ηχητικής σκίασης) (Εικόνα 16). Το ίδιο ισχύει και όταν κάποιος ήχος έχει 
πολύ χαµηλή ένταση. Στις περιπτώσεις αυτές η κωδικοποίηση απορρίπτει τις σχετικές πληροφορίες, 
επιτυγχάνοντας µείωση του όγκου του τελικού αρχείου. Οι πληροφορίες που χάνονται είναι τέτοιες 
που, έτσι και αλλιώς, δεν µπορεί να τις αντιληφθεί το ανθρώπινο αυτί συνεπώς, η ποιότητα του ήχου 
παραµένει σε υψηλά επίπεδα. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Εικόνα 23: Φαινόµενο Ηχητικής Σκίασης 
 
      Στα ίδια ψυχο-ακουστικά µοντέλα στηρίζονται και οι αλγόριθµοι που δηµιουργήθηκαν από το 
γερµανικό ινστιτούτο ολοκληρωµένων κυκλωµάτων Fraunhofer σε συνεργασία µε το Πανεπιστήµιο 
του Erlangen ως µέλη της οµάδας εργασίας MPEG2 και δηµιούργησαν το πρότυπο συµπίεσης MPEG-
1 LayerΙΙΙ ή, όπως είναι ευρύτερα γνωστό, MP3. Ο ρυθµός µετάδοσης δεδοµένων (bit rate) µε τη 
χρήση του, µπορεί να φθάσει από τα 1378 Kbits/sec που είναι στον ασυµπίεστο ήχο στα 128 
Kbits/sec, δηλαδή η συµπίεση φθάνει τον λόγο 12:1 χωρίς να υπάρχει µεγάλη διαφορά στην ποιότητα 

Περιοχή ήχων παραπλήσιας 
συχνότητας και χαµηλότερης 
έντασης που δεν γίνονται 
αντιληπτοί από το ανθρώπινο 
αυτί  

Σήµα κυρίαρχου ήχου 

Συχνότητα 

Π

λ

ά

τ

ο

ς 
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από το αντίστοιχο ασυµπίεστο αρχείο ήχου. Με αυτή τη µέθοδο µπορούµε να αποθηκεύσουµε σε ένα 
CD, 12πλάσιο αριθµό µουσικών κοµµατιών ή άλλα αρχεία ήχου. Επίσης, το συµπιεσµένο αρχείο ήχου 
απασχολεί πολύ λιγότερο την κεντρική µονάδα επεξεργασίας (CPU) κατά την αναπαραγωγή και 
γενικά τη διαχείριση.  
 

2.6.4.1 Άλλα Πρότυπα Συµπίεσης Αρχείων Ήχου  
• WMA (Windows Media Audio)  

Στηρίζεται στις ίδιες βασικές αρχές συµπίεσης µε το MP3 µε άριστη ποιότητα αναπαραγωγής 
και µε µεγαλύτερη ακόµη συµπίεση στα 64 kbps (τα τραγούδια που είναι προστατευµένα δεν 
µπορούν να µεταδοθούν ελεύθερα).  

• MP3 PRO  
Είναι η εξέλιξη του MP3 και µπορεί να προσφέρει την ίδια ποιότητα µε το MP3 στο µισό 
µέγεθος των αρχείων.  

• RA (Real Audio)  
Προορίζεται για την άµεση αναπαραγωγή ήχων µέσω του διαδικτύου χωρίς να προηγείται το 
κατέβασµα των αρχείων ήχου στο σκληρό δίσκο µε ποιότητα σχεδόν σαν του CD.  

• AC3 Dolby Digital  
Το πρότυπο που υποστηρίζει κωδικοποίηση/αποκωδικοποίηση πολυκάναλου ήχου (6 
κανάλια) για τον οικιακό κινηµατογράφο. 

 

2.6.5 Κυριότερα Είδη Αρχείων Ήχο 
Τα είδη αρχείων ήχου που χρησιµοποιούνται συνήθως είναι τα εξής :  

 

FORMAT ΠΕΡΙΓΡΑΦΗ 
mp3 
(MPEG Layer 1,2,και 3) 
 

 Το πιο διαδεδοµένο πρότυπο συµπίεσης ψηφιακού ήχου µε στόχο την 
µεγαλύτερη συµπίεση και καλύτερη ποιότητα ήχου. Η συµπίεση των 
αρχείων ήχου µπορεί να φτάσει έως και 85%, χωρίς την ύπαρξη 
αισθητής διαφοράς στην ποιότητα απόδοσης. Xχρησιµοποιείται 
κυρίως για την διακίνηση  αρχείων µουσικής στο ∆ιαδίκτυο. 

Voc 
Voice 

Εισήχθη από την εταιρεία Creative για χρήση µε την κάρτα ήχου 
Sound Blaster και υποστηρίζει πληροφορία των 8 bits µε συχνότητα 
δειγµατοληψίας από 11.025 έως 44.100 Hz. 
 

Wav 
Wave 

Που είναι ο στάνταρτ τρόπος υποστήριξης ψηφιακού ήχου στο 
περιβάλλον των Windows. Υποστηρίζει ήχους σε 8 ή και 16 bits µε 
συχνότητα δειγµατοληψίας από 11.025 έως 44.100 Hz. 
 

midi 
Musical Instrument Digital 
Interface 

Πρόκειται για αρχεία κειµένου (ascii files), όπου οι πληροφορίες 
αφορούν στις νότες που πρέπει να αναπαραχθούν, στον ρυθµό της 
µουσικής και στο µέτρο. 
 

aiff 
Audio Interchange File Format 

Είναι µια µορφή κωδικοποίησης που εισήγαγε η εταιρεία Apple για 
τους υπολογιστές Macintosh. 

wma 
Windows Media Audio 

Από την Microsoft. Στόχο έχει την υποστήριξη απωλεστικής 
συµπίεσης 

ra 
Real Audio 

Προορίζεται για την άµεση αναπαραγωγή ήχων µέσω του ∆ιαδικτύου 

Πίνακας 7: Format Αρχείων Ήχων- Περιγραφή  
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3 ΠΕΡΙΓΡΑΦΗ ΤΩΝ ΛΟΓΙΣΜΙΚΩΝ ΠΑΚΕΤΩΝ 
 
      Στο παρόν κεφάλαιο γίνεται µια περιγράφει τον χώρο εργασίας του Sound Forge 8, του Adobe 
Photoshop CS2 και του Adobe Premiere Pro CS3, ώστε να γνωρίσουµε και να εξοικειωθούµε µε τις 
βασικές λειτουργίες τουs.  
        

 
 

3.1   Sound Forge 8 της Sonic Foundry 

       Το Sound Forge είναι το στάνταρ της µουσικής βιοµηχανίας για πάνω από µία δεκαετία. 
Πρόκειται για ένα εργαλείο που απευθύνεται στους επαγγελµατίες µουσικούς που θέλουν 
να δηµιουργήσουν και να επέµβουν σε ψηφιακά audio αρχεία µε απόλυτη ταχύτητα και ακρίβεια. 
Το πρόγραµµα διαθέτει ότι χρειαζόµαστε για να αναλύσουµε, να ηχογραφήσουµε, να επέµβουµε, να 
δηµιουργήσουµε µουσικά loops, να ψηφιοποιήσουµε και να ανακτήσουµε παλιές ηχογραφήσεις από 
βινύλιο ή άλλα µέσα, να εξοµοιώσει χώρους, να δηµιουργήσουµε streaming media και τέλος να 
δηµιουργήσουµε master audio CDs. 
Με τη χρήση του Sound Forge µπορούµε να κάνουµε τις εξής βασικές λειτουργίες:  

• Ηχοληψία – ψηφιοποίηση αναλογικού ήχου  
• Εισαγωγή ψηφιακού ήχου από µουσικό cd  
• Αντιγραφή, αποκοπή, και επικόλληση ηχητικού τµήµατος  
• Ρύθµιση της έντασης και των συχνοτήτων  
• Αλλαγή συχνότητας δειγµατοληψίας και αλλαγή µεγέθους δείγµατος  
• Αλλαγή χρονικής διάρκειας  
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• Μείξη ήχων  
• Απαλοιφή θορύβου - Εισαγωγή διαφόρων εφέ  
• Συµπίεση - Αποθήκευση  
 

3.1.1     Περιβάλλον Εργασίας  
      Ανοίγοντας την κεντρική οθόνη το προγράµµατος Sound Forge 8, που σκοπό έχει την άρτια 
ψηφιοποίηση και επεξεργασία ηχητικών δεδοµένων, θα παρατηρήσουµε την απλή και λειτουργική του 
µορφή. Στην παρακάτω εικόνα φαίνεται το περιβάλλον εργασίας (Εικόνα 24) και τα εργαλεία που 
διαθέτει και ακριβώς πιο κάτω  παραθέτω έναν πίνακα, µε την γενική περιγραφή των εργαλείων 
αυτών (Πίνακας 8). 

 

Εικόνα 24: Περιβάλλον Εργασίας Sound Forge 8 
 

ΕΡΓΑΛΕΙΑ ΠΕΡΙΓΡΑΦΗ 

Menu bar 

Μας εµφανίζει τις επικεφαλίδες των µενού για όλες τις 
διαθέσιµες λειτουργίες. Όταν δεν υπάρχουν ανοιχτά 
παράθυρα µε δεδοµένα, τα µενού Process, Effects και 
Tools δεν είναι διαθέσιµα, γιατί περιέχουν εντολές οι 
οποίες απαιτούν την ύπαρξη κάποιου ανοιχτού αρχείου 
στο χώρο εργασίας.  

Status bar  
Μας εµφανίζει πληροφορίες οι οποίες περιλαµβάνουν: 
την συχνότητα δειγµατοληψίας, το µέγεθος του 
δείγµατος, τον ψηφιοποιηµένος ήχο αν  είναι mono ή 
stereo και  την διάρκεια του χρόνου.  

Workplace  Αυτή είναι η περιοχή που βρίσκεται πίσω από τo Data 
window.  

Play meters  Μας εµφανίζουν το επίπεδο του εξερχόµενου ηχητικού 
σήµατος. Αυτά τα µέτρα µπορούν να ενεργοποιηθούν ή 



Πτυχιακή Εργασία Τµήµατος Εφαρµοσµένης Πληροφορικής & Πολυµέσων  

 - 41 - 

να απενεργοποιηθούν επιλέγοντας Play meters από το 
µενού View.  

Tool bar 
Μας δίνει την δυνατότητα να επιλέξουµε κάποιες από τις 
βασικές λειτουργίες του προγράµµατος όπως: new, open, 
save, save as, render as, publish, cut, edit tool, κτλ. 

Play bar 
Περιέχει κουµπιά ρύθµισης της αναπαραγωγής και 
συγκεκριµένα: record, loop playback, play all. Play, 
pause, stop, go to start, rewind, forward και go to end. 

Data window 

Τα παράθυρα δεδοµένων περιέχουν ηχητικά δεδοµένα (σε 
κυµατοµορφή) όπως επίσης και έναν αριθµό κουµπιών 
ελέγχου και εντολών που µπορείτε να χρησιµοποιήσετε 
για να επεξεργαστείτε τον ήχο.  

 
Πίνακας 8: Εργαλεία Περιβάλλοντος Εργασίας του Sound Forge- Περιγραφή 

 
� Ας Αναλύσουµε κάποιες επιλογές από το Menu bar: 

Κάνοντας λοιπόν, δεξί κλικ στον κατάλογο File, αναδύονται οι βασικές εντολές για άνοιγµα, 
κλείσιµο και αποθήκευση αρχείων. Ιδιαίτερο ενδιαφέρον παρουσιάζει η εντολή Properties, 
µέσω τις  οποίας διαφαίνεται ένα παράθυρο διαλόγου παρέχοντας σηµαντικές λειτουργίες 
ενός αρχείου ήχου (µέγεθος δειγµατοληψίας, συχνότητα δειγµατοληψίας, µορφοποίηση, 
µέγεθος αρχείου) . 

� Στο πρώτο µέρος εντολών του καταλόγου Edit , βρίσκονται οι εντολές αναίρεσης και  
επανάληψης της τελευταίας κίνηση, ενώ στην συνέχεια έπονται οι εντολές επεξεργασίας ήχου 
όπως αποκοπή, αντιγραφή, επικόλληση και διαγραφή. Αντίθετα, µε την εντολή Preview 
Cut/Cursor  παρέχεται η δυνατότητα αναπαραγωγής ήχου πριν την τελική ολοκλήρωση της 
επεξεργασίας του.  

 

                          

   Εικόνα 25: Κατάλογος «File»                            Εικόνα 26: Κατάλογος «Edit»      
 

� Στον κατάλογο View, παρουσιάζονται οι βασικές εντολές µε σκοπό την εµφάνιση διαφόρων 
παραθύρων του προγράµµατος, π.χ. Keyboard, mixer (µεικτός ήχος), ιστορικό των 
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αναιρέσεων. Παράλληλα στον κατάλογο αυτό, εµφανίζεται και η εντολή Clipboard η οποία 
µας παρέχει την δυνατότητα τόσο να δούµε το µέγεθος και τα χαρακτηριστικά του ήχου όσο 
και να ακούσουµε το περιεχόµενο του, ενώ µε την εντολή Toolbars διαµορφώνεται µε βάση 
τις δικές µας απαιτήσεις η εµφάνιση των εργαλείων.  

� Οι σηµαντικότερες εντολές για την επεξεργασία των ηχητικών δεδοµένων, απαρτίζονται στον 
κατάλογο Process όπως είναι η τροποποίηση την συχνότητας δειγµατοληψίας, το µέγεθος του 
δείγµατος, η χρονική στιγµή έναρξης, το µέγεθος της έντασης κτλ.  

 

                 

 Εικόνα 27: Κατάλογος «View»                               Εικόνα 28: Κατάλογος «Process» 
 

      Ολοκληρώνοντας τη γραµµή εργαλείων παρουσιάζεται και ο κατάλογος Effect, µέσω του οποίου 
παρουσιάζονται οι σχετικές εντολές που χρησιµοποιούνται για να προσδώσουν κάποιο εφέ είτε σε 
ολόκληρο το αρχείο είτε σε ένα µέρος του, π.χ. προσθήκη θορύβου, ηχώ, αναστροφή του ήχου, κτλ.  

 

Εικόνα 29: Κατάλογος «Effects» 
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3.1.2  Ψηφιοποίηση Αρχείου Ήχου  
o Ψηφιοποίηση ήχου µε την χρήση µικροφώνου. 
o Ψηφιοποίηση ήχου από µουσικό CD. 

 

3.1.2.1 Ψηφιοποίηση Ήχου µε Χρήση Μικροφώνου 
Για την υλοποίηση της ψηφιοποίησης ενός ήχου σε συνδυασµό µε την χρήση µικροφώνου, θα 

πρέπει πρώτα να επιλεχθεί µέσω του λειτουργικού συστήµατος των Windows το µικρόφωνο, ως µια 
πηγή εισόδου και στην συνέχεια, ο ήχος να ψηφιοποιηθεί µε βάση το πρόγραµµα Sound Forge 8. Το 
πρώτο πράγµα που χρειαζόµαστε σε ένα πρόγραµµα δειγµάτων για την ψηφιοποίηση  τέτοιας χρήση, 
είναι η ακόλουθη διαδικασία:  

� Συνδέουµε το µικρόφωνο µε την κάρτα ήχου. 
� Επιλέγουµε τον πίνακα ελέγχου του ήχου (volume control) µε διπλό κλικ στο µεγάφωνο που 

βρίσκεται τοποθετηµένο στο κάτω µέρος δεξιά της επιφάνειας εργασίας.  
� Από το Volume Control επιλέγουµε τις εξής εντολές: 

Option>Properties>Recording>Ok.(Εικόνα 30)  
� Στην συνέχεια εµφανίζεται το παράθυρο Recording Control µε επακόλουθο να επιλεχθεί ως 

πηγή το µικρόφωνο, ενώ οι υπόλοιπες πηγές να είναι κλειστές (mute) .(Εικόνα 31) 
 

 

    Εικόνα 30: «Volume Control»  & «Properties»            Εικόνα 31: «Recording Control» 

      Αφού ολοκληρωθεί η διαδικασία προετοιµασίας της πηγή εισόδου, έπεται η ψηφιοποίηση του 
ήχου µε την χρήση του Sound Forge 8 η οποία ακολουθείται από τα πιο κάτω στάδια: 

� Επιλέγουµε από την εργαλειοθήκη τον κόκκινο κύκλο ούτως ώστε να εµφανίζεται το 
παρακάτω παράθυρο.(Εικόνα 32) 

� Στην συνεχεία, κάνοντας κλικ στην εντολή New αναδύεται ο πίνακας µε τις σχετικές 
ρυθµίσεις τόσο της συχνότητας και του µεγέθους δειγµατοληψίας όσο και η επιλογή 
µονοφωνικού ή στερεοφωνικού ήχου.(Εικόνα 33)  

 



Πτυχιακή Εργασία Τµήµατος Εφαρµοσµένης Πληροφορικής & Πολυµέσων  

 - 44 - 

 

Εικόνα 32: Παράθυρο «Record» 

 

Εικόνα 33: Παράθυρο «New Window» 

      Ολοκληρώνοντας, µε δεξί κλικ στην εντολή ΟΚ, επιστρέφουµε στο πίνακα του Record και 
επιλέγοντας την εντολή monitor , µε αποτέλεσµα τον έλεγχο την έντασης της φωνής κατά την 
διαδικασία της ηχογράφησης. 

� Πατώντας το κόκκινο κύκλο, τίθεται σε λειτουργία η έναρξη της ηχογράφησης ενώ µε την 
χρήση του µαύρου τετράγωνου ολοκληρώνεται η διαδικασία αυτή. 

� Αφού γίνει η εκτέλεση των παραπάνω και κλείσουµε το παράθυρο εγγραφής, επιστέφουµε 
στην κύρια οθόνη του προγράµµατος µας όπου και έπεται η επεξεργασία του εισαγόµενου 
ήχου που µόλις φτιάξαµε. 

� Εν κατακλείδι, αποθηκεύουµε τον ήχο από το µενού File δίνοντας του τόσο το όνοµα όσο και 
τον τύπο του αρχείου.   

 

3.1.2.2  Ψηφιοποίηση Ήχου από Μουσικό CD: 
      Όπως και στη διαδικασία ψηφιοποίηση ήχου µε την χρήση µικροφώνου, έτσι και εδώ, επιλέγουµε 
ως πηγή εισόδου µέσω του λειτουργικού συστήµατος των Windows  την µονάδα CD και στην 
συνέχεια, έπεται η χρήση του προγράµµατος Sound Forge για  την ψηφιοποίηση ήχου. Τα βήµατα που 
ακολουθούµε για την προετοιµασία αυτή, είναι όµοια µε την παραπάνω περιγραφή , µε διαφορά ως 
πηγή εισόδου επιλέγεται από το παράθυρο Recording Control το CD Audio.Αφού ολοκληρωθεί η 
διαδικασία επιλογής εισόδου, ανοίγουµε το µουσικό CD, ενώ στην συνέχεια ακολουθεί η επιλογή του 
προγράµµατος CD player µέσω του Programs>Accessories> Entertainment µε σκοπό την επιλογή 
του µουσικού κοµµατιού που έγκειται στις προτιµήσεις µας.  
      Μεταβαίνουµε στο πρόγραµµα ψηφιοποίηση και επεξεργασίας Sound Forge 8  ακολουθώντας τα 
παρακάτω βήµατα: 
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I. Επιλέγουµε από την εργαλειοθήκη τον κόκκινο κύκλο. 
II.  Στην συνεχεία, επιλέγουµε την δηµιουργία νέου αρχείου µε αποτέλεσµα στο πίνακας 

που µας παρουσιάζεται να γίνονται οι σχετικές ρυθµίσεις όπως ειπωθήκαν παραπάνω. 
Τελειώνοντας τις ρυθµίσεις, πατάµε την εντολή ΟΚ. 

III.  Επιστρέφουµε στην εντολή Record, µε σκοπό τον έλεγχο την ηχογράφησης της 
έντασης µέσω του monitor . 

IV.  Έπεται η αναπαραγωγή του µουσικού κοµµατιού που έχουµε επιλέξει από το 
πρόγραµµα CD player πατώντας το κατάλληλο κουµπί, ενώ από το πρόγραµµα  Sound 
Forge και µε δεξί κλικ στο κουµπί ηχογράφηση (κόκκινο κύκλο) τίθεται σε λειτουργία 
η διαδικασία της εγγραφής.  

V. Ολοκληρώνοντας, επιστέφουµε στην κύρια οθόνη του προγράµµατος µας όπου και 
εκτελείται η επεξεργασία του ήχου που µόλις ηχογραφήσαµε. 

 

3.1.3  Επεξεργασία Ψηφιακών Αρχείων Ήχου 
      Το πρόγραµµα ψηφιοποίησης ήχου Sound Forge 8 της Sonic Foundry, ως ένα από τα 
δηµοφιλέστερα εργαλεία αυτής της κατηγορίας διαθέτει ένα ευρύ φάσµα δυνατοτήτων τόσο για την 
ψηφιοποίηση όσο και την επεξεργασία ενός ήχου, µε τον ίδιο εύκολο τρόπο που ένα πρόγραµµα 
επεξεργασίας κειµένου προσφέρει την δυνατότητα επεξεργασίας κειµένου. 

 Τροποποίηση συχνότητας δειγµατοληψίας: Μια από τις βασικές παραµέτρους της 
ψηφιοποίησης ήχου είναι η συχνότητα δειγµατοληψίας, που σύµφωνα µε το θεώρηµα του Nyquist 
θα πρέπει να είναι διπλάσια από αυτή που περιµένουµε στο αναλογικό. Το πρόγραµµα Sound 
Forge 8, επιτρέποντας την µείωση και την αύξηση του ψηφιοποιηµένου ήχου, µας παρέχει την 
δυνατότητα τροποποίησης της συχνότητας δειγµατοληψίας. Πιο συγκεκριµένα στην περίπτωση 
αύξησης της, είναι αδύνατον να αυξήσουµε στην πράξη τα δείγµατα για ένα ήχο που ήδη έχουµε 
ψηφιοποίηση, µε επακόλουθο να τίθενται σε χρήση ειδικοί αλγόριθµοι που δηµιουργούν 
µεγαλύτερο αριθµό δειγµάτων αλγοριθµικά χρησιµοποιώντας τα δείγµατα που υπάρχουν. Η 
διαδικασία αυτή γνωστή και ως παρεµβολής (interpolation). Για την τροποποίησης της 
συχνότητας δειγµατοληψίας επιλέγουµε από το κανάλι εντολών Process την εντολή Resample, 
ούτως ώστε να εµφανιστεί το παρακάτω παράθυρο για τον καθορισµό της..    

        

 
Εικόνα 33 :Παράθυρο Εντολής «Resample» 

 

 Τροποποίηση µεγέθους δειγµατοληψίας: Μια άλλη παράµετρος ψηφιοποίησης ήχου είναι το 
µέγεθος δειγµατοληψίας. Επιλέγοντας την εντολή 8bit –Depth Convert to από τον κατάλογο 
εντολής Process, µπορεί να καθοριστεί η µετατροπή του αρχείου ήχου µε µέγεθος δείγµατος 16bit 
σε αρχείο ήχου 8bit. Πιο συγκεκριµένα, µε την µέθοδο Dither , η οποία δίνει και τα καλύτερα 
ποιοτικά αποτελέσµατα αναπαραγοµένου ήχου, χρησιµοποιεί ένα πολύπλοκο αλγόριθµο 
εναλλαγής των τιµών των δειγµάτων στις 256 στάθµες κβάντωσης. 
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Εικόνα 34 : Παράθυρο Εντολής «8bit –Depth Convert» 

 

 Αντίθετα, για να τροποποιήσουµε το µέγεθος του δείγµατος από τα 8bit σε 16bit, θα πρέπει µε 
διπλό και δεξί κλικ στο κάτω µέρος της οθόνης στο σηµείο που αναγράφεται το µέγεθος 
δείγµατος 8bit, θα εµφανιστεί το επόµενο παράθυρο διαλόγου για την υλοποίηση της µετατροπής 
αυτής. 

 

 
Εικόνα 35 : Παράθυρο «Properties» 

 

 Τροποποίηση αριθµού καναλιών: Το πρόγραµµα Sound Forge 8, παρέχει την δυνατότητα 
τροποποίησης του αριθµού καναλιών του ψηφιακού αρχείου ήχου µέσω του καταλόγου εντολών 
Process επιλέγοντας της εντολής  Channel Converter. Από εκεί, µπορεί να γίνει η µετατροπή 
του ήχου σε µονοφωνικό ή στερεοφωνικό. 
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Εικόνα 36 : Παράθυρο Εντολής «Channel Converter» 

 

 Τροποποίηση έντασης: Όπως έχει ειπωθεί στο κεφ.2, η ένταση του ήχου είναι άµεσα 
συνδεδεµένη µε τα χαρακτηριστικά του µε µονάδα έντασης της το decibel (db). Με την χρήση του 
πρόγραµµα Sound Forge 8 και επιλέγοντας από τον κατάλογο εντολών Process την εντολή 
Volume, παρέχεται η δυνατότητα τροποποίησης της έντασης του ψηφιοποιηµένου ήχου. Στο 
σηµείο αυτό, οφείλουµε να αναφέρουµε ότι η σχετικά µικρή άνοδος της έντασης σε db µπορεί να 
διαµορφώσει µεγάλη αύξηση ισχύος. 

 

 
Εικόνα 37 : Παράθυρο Εντολής «Volume» 

 

 Σταδιακή αύξηση ή µείωση έντασης του ήχου: Το πρόγραµµα παρέχει την δυνατότητα 
διαµόρφωσης τόσο της σταδιακής αύξηση (fade in) έντασης του ήχου  µείωση όσο και την 
σταδιακή µείωση της (fade out). Για την υλοποίηση της παραπάνω διαδικασίας, θα πρέπει πρώτα 
να γίνει η επιλογή του συγκεκριµένου τµήµατος  µε σκοπό τη τροποποίησης της έντασης του, ενώ 
στην συνέχεια έπεται η επιλογή από τον κατάλογο Process η εντολή Fade In ή Fade Out. Η 
παρακάτω εικόνα αποτελεί ένα παράδειγµα της εντολής Fade In. 
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Εικόνα 38 : Παράδειγµα Εντολής «Fade In» 
 

 Τροποποίηση χρονικής διάρκειας: Μια άλλη δυνατότητα του προγράµµατος είναι η 
τροποποίηση της χρονικής διάρκειας του ψηφιοποιηµένου αρχείου ήχου. H διαδικασία αυτή 
υλοποιείται, επιλέγοντας από τον κατάλογο εντολών Process την εντολή Sony Time Stretch µε 
επακόλουθο τον καθορισµό της χρονικής διάρκειας του ήχου. Εντούτοις, θα πρέπει να θυµόµαστε 
ότι για την ορθή κατανοµή των δειγµάτων στο νέο χρονικό διάστηµα προϋποθέτετε είτε η 
συµπίεση τους είτε η επέκταση τους.    

 

 
Εικόνα 39 : Παράθυρο Εντολής «Sony Time Stretch» 

 

 Προσθήκη αντήχησης σε ένα ψηφιοποιηµένο ήχο: Εν κατακλείδι, το πρόγραµµα ψηφιοποίησης 
και επεξεργασίας Sound Forge 8 της Sonic Foundry, πέρα από αυτά, παρέχει τη δυνατότητα 
πρόσθεση ηχώ σε ένα ψηφιοποιηµένο ήχο επιλέγοντας από τον κατάλογο εντολών Effect την 
εντολή  Delay/Echo ούτως ώστε να εµφανιστεί το παρακάτω παράθυρο. 

 

 
Εικόνα 40 : Παράθυρο Εντολής «Delay/Echo» 

 

 Παράλληλα, επιλέγοντας την εντολή Preset αναδύεται ένας κατάλογος µε τις  προτεινόµενες 
µορφοποιήσεις αντήχησης έτσι ώστε να επιλεχθεί κάποια από αυτές. 
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Εικόνα 41 : Κατάλογος Εντολής «Presets»  
 

3.2 Adobe Photoshop CS2 της Adobe Systems 

 
      Το Adobe Photoshop είναι ένα από τα πιο δηµοφιλή προγράµµατα επεξεργασίας γραφικών στην 
αγορά. Με αυτό, θα µπορούµε να δούµε και να επεξεργαστούµε όλων των ειδών τις εικόνες. Το 
εργαλείο αυτό περιλαµβάνει όλα τα απαραίτητα στοιχεία για να πραγµατοποιήσουµε µια αληθινά 
επαγγελµατική δουλειά. Μπορούµε να κάνουµε από απλές επεξεργασίες µέχρι τη δηµιουργία 
περίπλοκών φωτογραφικών συνθέσεων µε όλα τα εφέ και τα φίλτρα που επιθυµούµε. Παρόλο που 
χρησιµοποιείται από επαγγελµατίες σε όλο τον κόσµο, η εφαρµογή είναι πολύ εύκολη στη χρήση. 
Όλα τα εργαλεία είναι διαθέσιµα σε µία µόνο µπάρα στην οποία έχουµε άµεση πρόσβαση χωρίς να 
χρειαστεί να αφήσουµε την οθόνη που βρίσκεται η εικόνα. Επιπλέον, το Adobe Photoshop CS2 
διαθέτει ένα καινοτόµο σύστηµα επεξεργασίας επιπέδων που µας επιτρέπει να προσαρµόσουµε 
ανεξάρτητα κάθε στοιχείο της φωτογραφίας ή της εικονογραφίας.. 
Με τη χρήση του Adobe Photoshop µπορούµε να κάνουµε τις εξής βασικές λειτουργίες: 

• Εισαγωγή εικόνας  
• Ρύθµιση της σωστής ανάλυσης,  
• Κοπή και στρέψη  
• Ρύθµιση των χρωµάτων, των τόνων και της αντίθεσης  
• Επεξεργασία σε επιλεγµένες περιοχές  
• Εφαρµογή ειδικών φίλτρων -εφέ 
• Εισαγωγή κειµένου  
• ∆ηµιουργία νέας εικόνας  
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• Αποθήκευση – Συµπίεση και πολλές άλλες ρυθµίσεις για βελτίωση του 
αποτελέσµατος.  

 

3.2.1  Περιβάλλον Εργασίας 
Ο χώρος εργασίας περιλαµβάνει µενού και µια ποικιλία εργαλείων και παλετών για την προβολή, 
επεξεργασία και προσθήκη στοιχείων στις εικόνες µας.. Ο προεπιλεγµένος χώρος εργασίας του 
Photoshop είναι τυπικός: 
 

 
Εικόνα 42: Περιβάλλον Εργασίας Adobe Photoshop Pro CS2 

 

 Εργαλειοθήκη 
Ξεκινώντας την περιήγηση µας, θα γνωρίσουµε την παλέτα µε τα εργαλεία που βρίσκεται 
αριστερά µε το που µπαίνουµε στο Photoshop(Εικόνα 43). Ορισµένα εργαλεία στην παλέτα 
εργαλείων, διαθέτουν επιλογές οι οποίες εµφανίζονται εάν τα επεκτείνουµε ώστε να εµφανιστούν 
τα κρυφά εργαλεία κάτω από αυτά. Η  ύπαρξη κρυφών εργαλείων δηλώνεται µε ένα µικρό 
τρίγωνο που υπάρχει στην κάτω δεξιά γωνία του εργαλείου. Η ρύθµιση κάθε εργαλείου όπως πχ 
µέγεθος και σκληρότητα βούρτσας πραγµατοποιείται από τον τοµέα «Ρύθµιση επιλεγµένου 
εργαλείου».  
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Εικόνα 43: Επισκόπηση Εργαλείων 

 

 Μπάρα Μενού 
Η γραµµή του Μενού του Photoshop λειτουργεί όπως οι αντίστοιχες των άλλων εφαρµογών. 
Όπως για παράδειγµα οι λειτουργίες ¨Save¨ και ¨Save as¨ που βρίσκονται στο µενού ¨Edit¨. 
Φυσικά υπάρχουν και άλλες επιλογές του µενού που δεν είναι στάνταρ, όπως οι επιλογές “Mode” 
και “Filter”. 

 

 Παράθυρο ∆εδοµένων 
Το παράθυρο δεδοµένων (ή φόντο ζωγραφικής) είναι η περιοχή στην οποία µπορούµε να 
δηµιουργήσουµε και να µετατρέψουµε εικόνες. Κατά παράβαση το Photoshop µας δίνει ένα 
φόντο ζωγραφικής για να δουλέψουµε, αλλά µπορούµε εύκολα να ανοίξουµε ένα άλλο 
χρησιµοποιώντας την επιλογή του µενού ¨Νέο¨ από το ¨File¨µενού. 

 

 Παλέτες 
Οι παλέτες είναι χρήσιµα συστατικά για το σύνολο των εργαλείων µας. Για την default 
κατάσταση, υπάρχουν 3 ή 4 υποστηριζόµενες παλέτες (layers, history, color, navigator). Οι 
παλέτες που χρειαζόµαστε ενεργοποιούνται από την µπάρα του µενού µε την επιλογή Window. 
Εκεί επιλέγουµε ποιές θέλουµε να είναι ενεργές. 
� Βασική παλέτα Layers (Στρώµατα): 
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Οι στρώσεις µιας εικόνας του Photoshop είναι σαν τις διαφάνειες στις οποίες σχεδιάζουµε 
διάφορα αντικείµενα και όταν τις τοποθετούµε τη µια πάνω στην άλλη, φαίνεται η 
ολοκληρωµένη εικόνα σαν ένα σύνολο. Η σειρά των στρώσεων στην παλέτα Layers δείχνει 
και τη σειρά εµφάνισής τους στην εικόνα, δηλ. η στρώση που εµφανίζεται στην κορυφή της 
παλέτας είναι και η κορυφαία στρώση της εικόνας. Μπορούµε να επεξεργαζόµαστε µόνο µία 
στρώση κάθε φορά, την ενεργό στρώση. Η ενεργός στρώση ξεχωρίζει γιατί είναι έντονα 
φωτισµένη στην παλέτα Layers και έχει αριστερά της το εικονίδιο ενός µικρού πινέλου. Για 
να γίνει ενεργή µια άλλη στρώση, κάνουµε κλικ στον όνοµά της στην παλέτα Layers. Το 
εικονίδιο του µατιού που βρίσκεται δίπλα στο όνοµα µιας στρώσης, σηµαίνει ότι η στρώση 
αυτή είναι ορατή.  
Για να κρύψουµε µια στρώση, πατάµε πάνω στο εικονίδιο του µατιού της. Αν κρύψουµε τη 
στρώση φόντου, θα εµφανισθεί ένα µοτίβο σκακιέρας που αντιπροσωπεύει τις διαφανείς 
περιοχές των ορατών στρώσεων. Με διπλό κλικ πάνω στο όνοµα µιας στρώσης, εµφανίζεται 
το παράθυρο Blending Options από όπου µπορούµε να προσθέσουµε διάφορα εφέ όπως σκιά, 
ανάγλυφη υφή κ.ά. καθώς και να µειώσουµε την αδιαφάνεια της στρώσης (opacity). Με δεξί 
κλικ πάνω στο όνοµα µιας στρώσης µπορούµε να διαγράψουµε τη στρώση (Delete) ή να της 
αλλάξουµε το όνοµα (Layer Properties). 

 
Εικόνα 44: Παλέτα «Layers» 

 
� Παλέτα Navigator (Πλοήγηση): 

Μπορούµε να χρησιµοποιήσουµε την παλέτα πλοήγησης για να αλλάξουµε γρήγορα τον 
τρόπο προβολής της εικόνας µας χρησιµοποιώντας µια προβολή µικρογραφίας. 

 

 
Εικόνα 45: Παλέτα «Navigator» 

 
� Παλέτα Info (Πληροφορίες): 

 Πληροφορίες για το χρώµα σε συγκεκριµένο σηµείο µιας εικόνας µπορεί να δει κανείς από 
το Info Window (Window → Info). Στην παρακάτω εικόνα, πάνω αριστερά φαίνεται ο 
τόνος κάθε χρώµατος (0 - 255) στο σηµείο που βρίσκεται το ποντίκι. Πάνω δεξιά φαίνονται 
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πάλι πληροφορίες χρώµατος στο πρότυπο CMYK το οποίο χρησιµοποιούµε ως επί τω 
πλείστον σε εκτυπωτές και τυπογραφικά µηχανήµατα (Cyan Magenta Yellow Key 
(=black)). Κάτω δίδονται πληροφορίες για της συντεταγµένες στις οποίες βρισκόµαστε (οι 
µονάδες µέτρησης µπορεί να αλλάξουν) καθώς και για το µέγεθος του crop.  
 

 
Εικόνα 46: Παλέτα «Info» 

 
� Παλέτα Histogram(Ιστόγραµµα): 

Πληροφορίες για την κατανοµή των τόνων σε συγκεκριµένο σηµείο µιας εικόνας µπορεί να δει 
κανείς από το Ιστόγραµµα (Window → Histogram).Ο οριζόντιος άξονας αποτελεί τους τόνους 
(0 - 255) και ο κατακόρυφος το πλήθος των pixel που έχουν τον ίδιο τόνο. Σε ορισµένες 
φωτογραφίες παρατηρείται το γεγονός το ιστόγραµµα να µην είναι οµοιόµορφα κατανεµηµένο 
από την τιµή 0 έως την τιµή 255 αλλά να είναι µετατοπισµένο προς τα αριστερά, τα δεξιά, ή 
συγκεντρωµένο στο κέντρο.  Πρακτικά, αυτό µεταφράζεται στα εξής:  

• Μετατοπισµένο αριστερά – Υποεκτεθειµένη φωτογραφία χωρίς έντονο κοντράστ και   
ανοιχτούς τόνους.  

• Μετατοπισµένο δεξιά – Υπερεκτεθειµένη φωτογραφία χωρίς έντονο κοντράστ και 
σκούρους τόνους.  

• Συγκέντρωση στο κέντρο – «Μουντή» φωτογραφία χωρίς κοντράστ.  
Να σηµειώσουµε ότι ένα τέτοιο ιστόγραµµα δεν είναι απαραίτητα «λάθος». Η εικόνα η 
οποία έχουµε αποτυπώσει µπορεί όντως να στερείται κάποιους τόνους. 

                  
Εικόνα 47: Οµοιόµορφο Ιστόγραµµα                 Εικόνα 48: Ιστόγραµµα Μετατοπισµένο Αριστερά 

 
Εικόνα 49: Ιστόγραµµα Συγκεντρωµένο στο κέντρο 

  
� Παλέτα History (Ιστορικό): 

Μπορούµε να χρησιµοποιήσουµε την παλέτα ιστορικού για να µεταπηδήσουµε σε οποιαδήποτε 
πρόσφατη κατάσταση της εικόνας που δηµιουργήθηκε κατά τη συγκεκριµένη περίοδο 
λειτουργίας. Κάθε φορά που εφαρµόζουµε µια αλλαγή στην εικόνα, η νέα κατάσταση της 
εικόνας προστίθεται στην παλέτα.  
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Εικόνα 50: Παλέτα «History» 

 
� Παλέτα Color (Χρώµα): 

Η παλέτα χρωµάτων (Window > Color) εµφανίζει τις τιµές χρωµάτων για τα τρέχοντα χρώµατα 
προσκηνίου και φόντου. Χρησιµοποιώντας τους ρυθµιστές στην παλέτα χρωµάτων, µπορούµε 
να επεξεργαστούµε τα χρώµατα προσκηνίου και φόντου χρησιµοποιώντας διαφορετικά 
χρωµατικά µοντέλα. Μπορούµε επίσης να επιλέξουµε ένα χρώµα προσκηνίου ή φόντου από το 
φάσµα χρωµάτων που εµφανίζεται στη γραµµή χρωµάτων που βρίσκεται στο κάτω µέρος της 
παλέτας.  

 
Εικόνα 51: Παλέτα «Color» 

� Παλέτα Channels (Κανάλια) 
Βρίσκεται στην παλέτα των στρωµάτων. Παρέχει πληροφορίες σχετικά τα κανάλια των 
χρωµάτων ανάλογα µε το χρωµατικό µοντέλο που χρησιµοποιείται. 
 

 
Εικόνα 52: Παλέτα «Channels» 

 

3.2.2   Τα Φίλτρα (Filter) 
      Τα φίλτρα του PhotoShop κάνουν µια λειτουργία ανάλογη µ’ αυτή των φωτογραφικών φίλτρων : 
φιλτράρουν ή διαθλούν το φως, µε αποτέλεσµα να τροποποιούν την εικόνα. Όλα τα φίλτρα του 
PhotoShop βρίσκονται στο µενού Filt er και µπορούµε να ακυρώσουµε (αναιρέσουµε) αµέσως τη 
χρήση κάποιου φίλτρου, αν το αποτέλεσµα δεν µας αρέσει. Μπορούµε να δούµε προκαταβολικά (σε 
προεπισκόπηση) τα αποτελέσµατα των πιο βασικών φίλτρων και µπορούµε να εφαρµόσουµε πολλά 

A. Ορίζει την προέλευση του πινέλου ιστορικού 

B. Μικρογραφία στιγµιότυπου 

Γ. Κατάσταση ιστορικού 

∆. Ρυθµιστής κατάστασης ιστορικού 

A. Χρώµα προσκηνίου  

B. Χρώµα φόντου  

Γ. Ρυθµιστής  

∆. Χρωµατικό φάσµα 
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φίλτρα στη σειρά ή και να χρησιµοποιήσουµε το ίδιο φίλτρο πολλές φορές. Όταν είναι επιλεγµένο 
κάποιο τµήµα της εικόνας, το φίλτρο επιδρά µόνο στην επιλεγµένη περιοχή, ενώ όταν δεν είναι 
επιλεγµένο κάποιο τµήµα της εικόνας, το φίλτρο επιδρά σ’ ολόκληρη την εικόνα. 
Υπάρχουν πάρα πολλά φίλτρα και θα µπορούσαµε να τα οµαδοποιήσουµε ως εξής: 

• Φίλτρα που βελτιώνουν την ποιότητα της εικόνας. 
• Φίλτρα που προσθέτουν καλλιτεχνικά εφέ. 
• Φίλτρα που προσθέτουν ειδικά εφέ. 
• Φίλτρα που εκτελούν τεχνικές διορθώσεις.  

      Για να δηµιουργήσουµε οµαλές µεταβάσεις µεταξύ των φιλτραρισµένων και των αφιλτράριστων 
περιοχών µιας εικόνας, µπορούµε να θολώσουµε το περίγραµµα επιλογής µε την εντολή Feather... 
του µενού Select. Για να εφαρµόσουµε ξανά το τελευταίο φίλτρο, µπορούµε να επιλέξουµε Last Filter 
από το µενού Filt er. Για να αναµίξουµε µια φιλτραρισµένη εικόνα µε την αφιλτράριστη αρχική 
εικόνα, µπορούµε να χρησιµοποιήσουµε την εντολή Fade... από το µενού Filt er. Στο πλαίσιο 
διαλόγου Fade µπορούµε να ρυθµίσουµε την αδιαφάνεια µε τον ροοστάτη (πλαίσιο κειµένου) Opacity 
και τον τρόπο ανάµιξης από την πτυσσόµενη λίστα Mode. Για να βλέπουµε το αποτέλεσµα της 
εφαρµογής του φίλτρου σε προεπισκόπηση, πρέπει να είναι επιλεγµένο το πλαίσιο ελέγχου Preview. 
Η εντολή αυτή πρέπει να χρησιµοποιείται αµέσως µετά την εφαρµογή του φίλτρου. Πρέπει να έχουµε 
υπόψη µας ότι η πραγµατική οµορφιά των φίλτρων του PhotoShop βρίσκεται στον συνδυασµό και την 
εφαρµογή τους σε µικρά, επιλεγµένα τµήµατα της εικόνας. 
 

 

Εικόνα 53: Επιλογή Φίλτρου 
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Εικόνα 54:Εφαρµογή Φίλτρου 
 

3.2.3   ∆ηµιουργία Νέου Αρχείου & Αποθήκευση 
      Για την δηµιουργία νέου αρχείου πηγαίνουµε File > New και στο παράθυρο που δηµιουργούµε 
γράφουµε το όνοµα της εικόνας και καθορίζουµε το µέγεθος(Εικόνα 55). Στην συνέχεια επιλέγουµε 
το χρώµα που θέλουµε να έχει η εικόνα µας και µε το εργαλείο Paint Bucket Tool την χρωµατίζουµε. 
Μπορούµε να αλλάξουµε την µορφή της εικόνας πηγαίνοντας στο Layer>Layer Style>Blending 
Options(Εικόνα 56). 
 

 
Εικόνα 55: Παράθυρο ∆ηµιουργίας Νέου αρχείου 
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Εικόνα 56: Παράθυρο «Layer Style» 

 
      Το PhotoShop µας δίνει την δυνατότητα αποθήκευσης αρχείων σε πολλά format. Για να 
αποθηκεύσουµε ένα αρχείο πηγαίνουµε File>Save. Στο παράθυρο που δηµιουργήθηκε καθορίζουµε το 
µέρος αποθήκευσης και το format της εικόνας(Εικόνα 57). 
 

 
Εικόνα 57: Παράθυρο Αποθήκευσης Αρχείου 
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3.3         Adobe Premiere Pro CS3 της Adobe Systems 

 
      Το Adobe Premiere pro CS3 είναι ένα ισχυρό εργαλείο, κατάλληλο τόσο για τους επαγγελµατίες 
που ασχολούνται µε την παραγωγή βίντεο, όσο για τους ερασιτέχνες λάτρεις αυτού του µέσου, το 
οποίο παρέχει στους χρήστες απεριόριστη ελευθερία δηµιουργικής έκφρασης. Το Adobe Premiere 
pro είναι το πιο επεκτάσιµο, αποτελεσµατικό και ακριβές εργαλείο επεξεργασίας βίντεο που υπάρχει 
σήµερα. Ανεξάρτητα αν δουλεύουµε µε µορφής DV, HD, HDV, ή µε υλικό άλλων µορφών, η 
κορυφαία ποιότητα του Adobe Premiere pro µας επιτρέπει να δουλεύουµε γρηγορότερα και πιο 
δηµιουργικά. Η πλούσια συλλογή ισχυρών εργαλείων που διαθέτει µας επιτρέπει να αντιµετωπίζουµε 
µε επιτυχία κάθε πρόκληση και να δηµιουργήσουµε έργα υψηλής ποιότητας. 
Με τη χρήση του Adobe Photoshop µπορούµε να κάνουµε τις εξής βασικές λειτουργίες: 

• Σύλληψη ή εισαγωγή video  
• Αντιγραφή, αποκοπή, επικόλληση video clip  
• Εισαγωγή εφέ αλλαγής πλάνου  
• Μοντάζ καναλιών video  
• Εφαρµογή ειδικών φίλτρων σε video clip  
• Εισαγωγή αρχείων ήχου  
• Εισαγωγή αρχείων εικόνας και γραφικών  
• Εισαγωγή κειµένου και τίτλων  
• Animation σε video clip, τίτλους και γραφικά  
• Ρύθµιση έντασης clip ήχου  
• Αλλαγή χρονικής διάρκειας video clip  
• Μείξη καναλιών ήχων  
• Εξαγωγή και συµπίεση video–εικόνας-ήχου  
 

3.3.1    Επιλογή Ρυθµίσεων Έργου 
      Το Adobe Premiere pro έχει δυο τύπους ρυθµίσεων: ρυθµίσεις έργου (project settings) και 
προτιµήσεις (preferences). Οι µεταξύ τους οµοιότητες µπορεί να οδηγήσουν σε σύγχυση. Για 
παράδειγµα, και οι δυο τύποι περιέχουν τις κατηγορίες ρυθµίσεων General και capture. Το µενού 
Project Settings υπάρχει επίσης µε τη µορφή της καρτέλας Custom Settings στο παράθυρο διαλόγου 
New Project. Οι ρυθµίσεις έργου (project settings) ισχύουν και εφαρµόζονται στο τρέχον έργο µας. 
Το πρώτο µας βήµα, πριν δηµιουργήσουµε ένα νέο έργο, είναι να επιλέξουµε τις ρυθµίσεις γι´ αυτό το 
έργο. Αφού ξεκινήσουµε ένα έργο, δεν µπορούµε να αλλάξουµε πολλές από τις ρυθµίσεις έργου. Από 
την άλλη, οι προτιµήσεις (preferences) ισχύουν γενικά για όλα τα έργα και µπορούµε να τις 
αλλάξουµε ανά πάσα στιγµή. 
Ας µπούµε  λοιπόν, στο πρακτικό µέρος, ανοίγοντας το Adobe Premiere Pro CS3. 

1) Επιλέγουµε «New Project», επίσης δίπλα βλέπουµε το «Open Project» για να 
ανοίξουµε ένα ήδη υπάρχον project καθώς και την «Βοήθεια» («Help»). Ακριβώς από πάνω 
βλέπουµε τα project που έχουµε δουλέψει πρόσφατα («Recent Projects») (Εικόνα 58). 
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2) Αυτό το παράθυρο διάλογου (Εικόνα 59), παρέχει πέντε φακέλους µε προκαθορισµένες 
ρυθµίσεις (Load Preset) έργου οι οποίες πρακτικά ταιριάζουν µε όλα τα είδη πηγαίου υλικού 
µε τα οποία µπορούµε να δουλέψουµε. Αν καµιά από τις διαθέσιµες οµάδες 
προκαθορισµένων ρυθµίσεων (presets) δεν ταιριάζουν µε τις  προδιαγραφές του πηγαίου 
υλικού µας, τότε µπορούµε να επιλέξουµε την καρτέλα Custom Settings (εξειδικευµένες 
ρυθµίσεις) (Εικόνα 60) και να αλλάξουµε τις ρυθµίσεις έργου (δηλαδή τα βασικά 
χαρακτηριστικά του Project µας, όπως είναι η ανάλυση, τα καρέ ανά δευτερόλεπτο (fps), ο 
λόγος των δυο διαστάσεων (Aspect Ratio), το βάθος χρώµατος, ο αριθµός καναλιών ήχου και 
βίντεο, ο ρυθµός δειγµατοληψίας του ήχου και άλλα πιο εξεζητηµένα χαρακτηριστικά.). 

3) Επιλέγουµε τις ρυθµίσεις που θέλουµε να έχει το project µας, εισάγουµε το όνοµα, την 
τοποθεσία αποθήκευσης και πατάµε <Ok>. 

 

 
Εικόνα 58: Παράθυρο εισαγωγής 

 

 
Εικόνα 59: Παράθυρο «New Project > Load Preset» 

 
 

 



Πτυχιακή Εργασία Τµήµατος Εφαρµοσµένης Πληροφορικής & Πολυµέσων  

 - 60 - 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Εικόνα 60: Παράθυρο «New Project > Custom Settings» 
 

3.3.2     Περιβάλλον Εργασίας 
Κάθε συστατικό του χώρου εργασίας εµφανίζεται σε δικό του πάνελ. Μπορούµε να 
«σταθεροποιήσουµε» πολλαπλά πάνελ σε ένα και µόνο παράθυρο και γενικότερα να προσαρµόσουµε 
τον χώρο εργασίας του προγράµµατος ώστε να καλύπτει τις δικές µας ανάγκες. Ορισµένα βασικά 
συστατικά του προγράµµατος εµφανίζονται σε δικό τους παράθυρο, όπως το ∆ιάγραµµα Ροής χρόνου 
(Timeline), ο Μείκτης Ήχου (Audio Mixer) και το  Monitor Program(πρόγραµµα). Παρακάτω 
βλέπουµε τον χώρο εργασίας του Adobe Premiere Pro CS3 και τα συστατικά του τα οποία θα 
περιγράψουµε.   
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Εικόνα 61: Παράθυρο Εργασίας 

 
� Το πάνελ Timeline - Το ∆ιάγραµµα Ροής Χρόνου, στο οποίο θα κάνουµε το µεγαλύτερο µέρος 

της επεξεργασίας. ∆ηµιουργούµε αλληλουχίες πλάνων (sequences, ο όρος που χρησιµοποιεί η 
Adobe για να αναφερθεί δε επεξεργασµένα/µονταρισµένα αποσπάσµατα βίντεο ή ολόκληρα 
έργα) στο πάνελ Timeline. Ένα ισχυρό χαρακτηριστικό των αλληλουχιών πλάνων είναι η 
δυνατότητα τους να τοποθετούνται ένθετες η µία µέσα στην άλλη (nested sequences). Με τον 
τρόπο αυτό, µπορούµε να διαχωρίσουµε µια παραγωγή σε µικρότερα, πιο εύκολα διαχειρίσιµα 
µέρη.  

 
Εικόνα 62: Πάνελ «Trim» 

 
� Μόνιτορ – Στο Monitor Source εξετάζουµε και κόβουµε το πηγαίο µας υλικό. Για να 

τοποθετήσουµε ένα κλιπ (το οποίο βρίσκεται στο πάνελ έργου) στο Monitor Source θα πρέπει 
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να του κάνουµε διπλό κλικ. Το Monitor Program  το χρησιµοποιούµε για να εξετάσουµε το  
έργο µας καθ’ όλη  τη διάρκεια της εξέλιξής του. 

�  

 
Εικόνα 63: Monitor «Source» – Monitor «Project» 

 
To πάνελ project – εδώ τοποθετούµε τις συνδέσεις (links) που οδηγούν στα «πηγαία υλικά» του 
έργου µας: βιντεοκλίπ, αρχεία ήχου, γραφικά, στατικές εικόνες και αλληλουχίες πλάνων (sequences). 
Για την εισαγωγή των πηγαίων υλικών µας στο «Project Panel» κάνουµε δεξί κλικ στο «Project 
Panel», επιλέγουµε το «Import» ή από το menu «File»> «Import», εµφανίζεται το παράθυρο και 
επιλέγουµε το υλικό που θέλουµε. Στο Premiere χρησιµοποιούµε bins – κάτι ανάλογο µε τους 
φακέλους – για την οργάνωση των πηγαίων υλικών µας. 
 

 
Εικόνα 64: Πάνελ «Project» 

 
� Το πάνελ Effects – τα εφέ του πάνελ Effects είναι οργανωµένα σε κατηγορίες: Presets 

(προκαθορισµένα), Audio Effects(ηχητικά εφέ), Audio Transitions (ηχητικά εφέ αλλαγής 
πλάνου), Video Effects(εφέ βίντεο) και Video Transitions (εφέ αλλαγής βίντεο). Εάν ανοίξουµε 
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τους διάφορος φακέλους, θα παρατηρήσουµε ότι περιλαµβάνουν πολλά ηχητικά εφέ για τον 
εµπλουτισµό της ηχητικής επένδυσης των έργων µας, δύο εφέ crossfade (σταδιακό σβήσιµο), 
εφέ αλλαγής πλάνων όπως τα dissolve (διάλυση) και wipe (σάρωση), καθώς και άλλα πολλά 
εφέ βίντεο για τον µετασχηµατισµό των βιντεοκλίπ µας σε εντυπωσιακές παραγωγές. 

 

 
Εικόνα 65: Πάνελ «Effect»- Εισαγωγή Εφέ(Black & White) 

 

 
Εικόνα 66: Πάνελ «Project»-Εισαγωγή Transitions(Iris Star) 

 
� Audio Mixer (Μείκτης ήχου) – Περιλαµβάνει ένα σετ µηχανισµών για κάθε κανάλι ήχου που 

υπάρχει στο ∆ιάγραµµα Ροής Χρόνου, συν ένα «κύριο» κανάλι (Master track). Επίσης µας 
παρέχει το record κουµπί το οποίο µας δίνει την δυνατότητα να καταγράψουµε και να θέσουµε 
τα επίπεδα του ήχου µε το audio mixer. 

 
Εικόνα 67: Πάνελ «Audio Mixer» 
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� Το πάνελ Tools – Κάθε εικονίδιο σε αυτό το πάνελ αντιπροσωπεύει µία εργαλείο το όποιο 

εκτελεί µια συγκεκριµένη λειτουργία – κατά κανόνα µία λειτουργία επεξεργασίας. 
�  

                    
Εικόνα 68: Πάνελ Tools                                    Εικόνα 69: Επεξεργασία µε «Razor Tool» 
 
� Το πάνελ Effects Controls – Εµφανίζει τις παραµέτρους των εφέ του κλιπ που έχουµε επιλέξει 

από το πάνελ Timeline. ∆ύο εφέ βίντεο είναι πάντα παρόντα, για κάθε βίντεο, στατική εικόνα ή 
γραφικό: τα Motion (κίνηση) και Opacity (αδιαφάνεια). Κάθε παράµετρος ενός εφέ (για το εφέ 
Motion: Position, Scale Height Width, Rotation και Anchor Point) είναι προσαρµόσιµη πάνω 
στον χρόνο, µέσω των καρέ-κλειδιών (keyframes).  
Επίσης όλα τα εφέ βίντεο µπορούν να αντιστοιχίζονται σε καρέ-κλειδιά και να ελέγχονται 
µέσω αυτών. ∆ηλαδή να µεταβάλλουµε το πώς συµπεριφέρεται το εφέ στο πέρασµα του 
χρόνου µε πολλούς τρόπους. Μπορούµε να αλλάξουµε την συµπεριφορά, της παρεµβολής σε 
καρέ-κλειδιά(keyframe interpolation) και µε το γράφηµα Velocity (ταχύτητα). Όταν οι 
παράµετροι σχετίζονται µε την θέση, το µενού συντόµευσης για ένα καρέ-κλειδί µας παρέχει 
δύο τρόπους επιλογής: Spatial Interpolation (χωρική, σχετιζόµενη µε την θέση)και Temporal 
Interpolation  (χρονική).µπορούµε να κάνουµε χωρικές προσαρµογές στο monitor program, 
καθώς και στο πάνελ Εffect Controls. Μπορούµε να κάνουµε χρονικές προσαρµογές στο κλιπ 
από το ∆ιάγραµµα Ροής Χρόνου και το πάνελ Effect Controls. Τα Keyframes µπορούν να 
δηµιουργηθούν αφού πατήσουµε το κουµπί Toggle Animation, δηλαδή αφού ενεργοποιήσουµε 
τη δυνατότητα εναλλαγής των χαρακτηριστικών του φίλτρου σε συνάρτηση µε το χρόνο. 
 

 
Εικόνα 70: Πάνελ «Effects Control» 
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� To πάνελ Info – Αυτό το πάνελ µας παρουσιάζει ένα «στιγµιότυπο» οποιοιδήποτε πηγαίου 
υλικού έχουµε επιλέξει από στο πάνελ Project, ή οποιουδήποτε κλιπ ή εφέ αλλαγής πλάνου 
έχουµε επιλέξει σε µια αλληλουχία πλάνων. 

� Το πάνελ History – Αυτό το πάνελ παρακολουθεί και καταγράφει κάθε µας βήµα µας στην 
διαδικασία παραγωγής ενός βίντεο και µας επιτρέπει να οπισθοχωρήσουµε στον χρόνο, ένα δεν 
µας αρέσει το αποτέλεσµα των τελευταίων προσπαθειών µας.  

 

3.3.3   ∆ηµιουργία Κείµενου µέσωTitler  
      Το Titler  του Adobe Premiere Pro µας παρέχει µία πλήρη γκάµα επιλογών για την δηµιουργία 
κειµένου και σχηµάτων. Μπορούµε να χρησιµοποιήσουµε οποιαδήποτε γραµµατοσειρά είναι 
εγκατεστηµένη στον υπολογιστή µας. Το κείµενο και τα σχήµατα που δηµιουργούµε µπορούν να 
έχουν οποιοδήποτε χρώµα (ή πολλά χρώµατα), οποιοιδήποτε βαθµό διαφάνειας και πολλά σχήµατα. 
Χρησιµοποιώντας το εργαλείο διαδροµών (Path Tool), µπορούµε να κάνουµε το κείµενο µας να 
ακολουθεί ακόµη και την πιο περίπλοκη καµπύλη που µπορούµε να φανταστούµε. 
 Για να δηµιουργήσουµε ένα στατικό κείµενο κάνουµε τα εξής βήµατα: 

� Από το µενού επιλέγουµε «File» > «New» > «Title» (ή µπορούµε να πάµε στο πάνελ 
Project, ¨ να κάνουµε δεξί κλικ¨ και να επιλέξουµε «new Title» > «Title» ) (Εικόνα 71). 
Στην συνεχεία δίνουµε ένα όνοµα για τον καινούργιο τίτλο π.χ. «Kleboun» (Εικόνα 72) 
και πατάµε «OK». 

 

 
Εικόνα 71: Τρόποι ∆ηµιουργίας «New Title» 

 

 
Εικόνα 72: Εισαγωγή Ονόµατος του «New Title» 

 

� Εφόσον εµφανιστεί το παράθυρο «Title Designer», Επιλέγουµε το εργαλείο  οριζόντιας 
γραφής και έπειτα πατούµε δίπλα στην εικόνα και πληκτρολογούµε το κείµενο(Εικόνα 73). 

 



Πτυχιακή Εργασία Τµήµατος Εφαρµοσµένης Πληροφορικής & Πολυµέσων  

 - 66 - 

 
Εικόνα 73: ∆ηµιουργία κείµενου 

 
� Για να κάνουµε αυτό τον τίτλο δυναµικό τον επιλέγουµε (Selection Tool) και στην συνεχεία 

επιλέγουµε το «Roll/Crawl Options…» (Εικόνα 74). Έπειτα ανοίγει το παράθυρο «Roll\Craw 
Options» το οποίο έχει τις εξής επιλογές (Εικόνα 75): 

 

 
Εικόνα 74: Επιλογή δυναµικού Τίτλου 
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Εικόνα 75: Παράθυρο «Roll\Craw Options» 

 
• Still : Τίτλος χωρίς κίνηση, στατικός. 
• Roll:  Τίτλος µε κυλιόµενη κίνηση (προς τα επάνω). 
• Crawl Left/Right:  Τίτλος µε κυλιόµενη κίνηση αριστερά/δεξιά 
• Start Off Screen: Ο τίτλος ξεκινάει την κίνησή του έξω από την ορατή περιοχή και 
• µπαίνει στην ορατή περιοχή. 
• End Off Screen: Ο τίτλος τελειώνει την κίνησή του όταν βγει έξω από την ορατή 
• περιοχή. 
• Preroll : Αριθµός των frames που θα παιχτούν πριν ξεκινήσει την κίνησή του ο 
• τίτλος. 
• Ease In: Αριθµός των αρχικών καρέ (Frames) που η κίνηση του τίτλου θα αυξάνεται 
• σταδιακά έως ότου η κίνησή του φτάσει σε κανονικό ρυθµό. 

� Εάν θέλουµε να µορφοποιήσουµε το κείµενο µας επιλέγουµε το εργαλείο κειµένου και στην 
συνεχεία τον τίτλο και εφαρµόζουµε όποιες µορφοποιήσεις θεωρούµε  κατάλληλες, ως προς 
τη γραµµατοσειρά, το χρώµα, το µέγεθος, το στυλ των γραµµάτων, την εφαρµογή σκιάς, το 
περίγραµµα (Stroke) ή χρησιµοποιούµε κάποιο από τα έτοιµα «Title Styles» που έχει το 
Adobe Premiere CS3(Εικόνα 76). 

� Όταν ολοκληρώσουµε τις µορφοποιήσεις µας κλείνουµε το παράθυρο του «Title 
� Designer» κα αν θέλουµε κάνουµε «Export» για να αποθηκευτεί το Title που δηµιουργήσαµε 

στο αρχείο τίτλου. 
 

 
Εικόνα 76: Μορφοποίηση κειµένου 
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3.3.4   Εξαγωγή Project 
      Η δηµιουργία αρχείων στο Adobe Premier Pro έχει πολλές επιλογές. Μπορούµε να γράψουµε 
µόνο τον ήχο του έργου µας, να µετατρέψουµε ένα απόσπασµα του βίντεο ή ένα ολόκληρο έργο σε 
µία από τις αρκετές καθιερωµένες µορφές αρχείων, ή να δηµιουργήσουµε στατικά καρέ, αλληλουχίες 
στατικών καρέ, ή αρχεία animation.  
Για την εξαγωγή ταινίας κάνουµε τα εξής βήµατα: 

� Κάνουµε κλικ στο πάνελ «Timeline» (∆ιάγραµµα ροής χρόνου) και έπειτα επιλέγουµε «File» 
> «Export» > «Movie»(Εικόνα 77). 

� Μας εµφανίζετε το παράθυρο «Export Movie», κάνουµε κλικ στο «Settings»(Εικόνα 78)». 
 

      
    Εικόνα 77: Επιλογή «File > Export»            Εικόνα 78: Παράθυρο «Export Movie»  

  
� Μας εµφανίζεται το παράθυρο «Export Movie Settings», το οποίο περιέχει τις καρτέλες: 

General, Video, Keyframe and Rendering, και Audio και σε κάθε µια από αυτές κάνουµε 
τις απαραίτητες ρυθµίσεις και πατάµε «OK»(Εικόνα 79). 

� Έπειτα εισάγουµε το όνοµα το αρχείου µας και πατάµε «Αποθήκευση».  
 

 
Εικόνα 79: Παράθυρο «Export Movie Settings» 
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4       ∆ΗΜΙΟΥΡΓΙΑ ∆ΙΑΦΗΜΙΣΤΙΚΩΝ ΣΠΟΤ 
 
      Στο παρόν κεφάλαιο θα αρχίσουµε µε µια εισαγωγή σχετικά µε το οπτικοακουστικό υλικό το 
οποίο χρησιµοποιήθηκε για την δηµιουργία της οπτικοακουστική παραγωγή. Επίσης θα αναφέρουµε 
τα εργαλεία που χρησιµοποιήθηκαν για την  παραγωγής των διαφηµιστικών σποτ, το καθένα 
ξεχωριστά, για  κάθε από τα προγράµµατα που χρησιµοποιήθηκαν, δηλαδή το Adobe Premiere Pro 
CS3, το Adobe Photoshop Pro CS2 και το Sound Forge 8. 
 

4.1 Εισαγωγή 
      Για την δηµιουργία µιας οποιασδήποτε οπτικοακουστικής παραγωγής χρειάζεται να 
ακολουθηθούν συγκεκριµένα στάδια, τεχνικές και κανόνες ώστε το αποτέλεσµα να είναι το καλύτερο 
δυνατόν. Έτσι και στην παρούσα πτυχιακή εργασία ακλούθησα κάποια συγκεκριµένα στάδια και 
κανόνες για την ολοκλήρωση της οπτικοακουστικής παραγωγής. Τα στάδια είναι τα εξής: 

1) Προπαραγωγή (Pre-Production) 
H προπαραγωγή θεωρείται το πιο σηµαντικό κοµµάτι για την παραγωγή οπτικοακουστικού                                       
περιεχοµένου καθώς περιλαµβάνει από την ανάπτυξη της ιδέας και το σενάριο µέχρι την  
ετοιµασία των σκηνικών και το προσωπικό που µπορεί να χρειαστεί. Σε αυτό το αρχικό 
στάδιο λοιπόν, αναπτύχθηκε η βασική ιδέα και το σενάριο για το κάθε διαφηµιστικό σποτ,   
έγινε η αγορά  του εξοπλισµού που θεωρείτο απαραίτητο για την λήψη των πλάνων και η  
συλλογή του υλικού.  
Ο εξοπλισµός περιελάµβανε την αγορά ενός mini DVD-RW, για την  εγγραφή του βίντεο, 
ενός τρίποδα, για σταθερές λήψεις πλάνων, ακουστικών µε ενσωµατωµένο µικρόφωνο 
(Sound Force CD-779MV) και ενός πράσινου υφάσµατος, για την αφαίρεση του φόντου στην 
µεταπαραγωγή. Ο υπάρχον ερασιτεχνικός εξοπλισµός ήταν µία ψηφιακή φωτογραφική 
µηχανή (SONY) και µια ψηφιακή βιντεοκάµερα (SONY DCR-DVD105E). Η συλλογή 
υλικού έγινε µέσω του internet, ενός ραδιοφωνικού σταθµού και ενός γραφείου ‘δηµιουργίας 
επιγραφών’. 

2) Παραγωγή (Production) 
Το δεύτερο στάδιο για την ολοκλήρωση µιας οπτικοακουστικής παραγωγής είναι η κύρια 
παραγωγή που περιλαµβάνει τα γυρίσµατα, τις σκηνές, την ηχοληψία και την εφαρµογή του 
φωτισµού για µια σωστή και ολοκληρωµένη βιντεοσκόπηση. Σε αυτό το στάδιο λοιπόν, 
έγιναν τα γυρίσµατα, εντελώς ερασιτεχνικά όπως και οι λήψεις φωτογραφιών. Με την χρήση 
του Adobe Photoshop Pro CS2 και του Sound Forge 8, πραγµατοποιήθηκε η δηµιουργία των 
εικόνων και τον ήχων, αντίστοιχα.  

3) Μεταπαραγωγή (Post-Production) 
Τελευταίο αλλά εξίσου σηµαντικό για την δηµιουργία µιας οπτικοακουστικής παραγωγής 
είναι το στάδιο της µετά-παραγωγής (post-production). Στην µεταπαραγωγή περιέχονται όλες 
αυτές τις εργασίες που έχουν να κάνουν µε το ξήλωµα σκηνικών, συσκευασία εξοπλισµού, 
αποδέσµευση ταλέντων, ρυθµίσεις οικονοµικών θεµάτων, επεξεργασία των βίντεο και των 
ήχων, το µοντάζ, τις µίξεις σε εικόνα και ήχο, αλλά και διάθεση και προβολή της παραγωγής. 
Σε αυτό το τελευταίο χρονοβόρο στάδιο, ως αρχή έγινε η µεταφορά του υλικού παραγωγής 
στον υπολογιστή. Επίσης πραγµατοποιήθηκε, η επεξεργασία εικόνας και ήχου όπου 
χρειαζόταν και φυσικά έγινε η επεξεργασία του οπτικοακουστικού υλικού, µε το πρόγραµµα  
Adobe Premiere Pro CS3 και έτσι ολοκληρώθηκαν τα τρία διαφηµιστικά σποτ.   
 

4.2     ∆ιαφηµιστικό Σποτ 1 «ΑΦΟΙ ΓΕΡΟΥΚΑΚΗ» 
      Σε αυτή την οπτικοακουστική παραγωγή, η οποία ήταν και η πρώτη µου, χρησιµοποίησα υλικό 
τα οποίο είχα συλλάβει µέσω της ψηφιακής βιντεοκάµερας και της ψηφιακής φωτογραφικής µηχανής. 
Επίσης, βρήκα έτοιµο υλικό, την εκφώνηση, από έναν ραδιοφωνικό σταθµό (Ράδιο Μοίρες 97,1), το 
οποίο έπειτα υπέστη επεξεργασία από το Sound Forge όπως και η µουσική την οποία ¨κατέβασα¨ από 
το internet. Τέλος, η επιγραφή «Αφοί Γερουκάκη», µου δόθηκε έτοιµο, από ένα γραφείο επιγραφών 
και στη συνεχεία το επεξεργάστηκα µε το Photoshop. Όλο αυτό το υλικό, στο στάδιο της 
µεταπαραγωγής, συνέθεσε την ολοκλήρωση του πρώτου διαφηµιστικού σποτ, χωρίς καµία δυσκολία. 
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Η διάρκεια αυτού του διαφηµιστικού σποτ ήταν 25 δευτερόλεπτα. Παρακάτω θα δούµε την 
ολοκλήρωση αυτής της οπτικοακουστικής παραγωγής. 
 

4.2.1    Επεξεργασία Εικόνας 
      Η επεξεργασία των εικόνων, όπως έχω ήδη αναφέρει, έγινε µε το Adobe Photoshop Pro CS2. Τα 
εργαλεία που χρησιµοποιήθηκαν για την επεξεργασία τους είναι τα εξής: 

• Move Tool: Εργαλείο για την µετακίνηση της φωτογραφίας. 
• Magic Wand Tool: Εργαλείο για την επιλογή περιοχής ίδιου χρώµατος. 
• Eraser Tool: Εργαλείο για το σβήσιµο των pixels. 
• Edit>Image Size: Ρύθµιση του µεγέθους της εικόνας.  
• Edit>Canvas Size: Ρύθµιση του µεγέθους του καµβά της εικόνας. 
 

 
                  Εικόνα 80: Πριν την Επεξεργασία                    Εικόνα 81: Μετά την Επεξεργασία 

         

4.2.2    Επεξεργασία Ήχου 
      Η επεξεργασία του ήχου έγινε µε το λογισµικό πακέτο Sony Sound Forge και τα εργαλεία που 
χρησιµοποιήθηκαν ήταν τα εξής: 

• Effects>Reverb>Plate>Plate 1: Εφέ προσοµοίωσης της ακουστικής σε διαφορετικούς 
χώρους. 

• Effects>Chorus>Slow Flange 1: Εφέ προσοµοίωσης πολλαπλών πηγών ήχου από έναν και 
µόνο ήχο. 

• Effects>Delay/Echo>Multi-Tab Delay>Cathedral 1: Εφέ δηµιουργίας καθυστέρησης έως 
και 8 delay-tabs, τοποθετηµένη οπουδήποτε µέσα σε 2,5 sec  αρχικού ήχου.  

• Process>Fade In: Σταδιακή αύξηση της έντασης του ήχου. 
• Process>Fade Out: Σταδιακή αύξηση της έντασης του ήχου. 
• Process>volume: Τροποποίηση της έντασης. 
 

4.2.3    Επεξεργασία/Μοντάζ Οπτικοακουστικού Υλικού 
      Η επεξεργασία του οπτικοακουστικού υλικού πραγµατοποιήθηκε µε το πρόγραµµα  της Adobe, 
το Premiere Pro CS3, όπως έχει αναφερθεί και στα προηγούµενα κεφάλαια. Εδώ έγινε η περισσότερη 
εργασία και η ποιο χρονοβόρα, καθώς έπρεπε να γίνει «κοπή» πλάνων από το πηγαίο υλικό, να 
µονταριστούν, και να εφαρµόσουµε ειδικά εφέ ,transition, τίτλους και κίνηση.  
      Με την εκκίνηση του Premiere ζητείται συνήθως το περιβάλλον στο οποίο θέλουµε να 
δουλέψουµε. Από τα συστήµατα µετάδοσης που υπάρχουν, σε αυτό το σποτ όπως και στα υπόλοιπα, 
επέλεξα το σύστηµα µετάδοσης που υπάρχει στη χώρα µας το DV PAL(4:3). Επειδή το Premiere 
‘θυµάται’ την αρχική θέση κάθε αρχείου που χρησιµοποιούµε σε ένα έργο, καλό είναι να θυµόµαστε 
την θέση του κάθε αρχείο που χρησιµοποιούµε ή να τοποθετούµε τα αρχεία αυτά σε ξεχωριστό 
φάκελο γιατί αν τα µετακινήσουµε ή τα διαγράψουµε το Premiere θα µας ζητάει να βρούµε την θέση 
του κάθε αρχείου που χρησιµοποιούµε στο έργο το οποίο δουλεύουµε. Τελειώνοντας µε τις 
απαραίτητες ρυθµίσεις, εισάγουµε το υλικό που θα επεξεργαστούµε. Καλό θα ήταν πρώτα, να 
δηµιουργήσουµε ξεχωριστούς φακέλους(bin) , ανάλογα µε τον είδος των αρχείων µας. Στην δική µας 
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περίπτωση, έχουµε τρεις φακέλους, έναν για τα αρχεία ήχου, έναν για τα βίντεο και τον τελευταίο για 
τις εικόνες. 
      Το πηγαίο υλικό ήταν διάρκεια 8 λεπτών περίπου και έτσι µε τη βοήθεια των κουµπιών Set In 
Point και Set Out Point(του Monitor Source), επέλεξα τα κοµµάτια που χρειαζόµουν. Έπειτα έκανα 
«Drug n Drop» από το Monitor Source στο Panel Project και ονόµασα τα νέα πλάνα(Subclip). 
      Για την δηµιουργία «εικόνας µέσα  σε εικόνα»(PiPs) και για ευκολία, δηµιούργησα δύο σεκάνς: 
� PiP SPOT_1 
      Αυτή η σεκάνς είναι µία ένθετη σεκάνς(nested sequence) διότι θα τοποθετηθεί µέσω «Drug n 

Drop» µέσα στην σεκάνς «TELIKO SPOT_1».  
� TELIKO SPOT_1 

Αυτήν η σεκάνς είναι η τελική στην οποία θα κάνουµε εξαγωγή και θα είναι η ολοκληρωµένη 
οπτικοακουστική παραγωγή µας.. 

Τα εργαλεία/εφέ που χρησιµοποιήθηκαν σε αυτήν την οπτικοακουστική παραγωγή είναι τα εξής: 
� Video Effects: 

• Distort>Transform: Αυτό το φίλτρο έχει πολλές από τις δυνατότητες του εφέ Motion, 
εκτός από το γεγονός ότι το Transform µπορεί να µετακινηθεί σε µία χαµηλότερη θέση 
στην σειρά εφαρµογής των εφέ. Τα εφέ εφαρµόζονται µε σειρά από πάνω προς τα κάτω. 
Στην περίπτωση µας , για να παραµείνει η σκιά στην ίδια πλευρά καθώς περιστρέφεται η 
PiP εικόνα, πρέπει τα εφέ να µπουν µε την σειρά που τα αναφέρω (Εικόνα 82).   

• Perspective>Bevel Edges: Εφέ πίπτουσας σκιάς (Εικόνα 82).  . 
• Perspective>Drop Shadow: Εφέ ανάγλυφων (επικλινών) άκρων (Εικόνα 82).  . 
• Adjust>Lighting Effects: Το εφέ αυτό µας δίνει την δυνατότητα να εισάγουµε πέντε 

διαφορετικούς κατευθυνόµενους προβολής φωτός. Στην περίπτωση µας, επέλεξα έναν 
προβολέα, για καλύτερο φωτισµό του βίντεο «xeria.mpg.Subclip005».(Εικόνα 83)    

• Blur & Sharpen>Fast Blur: Χρησιµοποιείται για άµεσο φλουτάρισµα της εικόνας. 
• Image Control>Color Pass: Χρησιµοποιείται για την µετατροπή ενός ολόκληρου κλιπ 

σε τόνους του γκρι (grayscale), µε την εξαίρεση ενός καθοριζόµενου από τον χρήστη 
χρώµατος.(Εικόνα 84).  
 

 
Εικόνα 82: Σεκάνς «PIP SPOT_1» 
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Εικόνα 83: Σεκάνς «TELIKO SPOT_1»(Lighting Effects) 

 

 
Εικόνα 84: Εφέ Βίντεο«Color Pass» 

 
� Selection Tool: Εργαλείο επιλογής/επεξεργασίας (µεταφορά, απόθεση, κοπή).  
� Rate Stretch Tool: Εργαλείο αυξοµείωσης ταχύτητας. 
� Presets>PiPs>25% PiPs: «Εικόνα µέσα σε εικόνα»(Picture-in-Picture). Αρχικά επέλεξα ένα 

στυλ και κατόπιν το προσάρµοσα στις δικές µου ανάγκες, αλλάζοντας τις θέσεις αρχής/τέλους 
του προκαθορισµένου εφέ και το µέγεθος, όπου χρειαζόταν.    

� Video Transitions: 
• GPU Transitions>Center Peel: (Εικόνα 85). 
• zoom>Cross Zoom 
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Εικόνα 85: Video Transitions «Center Peel» 

� Level: Ρύθµιση του επιπέδου του ήχου. Στην περίπτωση µας το χρησιµοποίησα για την 
ρύθµιση της έντασης στην αρχή (σταδιακό ‘άναµµα’) και στο τέλος (σταδιακό ‘σβήσιµο’) 
του ήχου µας (Εικόνα 86). 

� Χρήση µεθόδων παρεµβολής σε καρέ-κλειδιά(keyframes): (Εικόνα 86). 
� New Item >Title: (Εικόνα 87) 
� Motion: Εφέ κίνησης το οποίο είναι πάντα παρόν στο πάνελ Effects  Control. 
� Opacity: Εφέ ∆ιαφάνειας το οποίο είναι πάντα παρόν στο πάνελ Effects Control. 

 

            
Εικόνα 86: Εφέ Ήχου «Level» 

 



Πτυχιακή Εργασία Τµήµατος Εφαρµοσµένης Πληροφορικής & Πολυµέσων  

 - 74 - 

 
Εικόνα 87: Τίτλος 

4.2.4    Παρατηρήσεις/ Συµπέρασµα    
      Σε αυτήν την οπτικοακουστική παραγωγή η οποία ήταν και η πρώτη που υλοποίησα,, δεν υπήρξε 
ιδιαίτερη δυσκολία, µόνο στην διαδικασία ’κοπής’ των πλάνων που υπήρξε λίγο χρονοβόρα. Λόγω 
της µικρής διάρκειάς του και για να µην γίνει ‘κουραστικό’ δεν το επιβάρυνα µε πολλά εφέ.  Το 
συµπέρασµα είναι ότι αυτό που ανέβασε πολύ την ποιότητα του, ήταν η εκφώνηση που δόθηκε από 
επαγγελµατία (Ράδιο Μοίρες 97,1) και η οποία είχε γίνει σε στούντιο ηχογράφησης. Επίσης θα 
ανέβαζε περισσότερο την ποιότητα του, αν οι λήψεις πλάνων είχαν γίνει µε επαγγελµατική 
βιντεοκάµερα.  

4.3     ∆ιαφηµιστικό Σποτ 2 «SONY VAIO» 
      Σε αυτή την οπτικοακουστική παραγωγή χρησιµοποίησα υλικό τα οποίο είχα συλλάβει µέσω της 
ψηφιακής βιντεοκάµερας. Επίσης, βρήκα έτοιµο υλικό από το internet (αρχεία εικόνων, ήχων)οποίο 
έπειτα υπέστη επεξεργασία από το Adobe Photoshop και το Sound Forge. Η εκφώνηση ηχογραφήθηκε 
από εµένα, µε το πρόγραµµα Sound Forge και χρησιµοποιήθηκαν ακουστικά µε ενσωµατωµένο 
µικρόφωνο. Όλο αυτό το υλικό, στο στάδιο της µεταπαραγωγής, συνέθεσε την ολοκλήρωση του 
δεύτερου διαφηµιστικού σποτ.. Για τα γυρίσµατα χρειάστηκε ο φορητός υπολογιστής «Sony Vaio» 
και ένα πράσινο ύφασµα ως παραβάν, για την επεξεργασία αφαίρεσης του φόντου από το πρόγραµµα 
Adobe Premiere. Η διάρκεια αυτού του διαφηµιστικού σποτ ήταν 36 δευτερόλεπτα. Παρακάτω θα 
δούµε την ολοκλήρωση αυτής της οπτικοακουστικής παραγωγής 
 

4.3.1    Επεξεργασία Εικόνας 
      Η επεξεργασία των εικόνων, όπως έχω ήδη αναφέρει, έγινε µε το Adobe Photoshop Pro CS2. Τα 
εργαλεία που χρησιµοποιήθηκαν για την επεξεργασία τους είναι τα εξής: 

• Move Tool: Εργαλείο για την µετακίνηση της φωτογραφίας. 
• Freeform Pen Tool: Μας επιτρέπει την ελεύθερη σχεδίαση διαδροµών µε οµαλά άκρα. 

Στην εικόνα 88, µε το εργαλείο αυτό, σχεδίασα το περίγραµµα διαδροµής της λίµνης και 
το αντέγραψα σε ένα καινούριο layer(Εικόνα 89). 

• Magic Wand Tool: Εργαλείο για την επιλογή περιοχής ίδιου χρώµατος. 
• Eraser Tool: Εργαλείο για το σβήσιµο των pixels. 
• Edit>Image Size: Ρύθµιση του µεγέθους της εικόνας.  
• Edit>Canvas Size: Ρύθµιση του µεγέθους του καµβά της εικόνας. 
• Rectangle Tool: Σχεδίαση τετραγώνου. 
• Styles: 

o Image Effects: Χρήση ως πάτωµα. 
o Textures: Χρήση ως τοίχος (Εικόνα 90). 
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Εικόνα 88: Πριν                                                                       Εικόνα 89: Μετά 

 

 
Εικόνα 90: Style «Textures» 

4.3.2    Επεξεργασία Ήχου 
      Η επεξεργασία του ήχου έγινε µε το λογισµικό πακέτο Sony Sound Forge και τα εργαλεία που 
χρησιµοποιήθηκαν ήταν τα εξής: 

• Process>volume 
• Process>Pan/Expand>Expand Stereo Image>Pan (Preserve Stereo Separation) 
• Effects>Acoustic Mirror 
• Process>Fade In 
• Process>Fade Out 
 

4.3.3    Επεξεργασία Οπτικοακουστικού Υλικού 
      Η επεξεργασία του οπτικοακουστικού υλικού πραγµατοποιήθηκε µε το πρόγραµµα  της Adobe, 
το Premiere Pro CS3, όπως έχει αναφερθεί και στα προηγούµενα κεφάλαια. Όπως και µε το 
προηγούµενο διαφηµιστικό σποτ, εδώ έγινε η περισσότερη εργασία και η ποιο χρονοβόρα, καθώς 
έπρεπε να γίνει «κοπή» πλάνων από το πηγαίο υλικό, να µονταριστούν, και να εφαρµόσουµε ειδικά 
εφέ ,transition, τίτλους και κίνηση.  
      Στην  διαδικασία εκκίνηση του Premiere βάλαµε, όπως και στο προηγούµενο σποτ, το ίδιο 
συστήµατα µετάδοσης,  το DV PAL(4:3)  και δηµιουργήσουµε τέσσερις ξεχωριστούς φακέλους(bin) , 
έναν για τα αρχεία ήχου, έναν για τα βίντεο έναν για τους τίτλους και τον τελευταίο για τις εικόνες. Το 
πηγαίο υλικό ήταν διάρκεια 35 λεπτών περίπου και έτσι µε τη βοήθεια των κουµπιών Set In Point και 
Set Out Point(του Monitor Source), επέλεξα τα κοµµάτια που χρειαζόµουν και τα έκανα εξαγωγή 
(Export)  σε µορφή «mpg» και έπειτα εισαγωγή (Import) στο Panel Project. 
 Αυτή οπτικοακουστική παραγωγή αποτελείται από τρείς σεκάνς: 
� SONY 

Αυτή η σεκάνς είναι µία ένθετη σεκάνς(nested sequence) διότι θα τοποθετηθεί, µέσω «Drug n 
Drop», µέσα στην σεκάνς «TELIKO SPOT_2(SONY VAIO)». 

� GARDEN  
Επίσης και αυτή η σεκάνς είναι ένθετη της σεκάνς «TELIKO SPOT_2(SONY VAIO)».  



Πτυχιακή Εργασία Τµήµατος Εφαρµοσµένης Πληροφορικής & Πολυµέσων  

 - 76 - 

� TELIKO SPOT_2(SONY VAIO) 
Αυτή η σεκάνς αποτελείται κυρίως από τις δύο προηγούµενες σεκάνς και είναι η τελική στην 
οποία θα κάνουµε εξαγωγή και θα είναι η ολοκληρωµένη οπτικοακουστική παραγωγή µας. Εδώ 
χρησιµοποιήσαµε ένα transition το οποίο ενώνει τις δύο ένθετες σεκάνς.  

Τα εργαλεία/εφέ που χρησιµοποιήθηκαν σε αυτήν την οπτικοακουστική παραγωγή είναι τα εξής: 
� Video Effects: 

• Distort>Transform: Αυτό το φίλτρο έχει πολλές από τις δυνατότητες του εφέ Motion, 
εκτός από το γεγονός ότι το Transform µπορεί να µετακινηθεί σε µία χαµηλότερη θέση 
στην σειρά εφαρµογής των εφέ.  

• Distort>Offset: ∆ηµιουργεί σε ένα αντικείµενο (laptop στην περίπτωση µας) το «είδωλο» 
του, παραµένοντας σταθερό κατά την διάρκεια της κίνησης του αντικειµένου (Εικόνα 91). 

• Distort>Drop Shadow: Εφέ ανάγλυφων (επικλινών) άκρων. 
• Blur & Sharpen>Antialias: Εφέ φλουταρίσµατος (θολώµατος).     Χρησιµοποιήθηκε για 

το φλουτάρισµα του φόντου, για να δώσει πιο ρεαλιστική εµφάνιση στο µασκαρισµένο 
πλάνο. 

• Keying>Eight-Point Garbage Matte: Εφέ διαίρεσης οθόνης οχτώ κορυφών.    
• Color Correction>Brightness& Contrast: Εφέ επεξεργασίας της φωτεινότητας και της 

αντίθεσης.  
• Generate>Paint Bucket: «Βάφει» περιοχές µιας σκηνής µε ένα πλακάτο (οµοιόµορφο) 

χρώµα (Εικόνα 91). 
• Keying>Color Key: Χρησιµοποιεί ένα χρώµα κλειδί για την δηµιουργία διαφάνειας 

(Εικόνα 91). 
• Image Control>Black & White: Μετατροπή ενός πλάνου σε ασπρόµαυρο (Εικόνα 91). 
• Adjust>Lighting:  Εντυπωσιακό εφέ για την δηµιουργία «αστραπής/ηλεκτρισµού» 

(Εικόνα 92). 
• Color Correction>Channel Mixer: Εφέ δηµιουργίας µίξης χρωµάτων (Εικόνα 92). 
• Keying>Sixteen-Point Garbage Matte: Εφέ διαίρεσης οθόνης δεκαέξι κορυφών (Εικόνα 

93). 
• Keying>Four-Point Garbage Matte Εφέ διαίρεσης οθόνης τεσσάρων κορυφών. 
• Keying>Chroma key: Χρησιµοποιεί ένα χρώµα κλειδί για την δηµιουργία διαφάνειας 
• Distort>Wave Warp: Εφέ εγγενείς δυνατότητας κίνησης που λειτουργούν ανεξάρτητα 

από τα καρέ-κλειδιά.  
• GPU Effects>Refraction: Εφέ εγγενείς δυνατότητας κίνησης που λειτουργούν 

ανεξάρτητα από τα καρέ-κλειδιά.  
 

 
Εικόνα 91: Σεκάνς «SONY», Εφέ: « Lighting », « Channel Mixer », «Black & White»  
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Εικόνα 92: Σεκάνς «SONY», Εφέ: «Offset», «Paint Bucket», 

 

 
Εικόνα 93: Σεκάνς «GARDEN», Εφέ : «Sixteen-Point Garbage Matte» 

 
� Video Transitions: 

• Dissolve>Additive Dissolve. 
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• Dissolve>Cross Dissolve: (Εικόνα 94). 
• Wipe>Inset. 
• Slide>Center Split: (Εικόνα 95). 
• Zoom>Cross Zoom. 
• Dissolve>Dip to White: (Εικόνα 96). 
 

 
Εικόνα 94: Σεκάνς «SONY», Video Transitions «Cross Dissolve»  
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Εικόνα 95: Σεκάνς « GARDEN », Video Transitions « Center Split » 

 

 
Εικόνα 96: Σεκάνς « TELIKO SPOT_2(SONY VAIO)», Video Transitions « Dip to White » 

 
� New Item >Title: (Εικόνα 97). 
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� Χρήση µεθόδων παρεµβολής σε καρέ-κλειδιά(keyframes).. 
� Trim Monitor : Τοποθετούµε το την ένδειξη CTI στο σηµείο δυο κλιπ και πατούµε το πλήκτρο 

συντόµευσης που βρίσκεται στο «Monitor Program». Αυτό µας εµφανίζει δυο µεγάλες οθόνες 
προεπισκόπησης, µε µηχανισµούς ακρίβειας και πληροφοριακές ενδείξεις χρονοκώδικα (Εικόνα 
98). 

� New Item >Transparent Video: ∆ιαφανές Βίντεο, στο οποίο έγινε η εισαγωγή του εφέ 
«Lighting».  

� Level: Ρύθµιση του επιπέδου του ήχου. Στην περίπτωση µας το χρησιµοποίησα για την ρύθµιση 
της έντασης στην αρχή (σταδιακό ‘άναµµα’) και στο τέλος (σταδιακό ‘σβήσιµο’) του ήχου µας. 

� Motion: Εφέ κίνησης το οποίο είναι πάντα παρόν στο πάνελ Effects  Control. 
� Opacity: Εφέ ∆ιαφάνειας το οποίο είναι πάντα παρόν στο πάνελ Effects Control. 
� Rate Stretch Tool: : Εργαλείο αυξοµείωσης ταχύτητας. 
� Slip Tool: Εργαλείο Ολίσθησης. 
� Slide Tool: Εργαλείο Μετατόπισης. 
� Selection Tools: Εργαλείο επιλογής/επεξεργασίας (µεταφορά, απόθεση, κοπή). 
� Rolling Edit Tool: Εργαλείο επεξεργασίας µοντάζ µε αντικατάσταση. 
 

 
Εικόνα 97: Σεκάνς «GARDEN» Τίτλος: «500 GBYTE» 
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Εικόνα 98: Σεκάνς «SONY», Monitor Tim 

 

4.3.4   Παρατηρήσεις/ Συµπέρασµα 
         Σε αυτήν την οπτικοακουστική παραγωγή υπήρξε αρκετή δυσκολία, τόσο στην διαδικασία 
«κοπής» των πλάνων που ήταν αρκετή χρονοβόρα, όσο και στην διαδικασία αφαίρεσης του πράσινου 
φόντου που εκτός από χρονοβόρα υπήρξε και κουραστική. Το πρόβληµα ήταν στο πράσινο ύφασµα 
που χρησιµοποιήθηκε ως φόντο και στο οποίο, ο κακός φωτισµός (λόγω ερασιτεχνικής λήψης) 
δηµιουργούσε ανοµοιόµορφο χρώµα. Συγκεκριµένα, σε κάποια σηµεία του υφάσµατος «έπεφτε» πολύ 
φως, δηµιουργώντας ανοιχτές  αποχρώσεις παρόµοιες µε το χρώµα του παντελονιού (το οποίο ήταν 
άσπρο) και του δέρµατος. Έτσι στην αφαίρεση του (πράσινου) φόντου, σε κάποια σηµεία, έπρεπε να 
γίνει περεταίρω επεξεργασία, για να αφαιρεθούν και κατά την διάρκεια αφαίρεσης του φόντου υπήρχε 
αλλοίωση στο περίγραµµα (κυρίως) της φιγούρας µου. Το τελικό συµπέρασµα είναι ότι αν είχε γίνει η 
όλη διαδικασία λήψης και ηχογράφησης µε επαγγελµατικά µέσα, αυτή η οπτικοακουστική παραγωγή 
θα ήταν λιγότερη χρονοβόρα και τα αποτελέσµατα της, µε περισσότερη ποιότητα.  
 

4.4     ∆ιαφηµιστικό Σποτ 3 «BABYPEDIA» 
      Σε αυτή την οπτικοακουστική παραγωγή χρησιµοποίησα υλικό τα οποίο είχα συλλάβει µέσω της 
ψηφιακής φωτογραφικής µηχανής και υπέστη επεξεργασία από το Adobe Photoshop.. Η εκφώνηση 
ηχογραφήθηκε από εµένα, µε το πρόγραµµα Sound Forge και χρησιµοποιήθηκαν ακουστικά µε 
ενσωµατωµένο µικρόφωνο. Όλο αυτό το υλικό, στο στάδιο της µεταπαραγωγής, συνέθεσε την 
ολοκλήρωση του τρίτου διαφηµιστικού σποτ. Η διάρκεια αυτού του διαφηµιστικού σποτ ήταν 28 
δευτερόλεπτα. Παρακάτω θα δούµε την ολοκλήρωση αυτής της οπτικοακουστικής παραγωγής 
 

4.4.1  Επεξεργασία Εικόνας 
      Η επεξεργασία των εικόνων, όπως έχω ήδη αναφέρει, έγινε µε το Adobe Photoshop Pro CS2.Τα 
εργαλεία που χρησιµοποιήθηκαν για την επεξεργασία τους είναι τα εξής: 

• Move Tool: Εργαλείο για την µετακίνηση της φωτογραφίας. 
• Magic Wand Tool 
• Eraser Tool 
• Edit>Image Size  
• Edit>Canvas Size 
• Crop Tool: Χρησιµεύει για την ψαλίδιση εικόνων. 
• Ellipse Tool: Εργαλείο έλλειψης. 



Πτυχιακή Εργασία Τµήµατος Εφαρµοσµένης Πληροφορικής & Πολυµέσων  

 - 82 - 

• Styles>Textures 
• Filter>Artistic>Underpainting: (Εικόνα 99) 
• Layer Style>Blending Option: (Εικόνα 99). 

o Inner Glow: Προσθήκη εσωτερικής λάµψης. 
o Bevel and Emboss: Προσθήκη λοξής γωνίας και ανάγλυφου  
 

 
Εικόνα 99:Εφέ «Underpainting», «Bevel and Emboss» 

 

 
Εικόνα 100: Πριν  

 

        
Εικόνα 101: Μετά (α)                                             Εικόνα 102: Μετά (β) 

 

4.4.2   Επεξεργασία Ήχου 
      Η επεξεργασία του ήχου έγινε µε το λογισµικό πακέτο Sony Sound Forge και τα εργαλεία που 
χρησιµοποιήθηκαν ήταν τα εξής: 

• Effects>Pitch>Bend: ∆ηµιουργεί ένα τροποποιηµένο ηχητικό περίβληµα, το οποίο 
αντιστοιχεί στην αύξηση ή στη µείωση του τόνου του ηχητικού σήµατος (Εικόνα ). 

• Effects>Wave Hammer>Voice: Συµπιεστής και maximizer έντασης 
• Effects>Delay/Echo>Multi-Tab Delay>Cathedral 2 
• Process>Fade In 
• Process>Fade Out 
• Process>Volume  
 

4.4.3  Επεξεργασία Οπτικοακουστικού Υλικού 
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      Η επεξεργασία του οπτικοακουστικού υλικού πραγµατοποιήθηκε µε το πρόγραµµα  της Adobe, 
το Premiere Pro CS3. Όπως και µε το προηγούµενο διαφηµιστικό σποτ, εδώ έγινε η περισσότερη 
εργασία και η ποιο χρονοβόρα, καθώς έπρεπε να γίνει η σωστή “ένωση” του εξώφυλλου και µερικές 
από τις πρώτες σελίδες του βιβλίου «Babypedia» ώστε να φαίνεται ότι το βιβλίο ανοίγει και 
ξεφυλλίζεται Επίσης και εδώ έπρεπε να εφαρµόσουµε ειδικά εφέ ,transition, τίτλους και κίνηση.  
      Στην  διαδικασία εκκίνηση του Premiere βάλαµε πάλι,  το συστήµατα µετάδοσης  DV PAL(4:3)  
και δηµιουργήσαµε τέσσερις ξεχωριστούς φακέλους(bin) , για να τοποθετήσουµε µέσα το υλικό που 
χρειάστηκε για κάθε σεκάνς, Αυτή λοιπόν, η οπτικοακουστική παραγωγή αποτελείται από τέσσερις 
σεκάνς οι οποίες είναι: 
� WORD: 

Αυτή η σεκάνς είναι µία ένθετη σεκάνς(nested sequence) , τοποθετηµένη µέσω «Drug n 
Drop», µέσα στην σεκάνς «TELIKO SPOT_2(SONY VAIO)». 

� OPEN BOOK: 
Επίσης και αυτή η σεκάνς είναι ένθετη , τοποθετηµένη µέσα στην «FINAL BOOK» σεκάνς. 

� FINAL BOOK: 
Η «FINAL BOOK» ένθετη σεκάνς περιέχει την «OPEN BOOK» σεκάνς και είναι τοποθετηµένη 
στην «FINAL SPOT_3(BABYPEDIA)» 

� FINAL SPOT_3(BABYPEDIA): 
 Αυτή η σεκάνς αποτελείται κυρίως από τις σεκάνς «WORD», «FINAL BOOK»και είναι η 
τελική στην οποία θα κάνουµε εξαγωγή και θα είναι η ολοκληρωµένη οπτικοακουστική 
παραγωγή µας. 

Τα εργαλεία/εφέ που χρησιµοποιήθηκαν σε αυτήν την οπτικοακουστική παραγωγή είναι τα εξής: 
� Video Effects: 

• Distort>Transform: Αυτό το φίλτρο έχει πολλές από τις δυνατότητες του εφέ 
Motion, εκτός από το γεγονός ότι το Transform µπορεί να µετακινηθεί σε µία 
χαµηλότερη θέση στην σειρά εφαρµογής των εφέ (Εικόνα 103).  

• Perspective>Drop Shadow: Εφέ ανάγλυφων (επικλινών) άκρων. 
• Perspective>Basic 3D: Εφέ τρισδιάστατης εµφάνισης (Εικόνα 104). 
• GPU Effects>Page Curl: Εφέ δηµιουργίας “ξετύλιγµα σελίδας (Εικόνα 104). 
 

 
Εικόνα 103: Σεκάνς «WORD» 
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Εικόνα 104: Σεκάνς «OPEN BOOK», Εφέ «Basic 3D», «Page Curl» 

 
• Stylize>Texturize: Εφέ εφαρµόσεις υφή σε ένα κλιπ, χρησιµοποιώντας ένα κλιπ το 

οποίο βρίσκεται σε ένα κατώτερο κανάλι της σεκάνς (Εικόνα 105).  
• Perspective>Radial Shadow: Εφέ εφαρµογής ακτινικής σκιάς. 
• Transition>Venetian Blinds: Εφέ εφαρµογής «Βενετσιάνικα στόρια». 
• Distort>Twirl : Εφέ εφαρµογής «στριφογυρίσµατος» 
• Stylize>Strobe Light: Εφέ δηµιουργίας φως στροβοσκόπια. (Εικόνα 106).  
• Channel>Blend: Λειτουργεί σαν το opacity, αλλά µας παρέχει περισσότερες 

δυνατότητες. 
• Image Control>Color Balance(RGB): Εφέ χρωµατικής διορώσης και 

συγκεκριµένα το RGB ελέγχει µόνο τις τιµές των πρωτευόντων χρωµάτων 
(κόκκινο, πράσινο και µπλε). 
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Εικόνα 105: Σεκάνς «FINAL BOOK», Εφέ «Texturize» 

 

 
Εικόνα 106: Σεκάνς «FINAL BOOK», Εφέ «Strobe Light» 

 
� Video Transitions: 

• Iris>Iris Star 
• GPU Transitions>Page Curl: (Εικόνα 107) 

� New Item>Color Matte. 
� New Item >Titles 
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� Motion: Εφέ κίνησης το οποίο είναι πάντα παρόν στο πάνελ Effects Control. 
� Opacity: Εφέ ∆ιαφάνειας το οποίο είναι πάντα παρόν στο πάνελ Effects Control. 
� Selection Tool: Εργαλείο επιλογής/επεξεργασίας (µεταφορά, απόθεση, κοπή).  
� Rate Stretch Tool: Εργαλείο αυξοµείωσης ταχύτητας. 
� Level: Ρύθµιση του επιπέδου του ήχου. Στην περίπτωση µας το χρησιµοποίησα για την     

ρύθµιση της έντασης στην αρχή (σταδιακό ‘άναµµα’) και στο τέλος (σταδιακό 
‘σβήσιµο’) του ήχου µας 

 

 
Εικόνα 107: Σεκάνς « FINAL SPOT_3(BABYPEDIA)», Εφέ «Strobe Light» 

 

4.4.4  Παρατηρήσεις/Συµπεράσµατα    
         Όπως και µε την προηγούµενη οπτικοακουστική παραγωγή έτσι και εδώ, η ολοκλήρωση της 
ήταν αρκετά χρονοβόρα. Για να γίνω πιο σαφείς, η επεξεργασία των εικόνων µε το Photoshop ήταν 
µου πήρε λίγο χρόνο διότι, έπρεπε να “αφαιρέσω” από τις εικόνες το φόντο τους (π.χ. το πράσινο 
χρώµα γύρο από την σελίδα (Εικόνα 101, 102, 103)), χωρίς να µείνουν “κατάλοιπα”. Επίσης υπήρξε 
κάποια δυσκολία (στο Premiere µε το εφέ Transform), στην ακριβή τοποθέτηση των εικόνων(που 
περιείχαν τις σελίδες του βιβλίου), µεταξύ τους, έτσι ώστε να φαίνεται σαν ένα ενιαίο βιβλίο καθώς οι 
σελίδες ξεφυλλίζονται. Το συµπέρασµα είναι, ότι αν και ηχογράφηση της εκφώνησης δεν είχε γίνει µε 
επαγγελµατικά µέσα, το αποτέλεσµα της προκαλούσε κάποιο ενδιαφέρον λόγω του φίλτρου το οποίο 
έκανε την φωνή µου να µοιάζει παιδική. Επίσης, η ηχογράφηση και το «ξεφύλλισµα» του βιβλίου 
πιστεύω ότι έκανε αυτή την οπτικοακουστική παραγωγή εντυπωσιακή. 
 

4.5     Ένωση των ∆ιαφηµιστικών Σποτ(1,2,3) 
      Για µία καλύτερη παρουσίαση των παραπάνω τριών διαφηµιστικών σποτ, τα ένωσα µε εφέ 
αλλαγής πλάνου, δηµιουργώντας έτσι µια νέα οπτικοακουστική παράγωγη. Η διάρκεια της είναι 
συνολικά  1:28 δευτερόλεπτα  και  αποτελείται από τα τρία µικρής διάρκειας διαφηµιστικά σποτ και 
από τρεις σεκάνς: 
� ONOMA: 

Αυτή η σεκάνς είναι ένθετη που εµφανίζει το ονοµατεπώνυµο µου όπως και το Αριθµό 
Μητρώου σε κυλιόµενη µορφή. 
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� EISAGOGH:  
Αυτή η είναι µία είναι µία ένθετη σεκάνς, στην οποία γίνεται η παρουσίαση των τίτλων των 
διαφηµιστικών σποτ.  

� DIAFHMISTIKA SPOT(TELIKO):  
Αυτή η σεκάνς αποτελείται κυρίως από τις σεκάνς «EISAGOGH», «ONOMA»  και είναι η 
τελική στην οποία θα κάνουµε εξαγωγή και θα είναι η ολοκληρωµένη οπτικοακουστική 
παραγωγή µας η οποία θα παρουσιάζει τα τρία διαφηµιστικά σποτ.. 
� Video Effects: 

• Video>Time Code: Εφέ εµφάνισης χρονοκώδικα. (Εικόνα 109). 
• Stylize>Roughen Edges: Εφέ για την δηµιουργία τραχέων άκρων (Εικόνα 109). 
• Color Correction>Broadcast Colors: ∆ιαµορφώνει το βίντεο ώστε να 

προβάλλεται σωστά σε τηλεοπτικές οθόνες. ∆ιορθώνει τα προβλήµατα που 
οφείλονται σε υπερβολικά φωτεινά χρώµατα και γεωµετρικά µοτίβα, τα οποία 
προκαλούν ορισµένα εφέ ή προστιθέµενα γραφικά. 

 

 
Εικόνα 108: Σεκάνς «ΟΝΟΜΑ» 
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Εικόνα 109: Σεκάνς «EISAGOGH», Εφέ «Time Code», «25% PiPs», «Roughen Edges» 

 
�  Presets>PiPs>25% PiPs: «Εικόνα µέσα σε εικόνα»(Picture-in-Picture). Αρχικά 

επέλεξα ένα στυλ και κατόπιν το προσάρµοσα στις δικές µου ανάγκες, αλλάζοντας τις 
θέσεις αρχής/τέλους του προκαθορισµένου εφέ και το µέγεθος, όπου χρειαζόταν.    

� Video Transitions: 
• Dissolve>Dip to Black 
• GPU Transitions>Page Roll: (Εικόνα 110). 
• Wipe>Clock Wipe: (Εικόνα 111). 
• Slide>Push: (Εικόνα 112). 
• Wipe>Barn Doors: (Εικόνα 113) 
• Zoom>Zoom Boxes: (Εικόνα 114). 
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Εικόνα 110: Σεκάνς « DIAFHMISTIKA SPOT(TELIKO)», Transitions « Page R oll » 

 

 
Εικόνα 111: Σεκάνς « DIAFHMISTIKA SPOT(TELIKO)», Transitions « Clock Wipe » 
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Εικόνα 112: Σεκάνς « DIAFHMISTIKA SPOT(TELIKO)», Transitions « Push »  

 

 
Εικόνα 113: Σεκάνς « DIAFHMISTIKA SPOT(TELIKO)», Transitions « Barn D oors » 

 
� New Item: 

• Universal Counting Leader: (Εικόνα 111). 



Πτυχιακή Εργασία Τµήµατος Εφαρµοσµένης Πληροφορικής & Πολυµέσων  

 - 91 - 

• Bars and Tone: (Εικόνα 114). 
• Color Matte 
• Title>Templates>General>Scrapbook: (Εικόνα 108) 
• Title 

� Motion: Εφέ κίνησης το οποίο είναι πάντα παρόν στο πάνελ Effects Control. 
� Opacity: Εφέ ∆ιαφάνειας το οποίο είναι πάντα παρόν στο πάνελ Effects Control. 
� Selection Tool: Εργαλείο επιλογής/επεξεργασίας (µεταφορά, απόθεση, κοπή).  
� Rate Stretch Tool: Εργαλείο αυξοµείωσης ταχύτητας. 
� Level: Ρύθµιση του επιπέδου του ήχου. Στην περίπτωση µας το χρησιµοποίησα για την 

ρύθµιση της έντασης στην αρχή (σταδιακό ‘άναµµα’) και στο τέλος (σταδιακό ‘σβήσιµο’) 
του ήχου µας 

 

 
Εικόνα 114: Σεκάνς « DIAFHMISTIKA SPOT(TELIKO)», Transitions « Zoom B oxes », « Bars 

and Tone» 
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5      ΑΠΟΤΕΛΕΣΜΑΤΑ 
 
Στο παρόν κεφάλαιο γίνεται µία αξιολόγηση της παρούσας πτυχιακής, αναφέροντας αν τα 
αποτελέσµατα είναι ικανοποιητικά 
 
5.1 Αξιολόγηση των Αποτελεσµάτων 
      Κατά τη διαδικασία δηµιουργίας της παρούσας εργασίας, κατάφερα να εκπληρώσω τους 
βασικότερους στόχους που είχα εξ’ αρχής στο µυαλό µου. Η διάρκεια ολοκλήρωσης, αν και 
µεγαλύτερη απ’ ότι περίµενα, ήταν µια ευχάριστη και εποικοδοµητική περίοδος, που µε έβαλε σε µια 
διάθεση αναζήτησης, εξέλιξης και εµβάθυνσης στον τοµέα των πολυµέσων. Κατανόησα µε έναν πιο 
ρεαλιστικό τρόπο, τα στάδια από τα οποία πρέπει να περάσει κάποιος και τα µέσα που χρειάζεται για 
να ολοκληρώσει µία οπτικοακουστική παραγωγή. 
      Το αποτέλεσµα στο θεωρητικό µέρος και συγκεκριµένα στην ανάλυση των χαρακτηριστικών των 
πολυµέσων, ήταν αρκετά  ικανοποιητικό, καθώς η περιγραφή τους ήταν όσο γινόταν  πιο αναλυτική 
και αυτό βοήθησε στην εµπλουτισµό των γνώσεων µου, στα πολυµέσα. Το πρακτικό µέρος, το οποίο 
υπήρξε και αυτό αρκετά χρονοβόρο αλλά πολύ ενδιαφέρον, µε βοήθησε να γνωρίσω πολύ καλύτερα 
τα λογισµικά πακέτα που χρησιµοποίησα και περισσότερο το Adobe Premiere Pro CS3, αφού εκεί 
έγινε η επεξεργασία /µοντάζ, των οπτικοακουστικών υλικών που είχα συλλέξει για κάθε 
οπτικοακουστική παραγωγή. 
Το αποτέλεσµα είναι αρκετά καλό στο σύνολό του υπάρχουν όµως και προβλήµατα τα οποία 
µπορούν να εξαλειφθούν σε επόµενες παραγωγές, µε γνώµονα την συγκεκριµένη εµπειρία. Το 
σηµαντικότερο πρόβληµα που υπήρξε κατά την διαδικασία ολοκλήρωσης των οπτικοακουστικών 
µέσων, ήταν η χαµηλή ποιότητα των αρχείων βίντεο,  καθώς οι λήψεις είχαν γίνει µε 
ερασιτεχνική ψηφιακή βιντεοκάµερα, και η χαµηλή ποιότητα των ηχογραφηµένων αρχείων, τα 
οποία έπρεπε να είχαν ηχογραφηθεί σε στούντιο ηχογράφησης. Αυτό το πρόβληµα επηρέασε 
σηµαντικά την ποιότητα του αποτελέσµατος.  
 
 
5.2    Συµπεράσµατα      
      Θεωρώ, ότι για την δηµιουργία µιας οπτικοακουστικής παραγωγής χρειάζεται αρκετή προσπάθεια, 
χρόνο, όρεξη και το κυριότερο έµπνευση. Επίσης, πιστεύω πως η παρούσα πτυχιακή εργασία  θα 
δώσει το κίνητρο σε κάποιος συµφοιτητές µου, να ασχοληθούν και αυτοί έστω και ερασιτεχνικά  µε 
την δηµιουργία οπτικοακουστικών παραγωγών. Το τελικό συµπέρασµα λοιπόν είναι ότι η προσπάθεια 
υλοποίησης των τριών οπτικοακουστικών παραγωγών αποδείχθηκε εξαιρετικά ενδιαφέρουσα 
διαδικασία, αλλά και πολύ δύσκολη και χρονοβόρα στην εφαρµογή της.  
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ΠΑΡΑΡΤΗΜΑΤΑ 
 
 
 

ΠΑΡΑΡΤΗΜΑ Α: Παρουσίαση της Πτυχιακής (PowerPoint slides) 
 
ΠΑΡΑΡΤΗΜΑ Β: Περίληψη Πτυχιακής σε Στυλ ∆ηµοσίευσης 
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ΠΑΡΑΡΤΗΜΑ Α: Παρουσίαση της Πτυχιακής (PowerPoint slides) 
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 ∆ιαφάνεια 1 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

1

∆ΙΑΦΗΜΙΣΤΙΚΑ ΣΠΟΤ

ΦΡΑΓΚΙΑ∆ΑΚΗ ΜΑΡΙΑ

861

 

 

 

∆ιαφάνεια 2 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

2

Σκοπός/Στόχοι Πτυχιακής
Εργασίας

� Η δηµιουργία µικρών διαφηµιστικών
σποτ µε την χρήση των λογισµικών
πακέτων: Adobe Premiere Pro CS3, 
Adobe Photoshop CS2 και Sony Sound 
Forge 8.0

� Η εµβάθυνση των γνώσεων µου στα
παραπάνω προγράµµατα. 
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∆ιαφάνεια 3 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

3

Βασικές Έννοιες

� Πολυµέσα: Αναφέρεται στον
συνδυασµό εικόνας, ήχου, και βίντεο. 

� Οπτικοακουστικά Μέσα: αναφέρεται
στα µέσα που παράγουν ταυτόχρονα
εικόνα και ήχο. 

� ∆ιαφήµιση: Αναφέρεται στην
παραγωγή οπτικοακουστικού ή γραπτού
µηνύµατος, το οποίο αφορά σε
συγκεκριµένο προϊόν, µε σκοπό την
αγορά του ή την αποδοχή από τον
δέκτη.  

 

 

 

∆ιαφάνεια 4 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

4

Εικόνα

� Η εικόνα αποτελεί το σηµαντικότερο
κοµµάτι στον κόσµο των υπολογιστών και
ειδικότερα στα πολυµέσα και στις
οπτικοακουστικές παραγωγές. 
• Οι διανυσµατικές εικόνες (vector graphics) 

αποτελούνται από αντικείµενα σχεδίασης τα
οποία βασίζονται σε ειδικά µαθηµατικά
µοντέλα. 

• Οι ψηφιογραφικές ή Χαρτογραφικές
εικόνες αποτελούνται από πολλά
χαρτογραφηµένα bits (τετραγωνάκια), που
µοιάζουν µε ψηφίδες ή κουκκίδες ή
εικονοστοιχεία (pixels). 
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∆ιαφάνεια 5 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

5

Ήχος

� Ο ήχος που παράγεται από µια πηγή και
συλλαµβάνεται από το αυτί µας, αποτελεί
ένα από τα πιο εντυπωσιακά στοιχεία
των πολυµεσικών εφαρµογών, καθώς
µπορεί να προσφέρει ακουστική
απόλαυση, να εντυπωσιάσει µε
διαφορετικά ηχητικά εφέ και να
ξεκουράζει σαν ηχητική υπόκρουση

 

 

 

∆ιαφάνεια 6 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

6

Βίντεο

� Το βίντεο εµπλουτίζει, βελτιώνει και
προσδίδει έµφαση σε µια εφαρµογή
πολυµέσων.
• Αναλογικό βίντεο είναι η ηλεκτρονική

τεχνολογία κωδικοποίησης, µετάδοσης και
αναπαραγωγής οπτικοακουστικής πληροφορίας, 
όπου η µορφή των χρησιµοποιούµενων σηµάτων
είναι αναλογικού τύπου. 

• Ψηφιακό βίντεο ή τεχνολογία DV (Digital 
Video), αναφέρεται γενικά σε όλο το σύνολο των
ψηφιακών τεχνολογιών µε τις οποίες γίνεται η
παραγωγή, η επεξεργασία, η αποθήκευση.
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∆ιαφάνεια 7 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

7

Adobe Photoshop CS2

Το Adobe Photoshop CS2 της Adobe 
Systems, χρησιµοποιείται για την για
την επεξεργασία και την δηµιουργία

εικόνων. 

 

 

 

∆ιαφάνεια 8 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

8

Sony Sound Forge 8.0

Το Sound Forge 8.0 της Sonic Foundry, 
είναι το εργαλείο για την ψηφιοποίηση
και την επεξεργασία µουσικών αρχείων. 
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∆ιαφάνεια 9 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

9

Adobe Premiere Pro SC3

Το Adobe Premiere Pro CS3 της Adobe 
Systems, χρησιµοποιείται για την

σύνθεση βίντεο µέσω αρχείων βίντεο, 
εικόνας, ήχου και άλλων γραφικών.

 

 

 

∆ιαφάνεια 10 
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ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

10

∆ηµιουργία διαφηµιστικών Σποτ

Για την δηµιουργία
µιας οποιασδήποτε
οπτικοακουστικής

παραγωγής
χρειάζεται να

ακολουθηθούν
συγκεκριµένα

στάδια, τεχνικές
και κανόνες ώστε
το αποτέλεσµα να
είναι το καλύτερο

δυνατόν. 

� Προπαραγωγή: Περιλαµβάνει
από την ανάπτυξη της ιδέας και το
σενάριο µέχρι την ετοιµασία των
σκηνικών και το προσωπικό που
µπορεί να χρειαστεί. 

� Παραγωγή: Περιλαµβάνει τα
γυρίσµατα, τις σκηνές, την
ηχοληψία και την εφαρµογή του
φωτισµού για µια σωστή και
ολοκληρωµένη βιντεοσκόπηση. 

� Μεταπαραγωγή: Περιλαµβάνει
το ξήλωµα σκηνικών, συσκευασία
εξοπλισµού, αποδέσµευση
ταλέντων, ρυθµίσεις οικονοµικών
θεµάτων, επεξεργασία των βίντεο
και των ήχων, το µοντάζ, τις
µίξεις σε εικόνα και ήχο, αλλά και
διάθεση και προβολή της
παραγωγής. 

 

∆ιαφάνεια 11 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

11

Σποτ 1

∆εν υπήρξε ιδιαίτερη
δυσκολία στην υλοποίηση, 

µόνο στην διαδικασία ’κοπής’
των πλάνων που υπήρξε λίγο
χρονοβόρα. Λόγω της µικρής
διάρκειάς του και για να µην

γίνει ‘κουραστικό’ δεν το
επιβάρυνα µε πολλά εφέ. Η

διάρκεια αυτού του
διαφηµιστικού σποτ ήταν 25 

δευτερόλεπτα.

 

 

 

∆ιαφάνεια 12 
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ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

12

Σποτ 2

Υπήρξε αρκετή δυσκολία, 
τόσο στην διαδικασία

«κοπής» των πλάνων που
ήταν αρκετή χρονοβόρα, όσο

και στην διαδικασία
αφαίρεσης του πράσινου
φόντου που εκτός από
χρονοβόρα υπήρξε και
κουραστική. Η διάρκεια

αυτού του διαφηµιστικού
σποτ ήταν 36 δευτερόλεπτα.  

 

∆ιαφάνεια 13 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

13

Σποτ 3

Η επεξεργασία των εικόνων ήταν
χρονοβόρα, υπήρξε κάποια

δυσκολία (στο Premiere), στην
ακριβή τοποθέτηση των εικόνων
(που περιείχαν τις σελίδες του

βιβλίου), µεταξύ τους, έτσι ώστε
να φαίνεται σαν ένα ενιαίο

βιβλίο. 
Η ηχογράφηση και το

«ξεφύλλισµα» του βιβλίου
πιστεύω ότι έκανε αυτή την
οπτικοακουστική παραγωγή

εντυπωσιακή. 
Η διάρκεια αυτού του

διαφηµιστικού σποτ ήταν 28 
δευτερόλεπτα. 

 

 

 

∆ιαφάνεια 14 
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ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

14

Αποτέλεµατα

Το αποτέλεσµα είναι αρκετά καλό στο σύνολό του, 
υπάρχουν όµως και προβλήµατα τα οποία µπορούν

να εξαλειφθούν σε επόµενες παραγωγές, µε
γνώµονα την συγκεκριµένη εµπειρία. Το

σηµαντικότερο πρόβληµα που υπήρξε κατά την
διαδικασία ολοκλήρωσης των οπτικοακουστικών
µέσων, ήταν η χαµηλή ποιότητα των αρχείων

βίντεο,  καθώς οι λήψεις είχαν γίνει µε ερασιτεχνική
ψηφιακή βιντεοκάµερα, και η χαµηλή ποιότητα των
ηχογραφηµένων αρχείων, τα οποία έπρεπε να είχαν
ηχογραφηθεί σε στούντιο ηχογράφησης. Αυτό το
πρόβληµα επηρέασε σηµαντικά την ποιότητα του

αποτελέσµατος. 

 

∆ιαφάνεια 15 

 

ΤΕΙ Ηρακλείου Τµήµα
Τεχνολογικών Εφαρµογών & 

Πολυµέσων

15

Συµπεράσµατα

� Για την δηµιουργία µιας οπτικοακουστικής
παραγωγής χρειάζεται αρκετή
προσπάθεια, χρόνο, όρεξη και το
κυριότερο έµπνευση. 

� Η προσπάθεια υλοποίησης των τριών
οπτικοακουστικών παραγωγών
αποδείχθηκε εξαιρετικά ενδιαφέρουσα
διαδικασία, αλλά και πολύ δύσκολη και
χρονοβόρα στην εφαρµογή της.
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ΠΑΡΑΡΤΗΜΑ Β: Περίληψη Πτυχιακής σε Στυλ ∆ηµοσίευσης 
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      Το θέµα της πτυχιακής εργασίας ήταν η δηµιουργία 
οπτικοακουστικών µέσων (µικρών διαφηµιστικών σποτ), µε 
χρήση τεχνολογιών επεξεργασίας εικόνας/ήχου και σύνθεση 
κοµµατιών video και audio.Τα προγράµµατα που 
χρησιµοποιήθηκαν για την εκπόνηση της ήταν το Adobe 
Photoshop CS2 της Adobe Systems, που χρησιµοποιείται για 
την για την επεξεργασία και δηµιουργία εικόνων. Το Sound 
Forge 8.0 της Sonic  Foundry, το οποίο είναι το εργαλείο για 
την ψηφιοποίηση και την επεξεργασία µουσικών αρχείων. 
Το Adobe Premiere Pro CS3 της Adobe Systems,  για την 
σύνθεση βίντεο µέσω αρχείων βίντεο, εικόνας, ήχου και 
άλλων γραφικών. 
 

I. ΕΙΣΑΓΩΓΗ 
      Αυτό που µε ώθησε στην επιλογή του θέµατος της 
πτυχιακής εργασίας, ήταν, το ιδιαίτερο ενδιαφέρον µου 
για τα πολυµέσα και για την επεξεργασία τους. Επίσης, 
άλλος ένας παράγοντας που µε οδήγησε στην επιλογή 
αυτή, ήταν η ραγδαία αναπτύξει που υπάρχει στον κλάδο 
της διαφήµισης , καθώς πολλές επιχειρήσεις στρέφονται 
στην λήψη ειδικευµένων υπηρεσιών από επαγγελµατικές 
διαφηµιστικές εταιρίες οι οποίες αναλαµβάνουν την 
επιλογή και την εκτέλεση του µηνύµατος της διαφήµισης.  
      Στόχος της εργασίας αυτής, ήταν η δηµιουργία τριών 
µικρής διάρκειας διαφηµιστικών σποτ, δηλαδή µια 
παραγωγή οπτικοακουστικών µέσων, µε σκοπό την 
εµβάθυνση µου στα προγράµµατα: Adobe Photoshop, 
Sound Forge και κυρίως στο Adobe Premiere. Το πρώτο 
σποτ έχει τον τίτλο «ΑΦΟΙ ΓΕΡΟΥΚΑΚΗ», όπου 
διαφηµίζεται το συνεργείο/ηλεκτρολογείο «Αφοί 
Γερουκάκη». Το δεύτερο σποτ έχει τον τίτλο «SONY 
VAIO», όπου διαφηµίζω τον γνωστό φορητό υπολογιστή 
sony vaio. Στο τελευταίο σποτ, γίνεται µια διαφήµιση 
ενός παιδικού εκπαιδευτικού βιβλίου, και έχει τον τίτλο 
«BABYPEDIA». Σε όλα τα παραπάνω διαφηµιστικά 
σποτ, έχουν εφαρµοστεί διάφορα εφέ και φίλτρα και 
γενικότερα έχουν υποστεί αρκετή επεξεργασία και από τα 
τρία παραπάνω εργαλεία, ώστε να φτάσουν (όσο γινόταν 
εφικτό, λόγο µη επαγγελµατικού εξοπλισµού στη λήψη 
του ήχου και του βίντεο)στο επιθυµητό αποτέλεσµα. Η 
συνολική τους διάρκεια είναι 1 λεπτό και 28 
δευτερόλεπτα και η παρουσίαση τους γίνεται µέσω µίας 
νέας οπτικοακουστικής παράγωγης. 
      Το γραπτό µέρος της πτυχιακής εργασίας χωρίζεται σε 
5 κεφάλαια. Το πρώτο κεφάλαιο είναι η εισαγωγή όπου 
παρουσιάζεται το θέµα της παρούσας πτυχιακής και 
γίνεται µια αναφορά στους στόχους, το κίνητρο και στην 
δοµή της. Στο  δεύτερο κεφάλαιο περιγράφεται ο όρος 
των οπτικοακουστικών µέσων και της διαφήµισης όπως 
επίσης και τα χαρακτηριστικά της εικόνας ,του ήχου και 
του βίντεο.  Στην τρίτο κεφάλαιο, γίνεται µια περιγραφή  
των τριών εργαλείων που χρησιµοποιήθηκαν, ώστε να 
καταλάβουµε την χρήση τους, τις βασικές τους έννοιες 
και γενικότερα να γνωρίσουµε το περιβάλλον 
εργασίας(του κάθε προγράµµατος). Στο τέταρτο κεφάλαιο 
ασχολείται µε  το πρακτικό µέρος της πτυχιακής 

εργασίας, δηλαδή µε την  παραγωγή των διαφηµιστικών 
spots. Το τελευταίο εκθέτει τα  αποτελέσµατα και τα 
συµπεράσµατα της παρούσας πτυχιακής.   
 

II. ΒΑΣΙΚΕΣ ΕΝΝΟΙΕΣ & ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ 
• Πολυµέσα: Αναφέρεται στον συνδυασµό εικόνας, 

ήχου, και βίντεο.  
• Οπτικοακουστικά Μέσα: αναφέρεται στα µέσα που 

παράγουν ταυτόχρονα εικόνα και ήχο.  
• ∆ιαφήµιση: Αναφέρεται στην παραγωγή 

οπτικοακουστικού ή γραπτού µηνύµατος, το οποίο 
αφορά σε συγκεκριµένο προϊόν, µε σκοπό την 
αγορά του ή την αποδοχή από τον δέκτη. 

• Η εικόνα αποτελεί το σηµαντικότερο κοµµάτι στον 
κόσµο των υπολογιστών και ειδικότερα στα 
πολυµέσα και στις οπτικοακουστικές παραγωγές. 
Εικόνες µπορούµε να εισάγουµε σε µια 
πολυµεσική εφαρµογή µε τη βοήθεια του σαρωτή 
(scanner), όπου η όλη διαδικασία λέγεται 
ψηφιοποίηση της εικόνας, να τις πάρουµε 
(κατεβάσουµε) από το Internet, από CD ή να τις 
δηµιουργήσουµε µε κάποιο από τα πληθώρα 
εργαλεία επεξεργασίας εικόνας που υπάρχουν . 
o Οι διανυσµατικές εικόνες (vector graphics) 

αποτελούνται από αντικείµενα σχεδίασης τα 
οποία βασίζονται σε ειδικά µαθηµατικά 
µοντέλα.  

o Οι ψηφιογραφικές ή Χαρτογραφικές εικόνες 
αποτελούνται από πολλά χαρτογραφηµένα 
bits (τετραγωνάκια), που µοιάζουν µε 
ψηφίδες ή κουκκίδες ή εικονοστοιχεία 
(pixels).  

• Το βίντεο εµπλουτίζει, βελτιώνει και προσδίδει 
έµφαση σε µια εφαρµογή πολυµέσων. Προσθέτει 
ρεαλισµό, θετική διάθεση και συντελεί στην 
ενθάρρυνση του χρήστη ή του ακροατηρίου. Με 
την ενσωµάτωση ενός κατάλληλα επιλεγµένου και 
διαµορφωµένου αποσπάσµατος βίντεο ο ακροατής 
κατανοεί καλύτερα την πληροφορία 
παρακολουθώντας το ίδιο το γεγονός και όχι µια 
περιγραφή µέσω του κειµένου. 
o Αναλογικό βίντεο είναι η ηλεκτρονική 

τεχνολογία κωδικοποίησης, µετάδοσης και 
αναπαραγωγής οπτικοακουστικής 
πληροφορίας, όπου η µορφή των 
χρησιµοποιούµενων σηµάτων είναι 
αναλογικού τύπου.  

o Ψηφιακό βίντεο ή τεχνολογία DV (Digital 
Video), αναφέρεται γενικά σε όλο το 
σύνολο των ψηφιακών τεχνολογιών µε τις 
οποίες γίνεται η παραγωγή, η επεξεργασία, 
η αποθήκευση.  

• Ο ήχος που παράγεται από µια πηγή και 
συλλαµβάνεται από το αυτί µας, αποτελεί ένα από 
τα πιο εντυπωσιακά στοιχεία των πολυµεσικών 
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εφαρµογών, καθώς µπορεί να προσφέρει 
ακουστική απόλαυση, να εντυπωσιάσει µε 
διαφορετικά ηχητικά εφέ και να ξεκουράζει σαν 
ηχητική υπόκρουση.   

 
III.  ΠΕΡΙΓΡΑΦΗ ΤΩΝ ΛΟΓΙΣΜΙΚΩΝ ΠΑΚΕΤΩΝ 

 
A. Sound Forge 8 της Sonic Foundry 
      Το Sound Forge είναι το στάνταρ της µουσικής 
βιοµηχανίας για πάνω από µία δεκαετία. 
Πρόκειται για ένα εργαλείο που απευθύνεται στους 
επαγγελµατίες µουσικούς που θέλουν 
να δηµιουργήσουν και να επέµβουν σε ψηφιακά audio 
αρχεία µε απόλυτη ταχύτητα και ακρίβεια. 
Το πρόγραµµα διαθέτει ότι χρειαζόµαστε για να 
αναλύσουµε, να ηχογραφήσουµε, να επέµβουµε, να 
δηµιουργήσουµε µουσικά loops, να ψηφιοποιήσουµε και 
να ανακτήσουµε παλιές ηχογραφήσεις από 
βινύλιο ή άλλα µέσα, να εξοµοιώσει χώρους, να 
δηµιουργήσουµε streaming media και τέλος να 
δηµιουργήσουµε master audio CDs. 
Με τη χρήση του Sound Forge µπορούµε να κάνουµε τις 
εξής βασικές λειτουργίες:  

• Ηχοληψία – ψηφιοποίηση αναλογικού ήχου  
• Εισαγωγή ψηφιακού ήχου από µουσικό cd  
• Αντιγραφή, αποκοπή, και επικόλληση ηχητικού 

τµήµατος  
• Ρύθµιση της έντασης και των συχνοτήτων  
• Αλλαγή συχνότητας δειγµατοληψίας και αλλαγή 

µεγέθους δείγµατος  
• Αλλαγή χρονικής διάρκειας  
• Μείξη ήχων  
• Απαλοιφή θορύβου - Εισαγωγή διαφόρων εφέ  
• Συµπίεση - Αποθήκευση  

 
B. Adobe Photoshop CS2 της Adobe Systems 
      Το Adobe Photoshop είναι ένα από τα πιο δηµοφιλή 
προγράµµατα επεξεργασίας γραφικών στην αγορά. Με 
αυτό, θα µπορούµε να δούµε και να επεξεργαστούµε 
όλων των ειδών τις εικόνες. Το εργαλείο αυτό 
περιλαµβάνει όλα τα απαραίτητα στοιχεία για να 
πραγµατοποιήσουµε µια αληθινά επαγγελµατική δουλειά. 
Μπορούµε να κάνουµε από απλές επεξεργασίες µέχρι τη 
δηµιουργία περίπλοκών φωτογραφικών συνθέσεων µε 
όλα τα εφέ και τα φίλτρα που επιθυµούµε. Παρόλο που 
χρησιµοποιείται από επαγγελµατίες σε όλο τον κόσµο, η 
εφαρµογή είναι πολύ εύκολη στη χρήση. Όλα τα εργαλεία 
είναι διαθέσιµα σε µία µόνο µπάρα στην οποία έχουµε 
άµεση πρόσβαση χωρίς να χρειαστεί να αφήσουµε την 
οθόνη που βρίσκεται η εικόνα. Επιπλέον, το Adobe 
Photoshop CS2 διαθέτει ένα καινοτόµο σύστηµα 
επεξεργασίας επιπέδων που µας επιτρέπει να 
προσαρµόσουµε ανεξάρτητα κάθε στοιχείο της 
φωτογραφίας ή της εικονογραφίας.. 

Με τη χρήση του Adobe Photoshop µπορούµε να κάνουµε 
τις εξής βασικές λειτουργίες: 
• Εισαγωγή εικόνας  
• Ρύθµιση της σωστής ανάλυσης,  
• Κοπή και στρέψη  
• Ρύθµιση των χρωµάτων, των τόνων και της 

αντίθεσης  
• Επεξεργασία σε επιλεγµένες περιοχές  
• Εφαρµογή ειδικών φίλτρων -εφέ 
• Εισαγωγή κειµένου  
• ∆ηµιουργία νέας εικόνας  
• Αποθήκευση – Συµπίεση και πολλές άλλες 

ρυθµίσεις για βελτίωση του αποτελέσµατος.  
 

C. Adobe Premiere Pro CS3 της Adobe Systems 
      Το Adobe Premiere pro CS3 είναι ένα ισχυρό 
εργαλείο, κατάλληλο τόσο για τους επαγγελµατίες που 
ασχολούνται µε την παραγωγή βίντεο, όσο για τους 
ερασιτέχνες λάτρεις αυτού του µέσου, το οποίο παρέχει 
στους χρήστες απεριόριστη ελευθερία δηµιουργικής 
έκφρασης. Το Adobe Premiere pro είναι το πιο 
επεκτάσιµο, αποτελεσµατικό και ακριβές εργαλείο 
επεξεργασίας βίντεο που υπάρχει σήµερα. Ανεξάρτητα 
αν δουλεύουµε µε µορφής DV, HD, HDV, ή µε υλικό 
άλλων µορφών, η κορυφαία ποιότητα του Adobe 
Premiere pro µας επιτρέπει να δουλεύουµε γρηγορότερα 
και πιο δηµιουργικά. Η πλούσια συλλογή ισχυρών 
εργαλείων που διαθέτει µας επιτρέπει να 
αντιµετωπίζουµε µε επιτυχία κάθε πρόκληση και να 
δηµιουργήσουµε έργα υψηλής ποιότητας. 
Με τη χρήση του Adobe Photoshop µπορούµε να κάνουµε 
τις εξής βασικές λειτουργίες: 
• Σύλληψη ή εισαγωγή video  
• Αντιγραφή, αποκοπή, επικόλληση video clip  
• Εισαγωγή εφέ αλλαγής πλάνου  
• Μοντάζ καναλιών video  
• Εφαρµογή ειδικών φίλτρων σε video clip  
• Εισαγωγή αρχείων ήχου  
• Εισαγωγή αρχείων εικόνας και γραφικών  
• Εισαγωγή κειµένου και τίτλων  
• Animation σε video clip, τίτλους και γραφικά  
• Ρύθµιση έντασης clip ήχου  
• Αλλαγή χρονικής διάρκειας video clip  
• Μείξη καναλιών ήχων  
• Εξαγωγή και συµπίεση video–εικόνας-ήχου  

 
 

I. ∆ΗΜΙΟΥΡΓΙΑ ∆ΙΑΦΗΜΙΣΤΙΚΩΝ ΣΠΟΤ 
      Για την δηµιουργία µιας οποιασδήποτε 
οπτικοακουστικής παραγωγής χρειάζεται να 
ακολουθηθούν συγκεκριµένα στάδια, τεχνικές και 
κανόνες ώστε το αποτέλεσµα να είναι το καλύτερο 
δυνατόν. Έτσι και στην παρούσα πτυχιακή εργασία 
ακλούθησα κάποια συγκεκριµένα στάδια και κανόνες για 
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την ολοκλήρωση της οπτικοακουστικής παραγωγής. Τα 
στάδια είναι τα εξής: 
• Προπαραγωγή (Pre-Production) 
       H προπαραγωγή θεωρείται το πιο σηµαντικό 

κοµµάτι για την παραγωγή οπτικοακουστικού                                       
περιεχοµένου καθώς περιλαµβάνει από την 
ανάπτυξη της ιδέας και το σενάριο µέχρι την  
ετοιµασία των σκηνικών και το προσωπικό που 
µπορεί να χρειαστεί. Σε αυτό το αρχικό στάδιο 
λοιπόν, αναπτύχθηκε η βασική ιδέα και το σενάριο 
για το κάθε διαφηµιστικό σποτ,   έγινε η αγορά  
του εξοπλισµού που θεωρείτο απαραίτητο για την 
λήψη των πλάνων και η  συλλογή του υλικού.  

• Παραγωγή (Production) 
       Το δεύτερο στάδιο για την ολοκλήρωση µιας 

οπτικοακουστικής παραγωγής είναι η κύρια 
παραγωγή που περιλαµβάνει τα γυρίσµατα, τις 
σκηνές, την ηχοληψία και την εφαρµογή του 
φωτισµού για µια σωστή και ολοκληρωµένη 
βιντεοσκόπηση. Σε αυτό το στάδιο λοιπόν, έγιναν 
τα γυρίσµατα, εντελώς ερασιτεχνικά όπως και οι 
λήψεις φωτογραφιών. Με την χρήση του Adobe 
Photoshop Pro CS2 και του Sound Forge 8, 
πραγµατοποιήθηκε η δηµιουργία των εικόνων και 
τον ήχων, αντίστοιχα 

• Μεταπαραγωγή (Post-Production) 
       Τελευταίο αλλά εξίσου σηµαντικό για την 

δηµιουργία µιας οπτικοακουστικής παραγωγής 
είναι το στάδιο της µετά-παραγωγής (post-
production). Στην µεταπαραγωγή περιέχονται όλες 
αυτές τις εργασίες που έχουν να κάνουν µε το 
ξήλωµα σκηνικών, συσκευασία εξοπλισµού, 
αποδέσµευση ταλέντων, ρυθµίσεις οικονοµικών 
θεµάτων, επεξεργασία των βίντεο και των ήχων, το 
µοντάζ, τις µίξεις σε εικόνα και ήχο, αλλά και 
διάθεση και προβολή της παραγωγής. Σε αυτό το 
τελευταίο χρονοβόρο στάδιο, ως αρχή έγινε η 
µεταφορά του υλικού παραγωγής στον υπολογιστή. 
Επίσης πραγµατοποιήθηκε, η επεξεργασία εικόνας 
και ήχου όπου χρειαζόταν και φυσικά έγινε η 
επεξεργασία του οπτικοακουστικού υλικού, µε το 
πρόγραµµα  Adobe Premiere Pro CS3 και έτσι 
ολοκληρώθηκαν τα τρία διαφηµιστικά σποτ.   

 
A. ∆ιαφηµιστικό Σποτ 1 «ΑΦΟΙ ΓΕΡΟΥΚΑΚΗ» 
      Σε αυτή την οπτικοακουστική παραγωγή, η οποία 
ήταν και η πρώτη µου, χρησιµοποίησα υλικό τα οποίο 
είχα συλλάβει µέσω της ψηφιακής βιντεοκάµερας και της 
ψηφιακής φωτογραφικής µηχανής. Επίσης, βρήκα έτοιµο 
υλικό, την εκφώνηση, από έναν ραδιοφωνικό σταθµό 
(Ράδιο Μοίρες 97,1 FM), το οποίο έπειτα υπέστη 
επεξεργασία από το Sound Forge όπως και η µουσική την 
οποία ¨κατέβασα¨ από το internet. Τέλος, η επιγραφή 
«Αφοί Γερουκάκη», µου δόθηκε έτοιµο, από ένα γραφείο 
επιγραφών και στη συνεχεία το επεξεργάστηκα µε το 
Photoshop. Όλο αυτό το υλικό, στο στάδιο της 

µεταπαραγωγής, συνέθεσε την ολοκλήρωση του πρώτου 
διαφηµιστικού σποτ, χωρίς καµία δυσκολία. Η διάρκεια 
αυτού του διαφηµιστικού σποτ ήταν 25 δευτερόλεπτα.  
 
B. ∆ιαφηµιστικό Σποτ 2 «SONY VAIO» 
      Σε αυτή την οπτικοακουστική παραγωγή 
χρησιµοποίησα υλικό τα οποίο είχα συλλάβει µέσω της 
ψηφιακής βιντεοκάµερας. Επίσης, βρήκα έτοιµο υλικό 
από το internet (αρχεία εικόνων, ήχων)οποίο έπειτα 
υπέστη επεξεργασία από το Adobe Photoshop και το 
Sound Forge. Η εκφώνηση ηχογραφήθηκε από εµένα, µε 
το πρόγραµµα Sound Forge και χρησιµοποιήθηκαν 
ακουστικά µε ενσωµατωµένο µικρόφωνο. Όλο αυτό το 
υλικό, στο στάδιο της µεταπαραγωγής, συνέθεσε την 
ολοκλήρωση του δεύτερου διαφηµιστικού σποτ.. Για τα 
γυρίσµατα χρειάστηκε ο φορητός υπολογιστής «Sony 
Vaio» και ένα πράσινο ύφασµα ως παραβάν, για την 
επεξεργασία αφαίρεσης του φόντου από το πρόγραµµα 
Adobe Premiere. Η διάρκεια αυτού του διαφηµιστικού 
σποτ ήταν 36 δευτερόλεπτα. 
 
C. ∆ιαφηµιστικό Σποτ 3 «BABYPEDIA» 
      Σε αυτή την οπτικοακουστική παραγωγή 
χρησιµοποίησα υλικό τα οποίο είχα συλλάβει µέσω της 
ψηφιακής φωτογραφικής µηχανής και υπέστη 
επεξεργασία από το Adobe Photoshop.. Η εκφώνηση 
ηχογραφήθηκε από εµένα, µε το πρόγραµµα Sound Forge 
και χρησιµοποιήθηκαν ακουστικά µε ενσωµατωµένο 
µικρόφωνο. Όλο αυτό το υλικό, στο στάδιο της 
µεταπαραγωγής, συνέθεσε την ολοκλήρωση του τρίτου 
διαφηµιστικού σποτ. Η διάρκεια αυτού του 
διαφηµιστικού σποτ ήταν 28 δευτερόλεπτα. 
 
D. Ένωση των ∆ιαφηµιστικών Σποτ(1,2,3) 
      Για µία καλύτερη παρουσίαση των παραπάνω τριών 
διαφηµιστικών σποτ, τα ένωσα µε εφέ αλλαγής πλάνου, 
δηµιουργώντας έτσι µια νέα οπτικοακουστική παράγωγη. 
Η διάρκεια της είναι συνολικά  1:28 δευτερόλεπτα  και  
αποτελείται από τα τρία µικρής διάρκειας διαφηµιστικά 
σποτ 

 
II. ΠΑΡΑΤΗΡΗΣΕΙΣ/ΣΥΜΠΕΡΑΣΜΑΤΑ 

      Το αποτέλεσµα είναι αρκετά καλό στο σύνολό του, 
υπάρχουν όµως και προβλήµατα τα οποία µπορούν να 
εξαλειφθούν σε επόµενες παραγωγές, µε γνώµονα την 
συγκεκριµένη εµπειρία. Το σηµαντικότερο πρόβληµα που 
υπήρξε κατά την διαδικασία ολοκλήρωσης των 
οπτικοακουστικών µέσων, ήταν η χαµηλή ποιότητα των 
αρχείων βίντεο,  καθώς οι λήψεις είχαν γίνει µε 
ερασιτεχνική ψηφιακή βιντεοκάµερα, και η χαµηλή 
ποιότητα των ηχογραφηµένων αρχείων, τα οποία έπρεπε 
να είχαν ηχογραφηθεί σε στούντιο ηχογράφησης. Αυτό το 
πρόβληµα επηρέασε σηµαντικά την ποιότητα του 
αποτελέσµατος. 
      Θεωρώ, ότι για την δηµιουργία µιας 
οπτικοακουστικής παραγωγής χρειάζεται αρκετή 
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προσπάθεια, χρόνο, όρεξη και το κυριότερο έµπνευση. 
Επίσης, πιστεύω πως η παρούσα πτυχιακή εργασία  θα 
δώσει το κίνητρο σε κάποιος συµφοιτητές µου, να 
ασχοληθούν και αυτοί έστω και ερασιτεχνικά  µε την 
δηµιουργία οπτικοακουστικών παραγωγών. Το τελικό 
συµπέρασµα λοιπόν είναι ότι η προσπάθεια υλοποίησης 
των τριών οπτικοακουστικών παραγωγών αποδείχθηκε 
εξαιρετικά ενδιαφέρουσα διαδικασία, αλλά και πολύ 
δύσκολη και χρονοβόρα στην εφαρµογή της.  
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